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About Operation Manual

This manual provides an overview of the product and
notes on usage. It also explains how to configure it, oper-
ate it, perform maintenance on it, and so on. Read this
manual thoroughly before use, and use the product prop-
erly.

Intended readers

These manuals are intended for users of this product and
their instructors. The manual assumes that the reader has
knowledge about power supplies.

Manual construction

» User’s manual @(this manual)
This document is intended for first-time users of this
product. It provides an overview of the product, notes on
usage, and specifications. It also explains how to con-
nect the product, configure the product, operate the
product, perform maintenance on the product, and so
on.

* Communication Interface Manual @

This document contains details about remote control. It
is written for readers with sufficient basic knowledge of
how to control testers and measuring instruments using
SCPI commands.

a

+ Quick Reference P;Er ROF

This document briefly explains the control panel and the
basic operation of it.

» Setup Guide ng;;r @
This document is intended for first-time users of the
product. It gives an overview of the product, connecting
procedures, safety precautions etc. Please read this
manual before you operating the product.

» Safety Information P;:r @

This document contains general safety precautions.
Keep them in mind and make sure to observe them.

PDF files are included in the accompanying CD-ROM. You
can view the PDF files using Adobe Reader.

You can download the most recent version of these manu-
als from the Kikusui Electronics Corporation website.

Firmware versions that this manual covers

This manual applies to products with firmware versions
2.2X.

For information on how to check the firmware version, see
“Displaying the Device Information” (p. 143).

When contacting us about the product, please provide us
with the following information.

The model (marked in the top section of the front panel)
Firmware version (p. 143)
The serial number (marked on the rear panel)
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Trademarks

All company names and product names used in this man-
ual are trademarks or registered trademarks of their
respective companies.

Copyright
Reproduction and reprinting of this operation manual,
whole or partially, without our permission is prohibited.

Both unit specifications and manual contents are subject to
change without notice.

© Copyright 2019 Kikusui Electronics Corporation

Open Source Software

This product contains open source software under the
licensing terms of GNU General Public License (GPL),
GNU LESSER General Public License (LGPL), and other
licenses. For details, see the following URL.

https://rddocuments.kikusui.co.jp/oss/plz5wh
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Accessories

Common to all models

The attached power cord varies depending on the shipment destination. ]

2. 9. &

Plug: NEMA5-15 Plug: CEE7/7 Plug: GB1002
Rating: 125 Vac/10 A Rating: 250 Vac/10 A Rating: 250 Vac/10 A
[85-AA-0004] [85-10-1070] [85-10-0791]

[]Power cord (1 pc., length: 2.5 m)

=, -

3
)
NaPs

X @!

[

-

[Isafety terminal adapter [JExternal control
TL41 (red 1 set, black 1Set) connector kit (1 Set)
[87930] [83-20-0190]

(] Safety Information (1 copy)

[ISetup Guide (1 copy)

[J Quick Reference
(Japanese 1 sheet, English 1 sheet)
[JCD-ROM (1 disc)

PLZ1005WH2, PLZ2005WH2, PLZ4005WH2

[M1- 100119]@

= J0% 2
®®
\ [M5-101-008]

[M4-100-008] [M5-100-008]

Top [Q1-500-156]

Bottom [Q1-500-157]

[[]Screw set for rear-panel
DC INPUT terminals
(2 sets)

(] Rear-panel DC INPUT
terminal cover (1 set)

M Screw [M8-600-021]
[]Screws for the rear-panel DC ~

INPUT terminal cover (2 pcs.) /
[M3-112-018] /

P

[]Screws for the front-panel
DC INPUT terminals (2 pcs.)
[M3-112-043]

Cover
[Q1-510-001]

[ Front-panel DC INPUT
terminal cover (1 pc.)

x>

[]Heavy object warning
label (1 pc.)
PLZ4005WH2 only

PLZ-5WH2

PLZ12005WH2, PLZ20005WH2

Top [Q1-500-158]

[M1-100-134]
| 5/‘3
.

\[M5 101-009]

[M4-1OO 009] [M5-100-009]
Bottom [Q1-500-159]

[ Rear-panel DC INPUT [ Screw set for rear-panel
terminals DC INPUT terminals
Cover (1 set) (2 sets)

o <>

[]Rear-panel DC INPUT [[1Heavy object warning label
terminals Cover screws (1 pc.)

(2 pcs.)

[M3-112-016]
Cable length: Approx. 1 m

(] Parallel operation signal
cable kit
[PCO02-PLZ-5W]
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Product Overview

The PLZ-5WH2 Series Electronic Load is a multifunctional
system designed to offer the highest levels of reliability
and safety. A high voltage large capacity load can be con-
figured with this product set alone. The electronic load
contains a stable and fast-response current control circuit
that enables high-speed load simulations. Designed to
allow high-precision current setting, it provides outstanding
resolution.

The product is equipped with a color liquid crystal display
(LCD) for easy viewing.

Because the electronic load comes standard with
RS232C, USB, and LAN communication functions, it can
easily be incorporated into a wide range of inspection sys-
tems.

Model configurations

Model Power Maximum Operating volt-
operating cur- age
rent

PLZ1005WH2 1 kW 20A 10 V to 1000 V

PLZ2005WH2 2kW  40A
PLZ4005WH2 4kW  80A
PLZ12005WH2 12kW 240 A
PLZ20005WH2 20 kW 400 A

Features

In addition to basic constant current, constant resistance,
constant voltage, and constant power modes, the PLZ-
5WH2 Series offers a variety of other functions.

Larger capacity achievable in a compact form
The PLZ20005WH2 alone supports 20 kW. A compact
load system can be configured. Up to four units can be
operated in parallel using one of them as the master unit
(up to 100 kW, 2000 A).

Wide operating voltage range
The operating voltage range is 10 V to 1000 V. The min-
imum operating voltage at which current begins to flow
is1.5V.

Pulse and sine functions
The pulse function repeatedly executes two settings. It is
suitable for transient response characteristics testing of
large capacity power supplies and batteries. The sine
function varies the current sinusoidally.

Arbitrary |-V characteristics mode

Arbitrary I-V characteristics can be set by registering
multiple I-V characteristic points (pairs of voltage and
current values).

Cutoff function
The load can be turned off when the elapsed time from
load-on, the voltage drop, the integrated current, or the
integrated power reaches the specified value.
Synchronized Operation

Load on/off control and the execution of sequences can
be synchronized among PLZ-5WH2 units.
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Data logging function
The most recent measurements (current, voltage,
power, elapsed time, integrated current, integrated
power) are shown on the display. Further, measure-
ments can be stored in internal memory.

Standard RS232C, USB, and LAN communication
functions

These functions allow easy incorporation into various
types of inspection systems.

GPIB function available as an option
Using the optional GPIB converter (p. 182), the GPIB

function can be used via the RS232C or USB interface.
(Limitations apply to some of the functions.)

Notations Used in This Manual

¢ In this manual, the PLZ1005WH2, PLZ2005WH?2,
PLZ4005WH2, PLZ12005WH2, or PLZ20005WH2 Elec-
tronic Load is also referred to as the PLZ-5WH2 or PLZ-
5WH2 series.

* The PLZ-5WH2 has five operation modes: CC, CR, CV,
CP, and ARB. The operation mode is sometimes simply
referred to as the mode.

* The term “PC” is used to refer generally to both personal
computers and workstations.

* The term “DUT” is used to refer generally to a device
under test.

* The screen captures and illustrations used in this text
may differ from the actual items.

» The following markings are used in this manual.

/A\WARNING

Indicates a potentially hazardous situation which, if ignored,
could result in death or serious injury.

/A\CAUTION

Indicates a potentially hazardous situation which, if ignored,
may result in slight injury or damage to the product or other
property.
(NOTE)

Indicates information that you should know.

Indicates a reference manual (CD-ROM) containing detailed
information.

>

Indicates the hierarchy of items you need to select. The item
to the left of this symbol indicates a higher level item.

PLZ-5WH2



[ Safety Precautions J

When using this product, be sure to observe the precau-
tions in the Safety Information manual. Items specific to
this product are given below.

AWARNING

Be careful of hearing loss.

Wear earplugs when working near the PLZ12005WH2
or PLZ20005WH2 when it is running.

The noise sound pressure level of this product is 80 dB
or less, but when this product is operated in the same
place as another product with a large noise sound pres-
sure level or when several of this product is operated
simultaneously in the same place, the pressure level
near the product may exceed 80 dB.

/A\CAUTION

» The exhaust air may become hot.

Stay away from the exhaust air flow. Move this product
away from installed objects to prevent the exhaust air
from hitting them directly.

* Do not use or store the PLZ1005WH2, PLZ2005WH2,
PLZ4005WH?2 in a vertical position.

Risk of falling over. Use the legs on the side panel of the
PLZ1005WH2 or PLZ2005WH2 to temporarily stand the
product up for the purpose of carrying it by the handle.

* Do not use the product where ventilation is poor.
Heat is expelled from vents of the rear panel.
To prevent the heat from building up and causing a fire,
keep the vents at least 75 cm away from walls.

Also, do not place objects within 75 cm of the rear panel.

PLZ-5WH2

{ Notes on Usage J

When installing this product, be sure to observe the tem-
perature and humidity ranges indicated below.
Operating temperature range: 0 °C to 40 °C (32 °F to
104 °F)

Operating humidity range: 20 %rh to 85 %rh (no con-
densation)

When storing this product, be sure to observe the tem-
perature and humidity ranges indicated below.
Storage temperature range: -25 °C to 60 °C (-13 °F to
140 °F)

Storage humidity range: 90 %rh or less (no condensa-
tion)

Adequately ventilate the room in which this product is
installed to keep the room temperature from rising.

Locking the casters and applying the stopper

The PLZ12005WH2 and PLZ20005WH2 have casters
on the bottom side, so it is easy to move the product. To
ensure that the product is not moved accidentally while it
is being operated, use the stopper to fix the product in
place, and lock the casters with your foot.

When moving the product, be sure to release the stop-
per. (PLZ12005WH2, PLZ20005WH2 only)

Loosen the stopper nut, and turn the stopper shaft to

raise its base up to the bottom of the product. Provide
adequate space between the base of the stopper and
the floor.

Otherwise, the stopper may hit an obstacle while the
product is being moved causing the stopper shaft to
break.

User’s Manual
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Component Names

Front panel

PLZ1005WH2, PLZ2005WH2, PLZ4005WH2

(PLZ1005WH2 example) 1

PLZ12005WH2, PLZ20005WH2

(PLZ12005WH2 example)
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No. Name Description See
Air inlet Air inlet for cooling. -

2 Protection plate This plate protects the front-panel DC INPUT terminals. The PLZ1005WH2, p.22
PLZ2005WH2, or PLZ4005WH2 and the DUT can be connected by removing
the protection plate and attaching the front-panel DC INPUT terminal cover.

When not using the front-panel DC INPUT terminals, be sure to attach the
protection plate.

3 USB port (host) This port is used to connect an external keyboard, save measurement data, p.28
save and load setup memory, save and load programs, and update the firm- p.64
ware.

p.79
p.106
p.142
4 Handle for carrying the PLZ1005WH2, PLZ2005WH2 only. p.184
product.
Handle The handle is used to move the product on casters. -
Feet PLZ1005WH2/PLZ2005WH2: 4 locations on bottom panel, 4 locations on p.184
side panel.
PLZ4005WH2: 4 locations on bottom panel.
7 Front-panel DC INPUT These terminals are used for simple connection with the DUT. The specifica- p. 22
terminals tions are for the rear-panel DC INPUT terminals and the front-panel DC
INPUT terminals may not meet the specifications.
| MON OUT connector This connector outputs current monitor signals. p.120
V MON OUT connector  This connector outputs voltage monitor signals.

10 TRIG OUT terminal This connector outputs trigger signals. p.118

11  Caster and caster lock Push the caster lock down firmly with your foot until it stays in the ON posi- p.5
tion.

12 POWER switch Flipping the switch to the | side turns the power on and the O side turns the  p.17
power off.

13  Stopper Use to fix the product in the installation place. p.5

Not used Do not remove the screw. -

PLZ-5WH2
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Controls

ESCAPE  ENTER

LC| AL =KEYLOCK 8

< LOAD | e s s |
| SOURCE MEASURE SEQUENCE SYSTEM

[ [
10 11 12

No. Name Function See
1 Display Displays the settings, measured values, and other information. p.13
2  Function keys Each function key executes the item that is displayed above that key (function p.26

area).
3 Sub-function keys Each sub-function key executes the item that is displayed to the left of that p.26
key (sub-function area).
4 Numeric keypad Enters values. p.28
5 CLEARkey Deletes numeric/character input. p.28
6 <«/— keys Move the cursor left and right. Select the left and right items. p.28
7 ENTER key Confirms numeric keypad input. Confirms a setting after it is selected. p.28
KEY LOCK key Hold down to lock the keys. p.129
8 ESCAPE key Cancels numeric/character input. Closes the window. p.28
LOCAL key Returns remote control to panel control. p.88
9 Rotary knob Selects items. Inputs numbers and characters. p.28
10 LOAD LED Lights when the load is on. p.30
11 LOAD key Switches between load on and off. p.30
12 Menu keys Switch the display. p.25
SOURCE key Operation modes, current/resistance/power/voltage value setting, resistance —
range, sine function, pulse function, slew rate, alarm, response speed, soft
start, cutoff function, external control, ABC preset memories, load on/off syn-
chronization.
MEASURE key Measurement function, measurement trigger function, integrated data display, —
measurement data saving.
SEQUENCE key Sequence creating, executing, and saving. Sequence start trigger function. p.89
SYSTEM key Remote sensing, system settings, interface settings, setup memory, SCPI p.126
error display, date setting, restore factory default setting, update, device infor-
mation display.
User’s Manual PLZ-5WH?2



| A oppL[22.000k W

0.0200 Alus |_r~,;p|_| OFF V|
9
No. Name Function See
1  Selected operation mode. Displays the selected operation mode. p.31
2  Current range Displays the current range (1 range). -
Changes to pink color when L range of CR mode is specified.
3 Voltage range Displays the voltage range (1 range). -
4 Remote Indicates that the product is being controlled remotely. p.88
5 Operation mode in use Displays the operation mode in use. p.31
6 LAN Displays the LAN connection status. -
Green: Communication enabled. Orange: Preparing for communication.
Red: Not connected.
7 lcons -
. Indicates that the pulse function is running. p.44
n Indicates that the sine function is running. p.47
. Indicates that measured values are being recorded. p.55
= Indicates that the cutoff function is enabled. p.70
N Cutoff cause: Elapsed time activation, voltage drop activation
=)/ [Eam Cutoff cause: Integrated current activation, integrated power activation
F Indicates that remote sensing is in progress. p.67
Indicates that key lock is on. The key lock level is indicated with a number.  p. 129
- Indicates that a sequence is running. p.103
././ External contact state and input logic setting (load on/off control). p.116
Indicates that an SCPI error has occurred. The number of error incidents p.135
(up to 16) is displayed numerically.
8  Sub-function area Indicates that execution is possible with the keys (sub-function keys) in the p.26
right side of the display.
9 function area Indicates that execution is possible with the keys (function keys) at the bot- p. 26
tom of the display.
10 Message area Displays alarm messages. p.48
11 Measured values The current, voltage, and power are displayed. The load input ratio foreach —
rating is displayed in bar graph form under the current value and voltage
value.
12 Integrated data Displays the integrated data when integrated data display is enabled. p.63
13 Value Displays load values (current, conductance, voltage, power) and other set- —
tings such as slew rate and alarm operating conditions.
PLZ-5WH?2 User’s Manual
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Rear panel

PLZ1005WH2, PLZ2005WH2, PLZ4005WH2

(PLZ1005WH2 example)
12 3 4 5

PLZ12005WH2, PLZ20005WH2

(PLZ12005WH2 example)
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No. Name Function See

1 USB port (device) These are used for remote control. C?N "

2 LANport Interface

3 RS232C port Manual

4 DC OUT connector This connector is used during GPIB converter (option) use. p.182

5 EXT SYNC connector This connector is used for synchronized operation. A cover for the pinsis  p, 82
provided.

6 PARALLEL connector This connector is used for parallel operation. A cover for the pins is pro- p.122
vided.

7 EXT CONT connector This connector is used for external control. A cover for the pins is provided. p. 108

8 SENSING terminals These terminals are used for remote sensing. p.67

9 AC INPUT connector This connector is used to connect the power cord. p.16

10 Serial number The product’s serial number. -

11 Rear-panel DCINPUT  These terminals are used to connect the DUT and the product. p.19

terminals
12 Air outlet Air outlet for cooling. -
13 Cord anchor This anchor is used to fix the power cord in place. -

PLZ-5WH2

User’s Manual
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Preparation

Connecting the Power Cord

/\WARNING Risk of electric shock.

* This product is IEC Safety Class | equipment (equipment with a protective con-
ductor terminal). Be sure to ground the product to prevent electric shock.

* The product is grounded through the power cord ground wire. Connect the pro-
tective conductor terminal to earth ground.

(NOTE) » Use the supplied power cord to connect to the AC line.

D If the supplied power cord cannot be used because the rated voltage or the plug shape
is incompatible, have a qualified engineer replace it with an appropriate power cord
that is 3 m or less in length. If obtaining a power cord is difficult, contact your Kikusui
agent or distributor.

» The power cord with a plug can be used to disconnect the product from the AC power
line in an emergency.

Secure adequate space around the power plug. Do not insert the power plug to an out-
let where accessibility to the plug is poor. And, do not place objects near the outlet that
would result in poor accessibility to the plug.

* Do not use the supplied power cord with other instruments.

This product is designed as an equipment of IEC Overvoltage Category Il (energy-consuming equipment
supplied from a fixed installation).

1 Turning the POWER switch off (O)

2 Check that the AC power line meets the nominal input rating of the product.

The product can receive a nominal line voltage in the range of 100 Vac to 240 Vac at 50 Hz or 60
Hz. (Frequency range: 47 Hz to 63 Hz)

3 Connect the power cord to the rear-panel AC INPUT.
For the PLZ12005WH2 or PLZ20005WH2, if necessary, secure the power cord with the cord

anchor.

4 Insert the power plug to an outlet with a ground terminal.
This completes the setting.

16 User’s Manual PLZ-5WH2



Preparation

Checking Whether the Power Is On or Off

Turning the power on

1
2
3

Check that the power cord is connected properly.
Check that nothing is connected to the DC INPUT terminals.

Turn the POWER switch (| ) on.
The power turns on, and the display lights.

-0.038,

0w

0.03. o000

A OPPL 4400 W

0.0040 .. UVPL| OFF v

By factory default, the panel settings immediately before the POWER switch is turned off are
saved. When you turn the power on, the product starts in the same state as it was in the last time it
was turned off. (However, the load setting is always Load Off.)

The panel setting state at startup can be changed (p.127).

(NOTE)

« If you notice strange sounds, unusual odors, fire, or smoke around or from inside the
product, flip the POWER switch off, or remove the power cord plug from the outlet.

* The POWER switch of the PLZ12005WH2 and PLZ20005WH?2 is a circuit breaker
type. If the AC power line is not compatible with the input rating of this product or if
there is an error in the internal power supply of this product, the POWER switch is acti-
vated as a power supply circuit breaker.

PLZ-5WH2

User’s Manual
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Preparation | Checking Whether the Power Is On or Off

Turning the power off

00000000000 0000000000000 000000000 0CQCOCCFCOCOCOOCOOPOPOPOPOPOPOCOOPOPOPOPOPOPOPOPQOPTOQOPQOPTOQTPTQOTOTTYTS

Turn the POWER switch off (O).

ACAUTlON If you want to turn the POWER switch back on, wait at least 5 seconds after the fan
stops. Repeatedly turning the POWER switch on and off at short intervals will shorten the
service life of the POWER switch and the internal input fuse.

User’s Manual PLZ-5WH?2



Preparation

Connecting to the DUT

Connect the DUT to the DC INPUT terminal. The PLZ1005WH2, PLZ2005WH2, and PLZ4005WH2 have
DC INPUT terminals on both the real panel and front panel. The specifications of the product are for the
rear-panel DC INPUT terminals.

For information on selecting load cables, refer to “Selecting the Load Cables” (p.160) in the “Appendix”.
Large current load cables are available as options.

/\WARNING Risk of electric shock.

¢ Do not touch DC INPUT terminals when the output is turned on.

* Do not approach or place non-isolated objects within 5 cm of the load cables
when the output is turned on.

¢ (PLZ1005WH2, PLZ2005WH2, and PLZ4005WH2 only) The front-panel DC INPUT
terminals are connected internally to the rear-panel DC INPUT terminals. The
voltage applied to the terminal on one side appears directly at the terminal on
the other side.

/\CAUTION  Risk of damage.

* Do not connect the DUT to the DC INPUT terminals while the product’s load is turned
on.

» Do not invert the polarity when connecting. An overcurrent might flow regardless of
whether the load is turned on.

(PLZ1005WH2, PLZ2005WH2, and PLZ4005WH2 only) Do not connect electronic
loads to the front-panel DC INPUT terminals and the rear-panel DC INPUT terminals
at the same time.

Risk of overheating.

« Attach crimping terminals to the cables, and use the supplied screws to connect the
cables.

PLZ-5WH2

User’s Manual
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Preparation | Connecting to the DUT

When connecting to the rear-panel DC INPUT terminals

Connect the DUT to the rear-panel DC INPUT terminals.

/\WARNING Risk of electric shock.

* Be sure to attach the included cover for the rear-panel DC INPUT terminals.

¢ (PLZ1005WH2, PLZ2005WH2, and PLZ4005WH2 only) Attach the protection plate
or included cover for the front-panel DC INPUT terminals also to the front-panel
DC INPUT terminals. The voltage applied to the rear-panel DC INPUT terminals
appears at the front-panel DC INPUT terminals.

Turn off the load.

Turn off the DUT output.

LWN =

Attach crimping terminals to the load cables.

The rear-panel DC INPUT terminals have bolt holes for connecting the load cables. Attach the
appropriate crimping terminals to the cables.

Model Bolt size Tightening torque
PLZ1005WH2, PLZ2005WH2, PLZ4005WH2 M10 22.46 N*m
PLZ12005WH2, PLZ20005WH2 M12 33.06 Nem

4 Connect the load cables to the rear-panel DC INPUT terminals using the screw set
for rear-panel DC INPUT terminals.

B PLZ1005WH2, PLZ2005WH2, PLZ4005WH2

g
il
M

o 3

| Positive
™ Negative

When there are two load cables When there are four load cables

User’s Manual PLZ-5WH?2



PLZ-5WH2

Preparation | Connecting to the DUT

Align the bottom half of the included rear-panel DC INPUT terminal cover to the
cables connected to the rear-panel DC INPUT terminals.

Align the top half of the cover to the bottom half.
Align the tabs of the cover according to the load cable diameter.

|

PLZ12005WH2 example

Push the cover against the panel, and fasten it with the included rear-panel DC
INPUT terminal cover screws.

Make sure that the screws are securely fastened.

PLZ12005WH2 example

Connect the load cables to the output terminals of the DUT.

Be careful to match the polarities of the rear-panel DC INPUT terminals with those of the DUT termi-
nals during connection.

Use the shortest cables possible to connect the product and DUT, and twist the cables. If the
cables are too thick to be twisted, bring the rear-panel DC INPUT terminal’s positive and negative
terminal cables close together and make them parallel.

This completes the connections.

User’s Manual
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Preparation | Connecting to the DUT

When connecting to the front-panel DC INPUT terminals

The PLZ1005WH2, PLZ2005WH2, and PLZ4005WH2 have DC INPUT terminals also on the front panel.
The front-panel DC INPUT terminals enable you to easily connect the product and DUT. The specifications
of the product are for the rear-panel DC INPUT terminals. The front-panel DC INPUT terminals may not
meet the specifications.

AWARMNG Risk of electric shock.

* Attach insulation caps to the crimping terminals.
* Be sure to attach the included cover for the front-panel DC INPUT terminals.

* Be sure to attach the included cover for the rear-panel DC INPUT terminals also
to the rear-panel DC INPUT terminals. The voltage applied to the front-panel DC
INPUT terminals appears at the rear-panel DC INPUT terminals.

(NOTE) The rated current value of the front-panel DC INPUT terminals is 30 A. When a current of
: : 30 A or more flows to the front-panel DC INPUT terminals, an alarm occurs and the load
turns off.

Turn off the load.

Turn off the DUT output.

W=

Attach crimping terminals to the load cables.
Cables with a nominal cross-sectional area up to 8 mm? can be used. Attach crimping terminals
that are designed for M5 screws.

4 Remove the protection plate from the front-panel DC INPUT terminals.
Keep the removed protection plate and screws in a safe place.

0000 |
0000 \
00 6000 \|

— OO
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Preparation | Connecting to the DUT

Connect the load cables to the front-panel DC INPUT terminals using the screws for
the front-panel DC INPUT terminals.

The tightening torque is 2.61 N'm.

8 Connect the load cables to the output terminals of the DUT.

Connect the positive (+) polarity of the front-panel DC INPUT terminals to the positive (+) polarity of
the DUT, and the negative (-) polarity of the front-panel DC INPUT terminals to the negative (-)
polarity of the DUT. Use the shortest cables possible to connect the product and DUT, and twist the
cables.

This completes the connections.

PLZ-5WH2 User’s Manual 23



Preparation | Connecting to the DUT

Notes regarding DC INPUT terminals

Do not apply overvoltage to the DC INPUT terminals

Risk of damage. Do not apply a voltage that exceeds 1000 Vdc to the DC INPUT termi-

ANCAUTION  Risk

DC INPUT terminal

_® o
DUT <1000 Vdc PLZ-5WH2

_6 -

If a voltage exceeding 1100 V is applied to the DC INPUT terminals, a
beeping sound is generated and an OVP alarm (overvoltage detection)

— appears.
0.02 If this happens, immediately lower the voltage of the DUT.
17 w

“M 0:00:00

0.0200) ,

Match the wiring polarity with that of the DUT

Risk of damage. Be careful to match the polarities of the DC INPUT terminals with those

/\CAUTION : .
of the DUT during connection.
Connect to the same polarity.
* * DC INPUT terminal
—® o
DUT PLZ-5WH2
—O o

1000V If a reverse voltage of -5 V or higher is applied or a reverse current
Reverse Alarm has occ (approximately -1 % of the rating) flows, a beeping sound is generated
e e and a reverse alarm (reverse-connection detection) appears.

If this happens, immediately shut off the DUT output.

A oppL|

0.0040 ,, .. uvpL|
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Basic Functions

Panel Operations

This chapter explains the front panel operations in general.
Switching the display

There are two display modes: function display and main display. The function display shows functions that

can be executed on each screen. The main display shows measured values with large numbers.

Pressing a menu key shows the function display of the corresponding menu screen. Pressing the same
menu key again on the function display switches the display to the main display.

SOURCE screen

-0.038,

Menu keys

T000V]

0 """‘ opp
0:00:00

0.03,

A oppPL| 4400 W

JvPLl OFF v

—— ——
SOURCE MEASURE

MEASURE scree|

T000V] (L, ]
Initiate

SEQUENCE

SYSTEM

SEQUENCE screen

T000V]

SEQUENCE

SYSTEMscreen

* On the SEQUENCE screen, the main display of the screen that appears when 3.Transient is pressed appears.
On the SYSTEM screen, the main display of the menu screen displayed previously appears.

Menu keys Main functions
SOURCE Operation mode and load Resistance range Slew rate Pulse
setting
Sine Alarm Response speed Soft start
Cutoff ABC preset memories  Load on/off synchroni-  External control
zation
MEASURE Measurement recording Measurement record- Integrated data record- Measurement record-
ing trigger ing, display ing synchronization
SEQUENCE Sequence function Program configuration ~ Step configuration Sequence execution
Sequence synchronization Sequence start trigger
SYSTEM Remote sensing Setup memory System configuration Interface configuration

SCPI error display

Date/time setting

Factory default settings

Resets settings

Display of device information

Updating

PLZ-5WH2
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Basic Functions | Panel Operations

Using the function keys

On the function display (p. 25), the available functions are shown in the function area and sub-function
area.You can execute or select the functions by pressing the corresponding function key or sub-function
key. The selected function is shown with a light gray background.

Sub-function area

1000V

0.038,
0.03, 0:00 00 C — Sub-function keys

[ A oppL| 4400w [ A opeL|

0.0040,,, .. uvPL| OFF vV 0.0040,, . uv

Selected function

Function keys

When several functions are shown

If several functions that can be used with a single function key are shown, you can toggle between the
functions by repeatedly pressing the function key.

[ A opeL[ 4400w

UvPL| OFF v M | puice Y pulse

off off

| Current | Current

A oppL| 4400w
0.0040,, . UvPL|  OFF Vv

‘Sine
Pulse

Mode More

Key names

In this document, individual function keys and sub-function keys are distinguished by indicating the func-
tion names shown in the function area or sub-function area as the key names. If there are several func-
tions shown, the name of the function to use is indicated as the key name.

Ex:

A opprL| 4400 W A oppL| 4400w

0.0040,, . UVPL|  OFF v 0.0040,,, . uveL| OFF v

[ ode ] More r More ol
o OO OO CDC)C)C)(L)
|— Displayed as “Mode” Displayed as “Level” when

the level function is in use
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Basic Functions | Panel Operations

Operation example (Selection of constant resistance mode)

1 Press SOURCE > Mode > CR.

In the above step example, press the buttons in the following order.

W Rake
0wl oep
_ 003, oo

ppL[ 4400 w

OOOOU

s UVPL[OFF v

S Level ]
Pulse -ABC

OO Oooo

More

SOURCE MEASURE SEQUENGE SYSTEM

"SOURCE P iE SEQUENGE SYSTEM

OQSOURCE

Identification using color markers

Menu identification

Color markers corresponding to the colors of menu keys are shown at the bottom edge of the function
area and at the right edge of the sub-function area. The color marker makes it possible to identify the pres-
ent menu screen.

Example: SOURCE screen (function display)

|“' |
]
]
! (Blue) (Brown) (Green) (Yellow)
' < " e | e—
: “'SOURGE *  MEASURE SEQUENCE SYSTEM
]
A opPL| 4400w | Q Q Q Q
a
0.0040,., < U\_,-pL| OFF Vv Menu keys
foids cocoodemognoBaan

Identification of settings and sub-function keys

PLZ-5WH2

On the SOURCE screen, the input area of each setting and the corresponding sub-function area are
assigned a specific color. Even when the sub-function area is hidden while the main display is shown, the
color is displayed at the right edge of the screen. With the main screen shown, you can enter settings by
pressing the function key with the color corresponding to the input area.

Example: SOURCE screen (when applying current)

Function display Main display

1000V,

The correspondence
between the input
area and sub-function
keys is indicated in
pink.

AN 0 . Even when the function

identify the correspond-
ing sub-function keys
with color.

There are no input area color markers on the MEASURE or SEQUENCE screen. When the main display is
shown, colors appear at the positions of the available sub-function keys.

User’s Manual
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Basic Functions | Panel Operations

Inputting numbers and characters

You can enter numbers and characters in input areas from the front panel or external keyboard. Numeric
input and character input switch automatically according to the input area.

If numbers or characters are selected in an input area, they can be changed. If only a cursor is shown in
an input area, you can enter characters or numbers at the cursor position.

1000V,

-0.038,
0w
0.03 v 0:00:00

Program Name

Slew
Rate

| opP

A opPL| 4400 w

Alps

More

Input area (value)

Entering from the front panel

Purpose

Sine
Pulse

uvPL|  OFF v

-Level

-ABC

@
———

Delete... |

dbps 3Transient More meert Range selection Cursor

Input area (character)

Operation

Description

Numeric input1

Numeric keypad

You can enter numbers and a decimal point. Following input, press
the ENTER key to confirm the value.

Rotary knob

You can enter numbers. Turn clockwise to increase the value and
counterclockwise to decrease. The value is confirmed immediately
upon input.

Character input

Numeric keypad

You can enter numbers and dots.

Rotary knob

Turn clockwise to enter characters in the following order: space,
uppercase letters, lowercase letters, numbers, and symbols. Turn
counterclockwise to enter character in reverse order. To enter the next
character, press the « or — key to move the cursor. The character
entered immediately before is confirmed when you press the < or —
key.

Cursor movement

«—/— keys

Changes the number of digits or input position.

Delete

CLEAR key

Deletes the number or character on the left of the cursor or the
selected range.

Cancel

ESCAPE key

Cancels numeric/character input.

1. Numeric input such as current and voltage has input limits based on the setting range and other conditions.
You cannot enter numbers outside the input range. For details on the setting ranges, see “Specifications”

(p.145).

Entering from an external keyboard

You can enter numbers/characters if you connect a keyboard to the USB port on the front panel.Use the
arrow keys to move the cursor, the Backspace and Delete key to delete numbers and characters, the
Escape key to cancel input, the Enter key to confirm, and the Tab key to move between input items. Con-
nect the keyboard while the product is turned on.

The types of keyboards that you can use are 101-key and 104-key keyboards.

User’s Manual
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Basic Functions | Panel Operations

Changing values

PLZ-5WH2

To change a selected value (e.g., load value), use the numeric keypad or rotary knob. If you enter a value
with the numeric keypad, following input, press the ENTER key to confirm the value.

1000V

current| e aaaeeey —— Use the numeric keypad or the
0.0040,, . UVPL[ | OFF v rotary knob to change the value.

-Sine

Mode More vk ABC

On screens in which “Edit” is shown in the sub-function area, use the rotary knob to select the item you
want to change, and then press the Edit key or a numeric key to start changing the value. Procedures
using the Edit key are provided in this document.

Pressing Edit or a numeric key makes it possible to edit the value.

= ] [660
000

000

r— 60

Recal | SCPI Admin  infomation

When changing a setting, if there are multiple items you can choose from, select a number in front of the
item name using the numeric keypad, or select the item using the rotary knob. Procedures using the rotary
knob are provided in this document.

If there are multiple items when settings are being changed, use
the numeric keypad or the rotary knob to select the item.

o1 low -]
o) >: Medium | Q
o) Hioh  ~|

SCPI Admin  Infomation

To confirm a value you entered, press the Edit or ENTER key. Procedures using the ENTER key are pro-
vided in this document.

Configure
Item

ENTER

Use Edit or ENTER to confirm the value.

1: Enable
1: Enable
1: Enable

Recall SCPI
_lntedface __Save

Admin  Infomation
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Basic Functions

Load On/Off

The phrase “load on” refers to a condition in which a current is running through the product. “Turning the
load on” refers to the operation of running a current through the product.

Conversely, “load off” refers to a condition in which a current is not running through the product. “Turning
the load off” refers to the operation of stopping a current from running through the product.

You can turn the load on and off using the LOAD key.

1 Press LOAD.
The value switches between load on and load off each time you press LOAD.

In the load on state, the load on LED lights.
In the load off state, the load on LED turns off.

Load-on LED
LOAD key

o= (l)L(

AD e — —
O SOURCE MEASURE SEQUENCE SYSTEM

B Controlling load on/load off externally
Load on/load off can be controlled using an external signal (p. 115).

B Gradually raising the input current
In constant current (CC) mode, you can set to slowly raise the input current.
(Soft start) (p.66).

B Turning off the load after a specified time elapses
When performing battery or capacitor discharge tests, it is convenient to use the function that turns off
the load when a specified time elapses (cutoff function) (p. 70).

B Turning off the load by specifying conditions
The load can be turned off when the voltage drop, the integrated current, or the integrated power
reaches the specified value (cutoff function) (p. 70).
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Basic Functions

Setting the Operation Mode

The product has the following five operation modes. Mode switching can be done only while the load is off.

Constant current (CC) mode When a current value is specified, the current is kept at that value even

when the voltage changes.

Constant resistance (CR) mode When a conductance value is specified, the product sinks current propor-

tional to the voltage variation by using the value as a proportionality con-

stant.

Constant voltage (CV) mode When a voltage value is specified, the product runs the current so that the
voltage is kept at that value.

Constant power (CP) mode When a power value is specified, the product runs the current so that the
power is kept at that value.

Arbitrary |-V characteristics The desired load characteristics can be set by specifying multiple arbitrary

(ARB) mode voltage values and current values as |-V characteristics.

Selecting the operation mode

PLZ-5WH2

You can set the operation mode only when the load is off.

1

Press SOURCE > Mode.
The operation mode is shown in the sub-function area.

A OPPL 4400 V

. UVPL[  OFF

‘Sine
Pulse -ABC

More

Use the sub-function keys to select the operation mode.

“CC” (red), “CR” (blue), “CV” (green), “CP” (orange), or “ARB” (gray) appears in the upper left of
the display depending on the selected operation mode.

This completes the setting.

User’s Manual
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Basic Functions | Setting the Operation Mode

Setting the current in CC mode

In CC mode, the current is kept constant even when the voltage changes.
For details, see “Operation of the constant current (CC) mode” (p. 167).

1 Set the operation mode to CC mode (p. 31).

2 Press Level > Current.

00040, . uveL|

More

Use the numeric keypad or the rotary knob to enter the current value.
This completes the setting. The current value can be changed even while the load is turned on.

Adding the +CV mode (a function compatible with the PLZ-5W series)

If you want to set the +CV mode, which is available on the PLZ-5W series (PLZ205W, PLZ405W,
PLZ1205W), on this product, use an SCPI command. The +CV mode can be specified in CC mode or CR
mode. If you set the +CV mode, CC+CV or CR+CV appears in the “selected operation mode” area (p. 13)
in the upper left of the display.

This function is available for maintaining compatibility with the SCPI commands of the PLZ-5W series. For
details on SCPI commands, see the Communication Interface Manual on the included CD-ROM.
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Basic Functions | Setting the Operation Mode

Setting the conductance in CR mode

In CR mode, the product sinks current proportional to the voltage variation.The displayed resistance is a
value converted from the conductance. An appropriate Sl prefix (k: kilo, m: milli) is displayed according to
the converted resistance, and up to three decimal digits are displayed (conductance [S] = 1/resistance
[Q]). For details, see “Operation in constant resistance (CR) mode” (p. 168).

1 Switch to CR mode (p. 317).

2 Press Level > Conductance.

0-03 v 0 D{J:I:;.[l

Conducin ] OPPL 4400 W
et OCPL| BAOO A
Open Q  yvp | OFF v

Mode Range Mare Pulse

_oppL| 4400w

7 OCPL|  88.00 A

Qoen O yypL | OFF v
-ABC

More Pulse

ol 5

10.000 kQ 833.333 0 998.801 mQ

Resistances are displayed with k for kilo or m for milli.
Up to three decimal places are displayed.

The conductance value can be changed even while the load is turned on.
This completes the setting.

Adding the +CV mode (a function compatible with the PLZ-5W series)

If you want to set the +CV mode, which is available on the PLZ-5W series (PLZ205W, PLZ405W,
PLZ1205W), on this product, use an SCPI command. The +CV mode can be specified in CC mode or CR
mode. If you set the +CV mode, CC+CV or CR+CV appears in the “selected operation mode” area (p. 13)
in the upper left of the display.

This function is available for maintaining compatibility with the SCPI commands of the PLZ-5W series. For
details on SCPI commands, see the Communication Interface Manual on the included CD-ROM.

PLZ-5WH?2 User’s Manual
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Basic Functions | Setting the Operation Mode

Setting the resistance range of CR mode

In CR mode, you can select H or L for the resistance range. The resistance range is used to set the con-
ductance with the appropriate resolution. The current range is fixed. You can set the resistance range
when the load is off.

1
2

Switch to CR mode (p. 31).

Press SOURCE > Range.

Set the resistance range to H or L.
The H range is used for conductance whose current variation is large relative to the voltage varia-
tion. Otherwise, the L range is used. When the L range is used, the current range display changes

from red to pink.

Pink in the L range
Red in the H range

1000V

-0.038
e

m g
2 ochL

Open O yypL |

Mode: More
PLZ20005WH2 example

OPPL|

[20m5]

80A 1 — | range

Resistance range

(U T H range

[2s]
0:00:00
4400 W
88.00 A
OFF v

Pulse !‘E‘Jf‘

Resistance range PLZ1005WH2 PLZ2005WH2 PLZ4005WH2
H range Setting range 505.00mSto0S 1010.0mSto0S 2020.0mSto0S
Resolution 0.01 mS 0.02 mS 0.05mS
L range Setting range 5.0500mSto0S 10.100mSto0S 20.200mSto0 S
Resolution 0.0001 mS 0.0002 mS 0.0005 mS
Resistance range PLZ12005WH2 PLZ20005WH2
H range Setting range 6060.0mSto0S 10.1000Sto0S
Resolution 0.2mS 0.2mS
L range Setting range 60.600mSto0S 101.000mSto0S
Resolution 0.002 mS 0.002 mS
PLZ-5WH2
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Basic Functions | Setting the Operation Mode

Setting the voltage in CV mode

In CV mode, the product runs current so that the voltage at the load input end of the product is constant.
For details, see “Constant voltage (CV) mode operation” (p.171).

1 Switch to CV mode (p. 31).

2 Press Level > Voltage.

1000V

20.039
0w oep
0-03 0:00:00 *

orpL| 4400 w
/
OCPL|  88.00 A

ABC

More

Use the numeric keypad or the rotary knob to enter the voltage value.
This completes the setting. The voltage value can be changed even while the load is turned on.
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Basic Functions | Setting the Operation Mode

Setting the power in CP mode

In CP mode, the product runs current so that the consumed power is constant.
For details, see “Constant power (CP) mode operation” (p. 170).

1 Switch to CP mode (p. 31).

2 Press Level > Power.

1000V

-0.038

0w

0'03 0:00:00 o

uve
OCPL 88.00 A

w
uvpL | OFF v

-Level

More ABC

3 Use the numeric keypad or the rotary knob to enter the power value.

This completes the setting. The power value can be changed even while the load is turned on.
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Setting the |-V characteristics in ARB mode

In ARB mode, arbitrary |-V characteristics can be set by registering multiple I-V characteristic points (pairs
of voltage and current values). Three up to 100 points can be registered, and the space between two
points is linearly interpolated. The minimum voltage (0.00 V) and current (0.00 A) and the maximum volt-
age (1010.00 V) are fixed. This mode can be used for simulation of LED loads and the like.

[A] Example of settings (values with an asterisk are fixed)
(¢
0.80 / )) Voltage [V]  Current [A]
0.60 [ 0.00* 0.00*
0.40 / 12.00 0.10
0.20 20.50 0.20
0 ; . : {f—t M 23.00 0.40
0 10.00 20.00 30.00 1010.00
24.50 0.80

|-V characteristics example

1010.00* 0.80

Displaying the I-V characteristics editing screen

1 Switch to ARB mode (p. 31).

Press Level > Table.
The |-V characteristics editing screen appears.

1000V

-0.038,

0w

opp
0'03 v 0:00:00

uvp
Voltage Current [=]
0.00 0000 | | count
1.00 0.000 = E]
More -ABC ‘

Basic operations on the |-V characteristics editing screen

The left column is voltage, and the right is current. In each row, you can enter a single point of your choice.

SO0 {ngilfl I Edit the selected cell
(when the cell can be edited)
0.038,
Selected cell (blue) Y opp
003 0:00:00
uve
Voltage Current [+]
Jse the rotary knob 0.00 0.000 Count Sets the number of rows
to move the selected 0.000 = 3

location. Mude<;=n'k
Use the <€ 'and » keys to move the selected location.
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Setting the number of rows

* You can change the total number of rows (Count 3 to Count 100) using the Count key.
* Increase the number of rows: A copy of the selected row is inserted after the selected row.

» Decrease the number of rows: If you set the total number of rows less than the number of the selected
row, the last rows excluding the very last row are deleted.
If you set the total number of rows larger than the number of the selected row, the selected
row and subsequent rows are deleted.

Selecting row 3 and Selecting row 4 and Selecting row 4 and
changing Count from 5 to 7 changing Count from 7 to 3 changing Count from 7 to 5
Voltage Current Voltage Current Voltage Current

1 0.00  0.000 1 0.00  0.000 1 0.00  0.000
2 1.00  0.100 2 1.00  0.100 2 1.00  0.100
3 3.00 0.200 3 3.00 0.200 3 2.00 0.200

< Two rows are

4 300 0300 . certed with the -2 3.00 0.300 | Deleted 4 3.00 0.300 | Deleted

5 1010.00  0.400 copy of row 3. 5 4.00 0.400 5 4.00 0.400
6 5.00  0.500 6 5.00  0.500
7 1010.0 0.600 7 1010.0 0.600

Voltage Current Voltage Current Voltage Current

1 0.00 0.000 1 0.00  0.000 1 0.00 0.000

2 1.00 0.100 2 1.00___0.100 2 1.00 0.100

3 200  0.200 310100 0.600 3200 0200

4 2.00 0.200 4 5.00  0.500

5 2.00  0.200 5 1010.0 0.600

6 3.00 0.300

7 1010.0 0.400

1 Press Count.

Use the numeric keypad or the rotary knob to enter the number of rows, and then
press ENTER.

This completes the setting.

Setting the frequency

» The voltage (0.00 V) and current (0.000 A) in the first row and the voltage (1010.00 V) in the last row
are fixed.

+ Set the voltages to linearly increasing values as the line number increases. Same values are consid-
ered an increase. You cannot enter a voltage that is less than the previous row or a voltage that is
greater than the next row.

1 Use the rotary knob and «/— keys to select a value.

2 Press Table (*Edit).
You can also press a key on the numeric keypad without pressing Table (e Edit) to start editing.

3 Use the numeric keys or rotary knob to enter a value, and then press ENTER.
This completes the setting.
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Example: Setting |-V characteristics

You can smoothly set the |-V characteristics by first setting the number of rows and then setting the row
with the maximum voltage and proceeding to rows with lower voltages. As an example, let’s set the |-V
characteristics while referring to the table below.

Example of settings (values
with an asterisk are fixed)

Count Voltage [V]

Current [A]

1 0.00* 0.000*
2 12.00 0.100
3 20.50 0.200
4 23.00 0.400
5 24.50 0.800
6 1010.00* 0.800

Voltag

0.00 0.000 D Count
1.00 0.000 3

More

LLANE Table
(+Edit)

Current
0.00

[ 1010.00 |

Mode More

PLZ-5WH2

Press Level > Table.
The |-V characteristics editing screen appears.

ESetting the count value

2
3

Press Count.

Use the numeric keypad or the rotary knob to enter the
number of rows (6), and then press ENTER.

The rows are added.

ESetting the current value of row 6

Set only the current value because the voltage is fixed to the maximum
voltage (1010.00 V).

Use the rotary knob and the — key to select the Current col-
umn of row 6.

Press Table (*Edit).
The current value in row 6 becomes editable.

Use the numeric keypad or the rotary knob to enter the cur-
rent value “0.8”, and then press ENTER.

The current value in row 6 is set to 0.8 A.
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ESetting the voltage value of row 5

7 Use the rotary knob and the — key to select the Voltage col-
umn of row 5.

. 8 Press Table (*Edit).
-0.039, The voltage value in row 5 becomes editable.

0.03,
I iuiafinlel g Use the numeric keypad or the rotary knob to enter the volt-
om0 2 age value “24.5”, and then press ENTER.

The voltage value in row 5 is setto 24.5 V.

s}
& 1010.00

Mode

ESetting the current value of row 5
1 0 Use the — key to select the Current column of row 5.

(LANE Table -
(Edi) 1 1 Press Table (*Edit).
0.038, The current value in row 5 becomes editable.

0.03,

Current

1 2 Use the numeric keypad or the rotary knob to enter the cur-
rent value “0.8”, and then press ENTER.

The current value in row 5 is set to 0.8 A.

0,800

More

ESetting the rest of the rows

- . 1 In the same manner, set the voltage and current values in
-0.039, rows 4 through 2.

0w . .
0.03 opp This completes the setting.
. v 0:00:00
\LET T Current [=] e
2 0100 ||| count
3 20.50 0.200 E 6

[ _Level |
-ABC

More

Characteristics display screen (example)

When you press SOURCE to show the main display, the IV characteristics are displayed.

1000V,

4400 W

OFF Vv
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Basic Functions

Setting the Slew Rate

You can set the speed of change when the current is changed.

The slew rate functions in the following cases.
» When the setting is changed to change the current value (including the pulse function).
» When the current value is changed using external control in constant current (CC) mode.
* When the current value is changed while the load is on

(NOTE) * The specified slew rate may not be achieved depending on the load cable inductance. If
\ ’ this happens, reduce the load cable inductance (p. 162).

« If the load current is small, the specified slew rate may not be achieved (p. 165).

« If the current changes when the load is turned on, the slew rate may be slower than the
setting.

PLZ-5WH2

You can set this regardless of whether the load is on or off. This function operates in CC and ARB modes.

1 Switch to CC or ARB mode (p.31).

2 Press Level > Slew Rate.

1000V

Current
-0.039
A
0w
oPP
0-03 0:00:00

uvp
f  0.000 A oppL[ 4400w

uveL|  OFF v
-Sine

Pulse ‘ABC

Alus

More

3 Use the numeric keypad or the rotary knob to enter the slew rate value.

The slew rate is set as an amount of current change per unit time. The value is common to rising
and falling slopes.

This completes the setting.
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Basic Functions

Pulse Function

Pulse refers to the operation of executing two settings repetitively. It is suitable for transient response char-
acteristics testing of large capacity power supplies and batteries. When the pulse operation is in progress,
a trigger signal is output from the TRIG OUT connector on the front panel (p.44). You can set this regard-
less of whether the load is on or off. This function operates in CC and CR modes.

Setting the pulse amplitude

The pulse amplitude is set with a value or a percentage of the load value.

Current [A] or
Conductance [S] (100 %)

b

Current

Current or conductance:
Load value in CC mode or CR mode
Depth: Pulse level
Depth [AIISTI%] |-}

O[AI[S](0 %) Time

Switch to CC or CR mode (p. 31).

Press Pulse > Current or Conductance.

1000V ™ | pulse
Off

Slew Rate

0 w [Depthia]

-Depth(%]

Depth|  0.000 A Freg|
----% Duty 50.0 %

Mode More il

Use the numeric keypad or the rotary knob to enter the load value (current or conduc-
tance).

In CC mode, enter the current value [A], and in CR mode, enter the conductance value [S].

Press Depth.

1000V ™ | pulse
Off

I Current
Slew Ratg

current [ 0,000 A
Depth|  0.000
50.0 %

-Sine

Mode

Use the numeric keypad or the rotary knob to enter the pulse amplitude (Depth).
The input switches between numeric input and percentage [%] input every time you press Depth.
This completes the setting.
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Setting the pulse interval

PLZ-5WH2

Set the frequency or period and then the length of time or duty cycle of the high level (the ratio of the high
level in a cycle).

Freq [Hz] or Period [s] Current or conductance:
‘ Load value in CC mode or CR mode

Th [s] or Duty [%] Depth: Pulse level
Freq: Frequency
Period: Period

Th: Operation time on the HIGH side
Th

Depth Duty:  Duty cycle |nverse of Freq or Period

Current

Current [A] or
Conductance [S] (100 %)

0 Time

1 Press SOURCE > Pulse > Freq or Period.
The input switches between frequency [Hz] input and cycle [s] input every time you press the key.

1000V ™ | pulse
Off

I Current

current [ 0,000 A 3
Depth|  0.000 A Fre
- y

Mode More il

2 Use the rotary knob to enter the frequency (FREQ) or period.

You can enter the frequency also using the numeric keypad. If you are using the numeric keypad,
you can only enter values within the frequency setting range defined in the specifications and with
the setting resolution within that range.

Example: If you try to enter 101 Hz, the “1” in the ones digit will not be accepted.

3 Press Duty or Th.

The input switches between duty ratio [%] input and high level time [s] input every time you press
the key.

1000V ™ | pulse
Off

I Current

current [ 0,000 A
Depth|  0.000 A Freq|
----% Duty

-Sine

Mode More

4 Use the rotary knob to enter the duty ratio or high level time (Th).

You can enter the duty ratio also using the numeric keypad. The minimum pulse interval is 20 ys.
The minimum changeable digit of high level time varies depending on the frequency.

This completes the setting.
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Basic Functions | Pulse Function

Turning the pulse function on/off

If you want to turn on the pulse function, set the pulse level (p.42) and pulse interval (p.43) in advance.

1 Press SOURCE > Pulse.

2 Press Pulse On or Pulse Off.

The pulse function toggles between on and off each time you press the key.
When the pulse function is on, . is shown on the display.

When set to off

1000V | pulce
off

Depth|  0.00
50.00

More -%”é"- = Mode

Timing of trigger signal output

When set to on

Slew Rate

0 w [Depthia]

[%a]

% Duty|  50.000

Si L
More e n= b

-ABC

When the pulse operation is in progress, a trigger signal is output for 10 ps from the TRIG OUT connector
on the front panel when the current amplitude changes from low to high level.

Current
HIGH

LOW
0 Time

TRIG OUT

Ead
10 us
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Basic Functions

Sine Function

The sine function varies the current sinusoidally. It is suitable for superposed ripple testing of large capac-
ity power supplies and batteries. When a sine operation is in progress, a trigger signal is output from the
TRIG OUT connector on the front panel (p.47). You can set this regardless of whether the load is on or off.
This function operates in CC mode. You cannot set the slew rate.

Setting the amplitude

PLZ-5WH2

Set the center value of the amplitude of the sine wave and the amplitude.

Current
Amplitude [A]
Current [A] I
Current: Load value (center value of the amplitude)
Amplitude: Sine amplitud
0[A] Time

Set the operation mode to CC mode (p. 31).

=N

2 Press Sine > Current.

1000V | sine
Off

0w

Ampl|  0.000 app
Freql 1 Hz

More Pulse

3 Use the numeric keypad or the rotary knob to enter the load value (Current).
The load value becomes the center value of the amplitude.

4 Press Amplitude.

1000V | sine
Off

_0.039 ) . Current
W Amplitude
0-03 0:00:00

current| 0,000 A

FI’qu

Level

Mode More Pulse ABC

5 Use the numeric keypad or the rotary knob to enter the sine amplitude (Amplitude).
The amplitude is a P-P value with the center value at the load value.
This completes the setting.
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Basic Functions | Sine Function

Amplitude limitation

When the amplitude is from 0 A to the rated current, setting the center value of the amplitude to Current 1
causes a portion of the upper side of the sine wave to exceed the rated current, so the amplitude is limited
by the rated current. Likewise, setting the center value of the amplitude to Current 2 causes a portion of
the lower side of the sine wave to become less than 0 A, so the amplitude is limited by 0 A.

Rated current Amplitude [A]

\ /‘\/ \

Current 1

t A\

Current (Al I \/ Current 2 i \ /\

O[A] |

Time

Setting the frequency

Set the frequency of the sine amplitude set with Amplitude.

Frequency [Hz]

Current ‘
Current: Load value (center value of the amplitude)
Current [A] Frequency: Frequency
0[A] Time

1 Press SOURCE > Sine > Frequency.

1000V | sine
Off

_0.039 ) |Currenl
0w |Amuhtu-je
0-03 0:00:00

Frequenc
Ampl|  0.000 app
current| 0,000 A | l
Freq Hz
Level

Mode More Pulse ABC

2 Use the numeric keypad or the rotary knob to enter the frequency.

If you are using the numeric keypad, you can only enter values within the frequency setting range
defined in the specifications and with the setting resolution within that range.

Example: If you try to enter 101 Hz, the “1” in the ones digit will not be accepted.
This completes the setting.
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Turning the sine function on/off

1 Set the operation mode to CC mode (p. 31).
2 Press Sine.

3 Press Sine On or Sine Off.

The sine function switches on and off each time you press the key.
When the sine function is on, “ is shown on the display.
When set to off When set to on
1000V, [LAN JE e
Off

Current

Ampl|  0.000 app

A
Freql 1 Hz
‘Lev

Pulse

More

Trigger signal timing

PLZ-5WH2

Current
Current
0 | Time
TRIG OUT |_|
“—>
10 us

If you want to turn on the sine function, set the sine amplitude (p.42) and frequency (p.43) in advance.

When a sine operation is in progress, a trigger signal is output for 10 ps from the TRIG OUT connector on
the front panel when the current passes through the center value of the amplitude (Current) on the rising
edge (sine wave phase at 0 degrees).
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Basic Functions

Alarm Function

This function detects anomalies and protects the DUT.

Alarm types and operation

There are two types of alarm based on urgency level: alarm 1 (high urgency) and alarm 2 (low urgency).

Alarm 1 (high urgency)

This alarm detects anomalies and automatically turns off the load. The operating conditions of this alarm

are fixed.

When alarm 1 occurs, immediately remove the cause(s) of the alarm.

Name Display Activation condition and handling Activation
Overvoltage detec- OVP Alarm A voltage that is equal to or exceeds 110 % of the rated Load off
tion voltage was applied to the DC INPUT terminals. If this

happens, immediately lower the voltage of the DUT.
Reverse-connection Reverse Alarm Approximately -1 % of the rated current flowed through Load off
detection the DC INPUT terminals. If this happens, immediately

shut off the DUT output.
Overheat detection, OTP/Front Alarm The temperature of the internal devices exceeds the Load off
overcurrent detec- standard. Check whether the air inlet on the front panel
tion of the front-panel and the air outlet on the rear panel are being
DC INPUT terminals obstructed.

A current of 30 A or more flowed through the front- Load off

panel DC INPUT terminals. Decrease the current, or

use the rear-panel DC INPUT terminals.
Alarm input detection External Alarm A signal between 1.5V and 0 V is applied to ALARM Load off

INPUT (pin No. 6) of the EXT CONT connector. First

clear the signal input to the EXT CONT connector, then

clear the product alarm.
Parallel operation See the refer- An anomaly occurred during parallel operation (p. 125). Load off
anomaly detection ence.

PLZ-5WH2
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Alarm 2 (low urgency)

Basic Functions | Alarm Function

This alarm protects the DUT. The operating conditions of this alarm can be set freely within a given range.

Name Display Mode Activation condition Activation
Overcurrent protec- OCP Alarm CR Current at or exceeding the OCP setting Load off or
tion (OCP) o (0 % to 110 % of rated current) flows (p.50). limit

CP
Overpower protec-  OPP Alarm CcC Power at or exceeding the OPP setting (0 % Load off or
tion (OPP) CcR o 110 % of rated current) is applied (p.57). limit

Ccv

ARB
Undervoltage protec- UVP Alarm CC The voltage becomes equal to or less than  Load off, limit,
tion (va)1 CR the UVP setting (0 V to 1000 V) (p.52). or activation off

CP

ARB
Watchdog Watchdog All SCPI communication is not performed fora  Load off
Protection (WDP) Alarm length of time that is equal to or exceeds the

watchdog protection setting (1 s to 3600 s)
(p.53).

1. UVP can be set to off.

Operating range

The following figure shows the alarm operating range. For details on the operating area of each operation

mode, see “Operating Area” (p. 166).

El Overvoltage detection activation voltage (1100 V) -

Rated voltage (1000 V)

EAUVP setting range
N

Operating current for reverse-connection

detection
(approx. -1% of the rating)

A/

OPP setting range

>

Rated power
Y \
/110% of rated power

Il
Operating voltage for reverse-connection \"_
detection
(-5V)

1 Logarithmic axis’

<

1 L)
o Rated current \
A OCP setting range

110% of rated current

(NOTE)

* The detection points of OCP, OPP, and UVP are the DC INPUT terminals of the prod-

uct. However, when the remote sensing function (p. 67) is used, the detection points
are the connection points (sensing points).

» The detection points for overvoltage detection and reverse-connection detection are
the DC INPUT terminals of the product.

PLZ-5WH2
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Basic Functions | Alarm Function

Setting overcurrent protection (OCP)

This function either puts a limit on the current (OCPL) or turns off the load of the product (OCPT) when a
current that is equal to or exceeds the set value is running through the product. You can set the overcur-
rent protection setting and the action taken when an alarm occurs.

You can set this function when the load is off. This function operates in CR, CV, and CP modes.

1

Switch to CR, CV, or CP mode (p. 31).

2 Press Level > OCP.

3 Use the numeric keypad or the rotary knob to enter the current value.

orpL| 4400 w
. | Action
Limit

ABC

OCPL

More

4 Press Action and select the action taken when an alarm occurs.

orpL| 4400 w

OCPL
More
Each time you press the key, the parameters displayed under Action change.

Parameter  Description

Trip Turns the load off. The setting display changes to OCPT.

Limit Limits the current so as not to exceed the set value. The setting display changes to OCPL.

This completes the setting.
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Setting overpower protection (OPP)

PLZ-5WH2

This function either puts a limit on the power (OPPL) or turns off the load of the product (OPPT) when a
current that is equal to or exceeds the set value is applied to the product. You can set the overpower pro-

tection setting and the action taken when an alarm occurs.

You can set this function when the load is off. This function operates in modes other than CP mode.

1

Switch to CC, CR, CV, or ARB mode (p.31).

2 Press Level > OPP.

3 Use the numeric keypad or the rotary knob to enter the power value.

| oPPL| | w
Valtagel 0.00 V i
oceL| 8800 A | 5T

Mode More

4 Press Action and select the action taken when an alarm occurs.

oppL| |

OCPL 88.00 A

More

Each time you press the key, the parameters displayed under Action change.

Parameter Description

Trip Turns the load off. The setting display changes to OPPT.
Limit Limits the power so as not to exceed the set value. The setting display changes
to OPPL.

This completes the setting.
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Basic Functions | Alarm Function

Setting undervoltage protection (UVP)

This function limits the current (UVPL) or turns off the load (UVPT) when the voltage applied to the product
becomes equal to or less than the UVP setting. You can also turn UVP off. You can set this regardless of
whether the load is on or off. This function operates in modes other than CV mode.

1 Switch to CC, CR, CP, or ARB mode (p. 31).

2 Press Level > UVP.

1000V

OPP

0:00:00
uve
of 0000 A oppL[ 4400w

; Action
0‘0040;.“;.”5 U‘,ﬂPLl | v Limit

-Sine
Mode More Pulse ABC

Use the numeric keypad or the rotary knob to enter the voltage value.
To turn this off, turn the rotary knob counterclockwise to select OFF.

4 Press Action and select the action taken when an alarm occurs.

(LAN N e
Current

-0.039,

[ opPp

0000 A oppL | aa00w
0.0040,, . uve | 1000 v

More

Each time you press the key, the parameters displayed under Action change.

Parameter Description

Trip Turns the load off. The setting display changes to UVPT.

Limit Limits the voltage so as not to become equal to or less than the set value. The
setting display changes to UVPL.

This completes the setting.

(NOTE) If the +CV mode is added with an SCPI command (p. 32), the UVP value is changed to
\ ’ the set voltage of the CV mode.If +CV mode is set to on, UVP limit operation is enabled.
Otherwise, UVP TRIP operation is enabled.
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Setting watchdog protection (WDP)

PLZ-5WH2

This function turns off the load of the product when SCPI communication is performed for a length of time
that is equal to or exceeds the WDP setting.

1

(<) I~

Press SYSTEM.
The Configure screen appears.

1: Enable
1: Enable =

SCPI Admin  Infomation

If the Configure screen does not appear, press Configure.

Use the rotary knob to select Delay under Watchdog, and then press Edit.

1: Enable
otection 1: Enable
SCPI 1: Enable =l

Recall scri
_lntedace __Saue - - ___

Admin  Infomation

Use the numeric keypad or the rotary knob to enter the duration of time until the
watchdog times out, and then press ENTER.

This sets the WDP value.
Use the rotary knob to select Watchdog, and then press Edit.

Use the rotary knob to select Enable or Disable, and then press ENTER.
This completes the setting.
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Basic Functions | Alarm Function

When an alarm occurs

An alarm message appears in the message area of the display. If the action taken when an alarm occurs is

set to Limit, the operation mode display changes to the alarm name.

0.02,

1 . l 8 v 0:00:49

200 A opepL| 22.000k W

1108.87,

0.0200 , . uwveL|

Example when OVP occurs Example when UVPL occurs

There are the following status outputs to the EXT CONT connector.

» When overvoltage detection (OVP), reverse-connection detection, overheat detection, alarm input
detection, or parallel operation anomaly detection is activated: ALARM1 (terminal 14) switches ON

* When OCP, OPP, UVP or WDP is activated: ALARM2 (pin 15) switches ON

Clearing an alarm

1 Remove the cause of the alarm.

Press ENTER.
The alarm is cleared.

L1000V

Alarm has been

cleared. 1 B
D w

8 . j -:5 vV 0:02:07

2,00 A Oppi

0.0200 , . uveT

(NOTE)

+ If the cause of the alarm remains, the alarm will occur again.
* You can also clear the alarm with an external control signal (p. 117).
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Basic Functions

Recording Measurements

This product shows the most recent measurements (current, voltage, power) on the display. Measure-
ments are recorded in the internal memory (data logging function).

By setting measurement recording conditions (p. 56), you can control the timing that measurements are
recorded. The recording timing of measurements can be synchronized on synchronized products (p. 85).

Starting measurement recording

PLZ-5WH2

1 Press MEASURE > Acquire.

Initiate

Edit

Item Value
~ Trigger
Source
Count 1

Data Display

2 Press the Initiate key.

Measurement recording starts. While recording is in progress, [[ll is displayed in the upper right of
the display.
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Basic Functions | Recording Measurements

Setting recording conditions

You can set the following measurement recording conditions.

Condition Value Description
Trigger - Set the measurement recording timing and the number of times to
record measurements.

Source - Event (trigger source) that defines the measurement recording condi-
tion. Recording starts after the Initiate key is pressed and a trigger is
received.

Immediate Pressing Initiate applies a trigger immediately.
BUS Applies a trigger when a *TRG command is received from a PC or
when the *TRG key on the front panel is pressed.
DIGITAL2' Applies a trigger when a signal is received at pin 13 of the EXT CONT
connector.
MSync The trigger application timing is synced between PLZ-5WH2 that are
synchronized (p. 85).
TALink Applies a trigger when a step is executed if Generate is set to TALink in
the sequence step settings (p.97).
Load Off Applies a trigger when the load is turned off.
Count 1 to 65536 The number of times to recorded measurements.
Delay Opsto100s The delay time from trigger application until measurement recording.
(resolution: 10 us)

Interval Disable/Enable Sets whether to insert an interval between recordings when Count is 2
or higher.

Interval 10 ys to 3600 s Recording interval time when Interval is set to Enable.

Time (resolution: 10 ps)

Sense Aperture

10usto1s
(resolution: 10 ps)

Time period of each recording. The average over the time period is
recorded.

1. Only when Direction of Digital 2 is set to Input (p. 131).
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Basic Functions | Recording Measurements

Recording condition setting examples

B Example 1:

* Source: Immediate
* Interval: Disable

» Count: 3
Press the Initiate key. Recording end
Measurement Measurement Measurement
recording recording recording v
|- LY count =1 count =2 count =3
|
! Delay Recording time Recording time Recording time !

(Delay) (Sense Aperture)

B Example 2:

» Source: BUS, DIGITAL2, TALink, MSync, or Loadoff
* Interval: Disable

» Count: 3
Press the Initiate key. Recording end
Trigger application Trigger application Trigger application
Measurement Measurement Measurement
recording recording recording v
|llll count =1 \_llllll count =2 _lllll count=3
l | |
! Delay Recording time ! DelayI Recording ! ! Delay  Recording
(Delay) (Sense Aperture) time time

B Example 3:

» Source: Immediate
* Interval: Enable

» Count: 3
Press the Initiate key. Recording end
Measurement Measurement Measurement
recording recording recording v
|l EEER Count :1 | count :2 |——— Count :3
! Delay [Recording time Recording time Recording time
(Delay) |(Sense Aperture)

Recording interval Recording interval
(Interval Time)

PLZ-5WH2 User’s Manual 57



58

Basic Functions | Recording Measurements

Measurement recording flowchart

Other
Source

Immediate

Trigger application

Rl

Delay
-

|‘

| INTERVAL TIMER=0 |

Measurement recording
(Sense Aperture)

INTERVAL TIMER start

COUNT=COUNT +1

Enable

Interval

Disable

INTERVAL TIMER =
Interval time

yes

Immediate
Source
Other

( End )

User’s Manual
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Basic Functions | Recording Measurements

Setting recording conditions

1 Press MEASURE > Acquire.

Use the rotary knob to select a measurement recording condition (p.56), and then

press Edit.

1000V,

Initiate
0.043 A

ETime[s] Curre

0: Immediate =
Count 1

Data Display

3 Use the numeric keys or rotary knob to enter a value, and then press ENTER.

Repeat Step 2 and Step 3 to set the recording conditions.
This completes the setting.

Aborting a measurement recording

1 Press Abort while measurement is in progress.

1000V LAN

Item

Source 0: Immediate
Count 1

Data Display

Measurement recording is aborted.

PLZ-5WH2
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Basic Functions | Recording Measurements

Displaying the recorded measurement

Measured data can be shown in a table or chart.

Table display

1 Press MEASURE > Display > Table.

1000V

:00:09

Ac_qui.rﬁ_I Data »
Function display Main display

You can perform the following operations on the main display.

Using the rotary knob,
Page Up
Page Down

Use the € and » keys to move the displayed item.

Chart display

1 Press MEASURE > Display > Chart.

1000V

A

!

J ‘lrf.
Sou”

Elapsed Time
Capacitv 0: Disable

Acquire  Data = 8 7.2 7. 7
Function display Main display

The horizontal and vertical scales are set automatically according to the measurement.
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Recording Integrated Data

Basic Functions

Recording integrated current, integrated power, and

elapsed time

Integrated current (Capacity Ah), integrated power (Energy Wh), and elapsed time (s) are called integrated
data. You can set the recording period and the reset method of integrated data as in the table below.

In the factory default conditions, Integral Gate is set to Load On and Reset is set to Auto.

Parameter Value Description

Integral Gate Set the integrated data recording period.

None Integrated data recording is started/stopped manually.

Load On Recording is started/stopped automatically in synchronization with load on/

load off. Or, recording is started or stopped manually.

Program Run Recording is started/stopped automatically in synchronization with
sequence execution start/stop. Or, recording is started or stopped manu-

ally.
Reset - Selects the integrated data reset method. If the product is restarted, inte-
grated data is reset.
Manual Integrated data is reset when the Reset key is pressed.
Auto Integrated data is automatically reset before the start of recordings. Or,

integrated data is reset when the Reset key is pressed.

Example: Integral Gate is set to Load On, and UVP is set
Voltage

UVP detection
voltage 0 : Time

Integrated data recording'

Setting the recording period and reset method of integrated data

1 Press MEASURE > Data.

2 Use the rotary knob to select the items, and then press Edit.

E Start

Stop

Value
1: Load On
1: Auto Reset

Acquire m Display E[\D,E.E:_L

3 Use the rotary knob to select the value, and then press ENTER.
Repeat Step 2 and Step 3 to set the recording period and reset method.
This completes the setting.

PLZ-5WH2
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Basic Functions | Recording Integrated Data

Recording integrated data manually

1 Press MEASURE > Data.

1000V

2 Press Start.
Integrated data recording starts.

3 Press Stop.
Integrated data recording stops.

Resetting integrated data

1 Press MEASURE > Data.

1000V

2 Press Reset.
This resets the integrated data.

User’s Manual
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Basic Functions | Recording Integrated Data

Showing or hiding integrated data

You can show or hide integrated data. This is useful for example for battery discharge tests.
By factory default, the integrated current and integrated power are not shown.

1 Press MEASURE > Display.

2 Use the rotary knob to select the parameter, and then press Edit.

1000V,

Item

1: Enable
Capacity 0: Disable
Enerav 0: Disable
Acquire  Data
Parameter Value Description
Display Elapsed Time Enable/Disable Shows the elapsed time.
Capacity Enable/Disable Shows the integrated current (Ah).
Energy Enable/Disable Shows the integrated power (Wh).
(NOTE) There is a +1 second error between the elapsed time recording (p. 67) and elapsed time
\ ) display.

3 Use the rotary knob to select Enable (show) or disable (hide), and then press ENTER.
This completes the setting.

1000V

Capacit 1 Enable = 0.0040 . UVPL| 10.00 v

Acquire  Data Display
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Basic Functions

Saving Measurement Data

Recorded measurement values (p.55) and integrated data (p.67) can be stored in CSV format to a USB
memory device.

1 Press MEASURE > Data Export.

Insert a USB memory device into the USB port on the front panel.
“sdxx” (xx changes depending on the USB memory device) appears.

Save the measurement data to USB.
Name

P

» ba setups

Acquire Data  Display %‘

3 Use the rotary knob to select the USB memory directory.
Select the directory and press — to open the lower level. Press « to close the lower level.
The top directory, sdxx, is the root directory of the USB memory device.

4 Press Save As.
The CSV data is saved.

5 Use the numeric keypad or the rotary knob to enter a file name of your choice, and
then press ENTER.

~ B sda
» @ System Volume Information

The measurement data is saved with the specified file name.

CSV data
Example: Format of the CSV data saved to a USB memory device
ETimel[s] Current[A] Voltage[V] Power[W] Capacity[Ah] Energy[Wh]
30.92355 0.556787 4.305881 2.397457 0.018838 0.087071
31.02355 0.679384 4.305859 2.925332 0.018857 0.087152
31.12355 1.823047 4.305092 7.848385 0.018908 0.08737
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Advanced Functions

Changing the Response Speed

Set the response speed for CV, CR, or ARB mode according to the DUT’s conditions and application.

In CV or CR mode, the factory default setting is “Normal”. You can make the response speed faster by set-
ting “Fast”. In ARB mode, the factory default setting is “500 ps”.

Parameter Description

Response Voltage Set the response speed for CV mode. Normal, Fast

Conductance Set the response speed for CR mode. Normal, Fast

ARB Set the response speed for ARB mode. The value is the filter response time. Select
OFF for no filter.

OFF, 500 ps, 1 ms, 2 ms, 5 ms, 10 ms, 20 ms, 50 ms, 100 ms

(NOTE) When the response speed is set to Fast, the operation may become unstable if the load
; : cable is long or has a large loop. If this happens, decrease the response speed.

Switch to CV, CR, or ARB mode (p. 31).

1
2 Press More.
3

Use the rotary knob to select Voltage, Conductance, or ARB under Response, and
then press Edit.

-0.508
0w
004 0:00:00

Value

0: Normal
Conductance  0: Normal
Mode More

4 Use the rotary knob to select the value, and then press ENTER.
This completes the setting.

PLZ-5WH?2 User’s Manual
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Advanced Functions

Soft Start

Soft start is a function that controls the rise time of the load current.

Soft start functions only when all the following conditions are met.
* The rise time of the soft start has been set.
* Load on state in constant current (CC) mode.
» There is an input that is equal to or exceeds 1.5V, from the state where there is no input to the DC

INPUT terminals.

If the load current rises sharply, the DUT output may become unstable or the DUT’s overcurrent protection
circuit may be activated. In such situations, it is possible to raise the load current slowly only when the
product is started.

m When soft start has been disabled

o Input voltage or input current

m When soft start has been set properly

Time

o Input voltage or input current

| Time

Load  PLZ-5WH2 Load PLZ-5WH2

On

b

Rise start (Current starts flowing.) On Rise start (Current starts flowing.)

—— DUT’s voltage waveform
....... PLZ-5WH2

Press SOURCE > More.

Use the rotary knob to select Soft Start, and then press Edit.

1000V

Item Value
ARB ﬁr D
: OFF -

= Cutoff

=
-Sine Level
Mode More Pulse ABC

Use the rotary knob to select the soft start time, and then press ENTER.

Selecting Off disables soft start.
This completes the setting.

User’s Manual
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Advanced Functions

Remote Sensing

You can change a voltage measurement point from a DC INPUT terminal to an arbitrary sensing point. By
setting sensing points at the DUT end, influences such as voltage drops caused by the resistance of the load
cables can be reduced, and the load current can be stabilized.

To use remote sensing, connect the sensing cables to the product's SENSING terminals (+S, -S) and the
DUT terminals, and enable remote sensing in the SYSTEM menu.

Connecting cables to the safety terminal adapters

When connecting sensing cables to the SENSING terminals, use the included safety terminal adapters
(TL41).

Use sensing cables with a withstanding voltage of at least 1000 V. Unlike with the load cables, there is no
need to consider the allowable current. Cable diameter with a nominal cross-sectional area between

0.75 mm? and 2.5 mm? (AWG18 and AWG14) is compatible with the safety terminal adapter.
6 mm

R — LU=

Insert the conductive part of the wire into the hole.

Flat-blade screwdriver
Blade width: 2.5 mm or less
Blade thickness: 0.35 mm or less
Tightening torque: 0.5 N*m
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Advanced Functions | Remote Sensing

Connecting the sensing cables

Connect the included safety terminal adapter, TL41, to the sensing cables in advance. (p.67)

&CAU'”ON * Risk of damage to the internal circuitry. Never connect cables to the SENSING termi-

nals while the POWER switch is turned on.

« If the remote sensing cables come loose while remote sensing is in use, the product
and DUT may be damaged. Be sure to connect the cables securely.

Turning the POWER switch off (O)

N

2 Connect the sensing cables to the product.

PLZ12005WH2 example

3 Connect the sensing cables to the DUT.

~__ -S(black)

/// +S (red)
/% Black

[f Red

When connecting, match the polarities of the SENSING terminals with those of the DUT terminals.

SENSING terminals

DUT

PLZ-5WH2

This completes the connections.
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Advanced Functions | Remote Sensing

Enabling or disabling remote sensing

PLZ-5WH2

After connecting the sensing cables to the SENSING terminals, enable remote sensing.
Remote sensing can be set when the load is turned off and sequence operation is stopped.

1 Press SYSTEM.
If the Configure screen does not appear, press Configure.

2 Use the rotary knob to select Remote Sensing, and then press Edit.

Configure
Item

Admin  Infomation

3 Use the rotary knob to select Enable or Disable, and then press ENTER.

If you select Enable, m appears in the upper right of the display other than the SYSTEM screen.
This completes the setting.
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Advanced Functions

Cutoff Function

This function turns the load off when the elapsed time from load-on, the voltage drop, the integrated cur-
rent, or the integrated power reaches the specified value. These four functions are collectively referred to

as cutoff.

Setting the cutoff activation condition

Multiple cutoffs can be specified simultaneously. If any of the cutoff items is enabled, an icon (JG)
appears in the top area of the display. If a cutoff is activated, the icon corresponding to the item that

caused it appears in the top area of the display (p. 73).

Cutoff item Description

Elapsed time

The load turns off when the elapsed time value reaches the specified value.

Voltage drop1

The load turns off when the voltmeter value reaches the specified value.

Integrated current

The load turns off when the ampere-hour meter value reaches the specified value.

Integrated power

The load turns off when the watt-hour meter value reaches the specified value.

1.

=N

The same operation is performed using Trip (UVPT) of the constant voltage protection (UVP), but whereas
when an UVPT is activated, an alarm occurs, in the case of cutoff, an alarm does not occur.

Press SOURCE > More.

Use the rotary knob to select State under the item you want to set, and then press
Edit.

» For elapsed time, select State under ETime.

 For voltage drop, select State under Voltage.

» For integrated current, select State under Capacity.

» For integrated power, select State under Energy.

1000V

-0.511, B3

0w

0'04 v 0:00:00

Item Value [=]
~ETime D
-

0: Disable
Levells] 0
Mode

=]

3 Use the rotary knob to set Enable or Disable, and then press ENTER.

PLZ-5WH2
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Advanced Functions | Cutoff Function

4 If set to Enable, use the rotary knob to select Level, and then press Edit.

-0.513, [ o |

0 w
0-03 0:00:00

Item Value =
State 1: Enable D
+ |

|
~\Voltage =l

-Sine Level
Mode Pulse ABC

Use the numeric keypad or the rotary knob to enter the value for activating the cut-
off, and then press ENTER.

Parameter Setting range Resolution
Elapsed 0 s to 3600000 s (1000 h 0 min 0 s) 1s

time

Voltage 0.00 V to 1000.00 V 0.02Vv
drop

Integrated 0.000 mAh to 70.000 kAh (PLZ1005WH2) 0.001 mAh (0.000 mAh to 1000.000 mAh)

current 0.000 mAh to 140.000 kAh (PLZ2005WH2) 0.001 Ah (1.001 Ah to 1000.000 Ah)
0.000 mAh to 280.000 kAh (PLZ4005WH2) 0.001 kAh (1.001 kAh to 1000.000 kAh)
0.000 mAh to 800.000 kAh (PLZ12005WH2)  0.001 MAh (1.001 MAh to 1.400 MAh)
0.000 mAh to 1400.000 kAh (PLZ20005WH2)

Integrated  0.000 Wh to 40.000 MWh (PLZ1005WH2) 0.001 Wh (0.000 Wh to 1000.000 Wh)
power 0.000 Wh to 80.000 MWh (PLZ2005WH2) 0.001 kWh (1.001 kWh to 1000.000 kWh)
0.000 Wh to 160.000 MWh (PLZ4005WH2) 0.001 MWh (1.001 MWh to 800.000 MWh)
0.000 Wh to 500.000 MWh (PLZ12005WH2)
0.000 Wh to 800.000 MWh (PLZ20005WH2)

This completes the setting.
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Advanced Functions | Cutoff Function

Cutoff operation

Cutoff is activated based on integrated data (p.67). The operation necessary before and after the cutoff
varies depending on the integrated data recording setting.

B Relationship between the cutoff activation condition, integrated data setting, and load
on/off

Example: When the enabled cutoff activation condition is set only to elapsed time (ETime) and Level is set
to 10 seconds

LOAD ON LOAD ON
Integrated data setting | Loadon - S :
Integral Gate: Load On Load off
Reset: Auto oad o _— T e
. N Cutoff activation
10 seconds 10 seconds
LOAD ON Reset LOAD ON
Integrated data setting | Loadon  oo.... ————— — :
Integral Gate: Load On l
Reset: Manual Load Off  mmmmmhcoooccccicecc ~ S R
10 seconds Cutoff activation 10 seconds
Stgrt LOAP ON Stpp Stgrt LOAI? ON
Integrated data setting | Loadon oo R e S —— S
Integral Gate: None' | | |
Reset: Auto Load off = : e
\Cutoff activation
10 seconds 10 seconds
Start  LOAD ON Stop Reset Start LOAD ON
Integrated data setting | | agon S — — j— — — ‘
Integral Gate: None' } } ! }
Reset: Manual Load off re— ~ . - de— -
10 seconds Cutoff activation 10 seconds

1 When Integral Gate is set to Program Run, the operation is similar as when None is specified. Read Start as
sequence start, Stop as sequence stop, and LOAD ON as Load On step start.

B Turning the load on again after cutoff

Even when the load is turned on, if the cutoff activation condition is satisfied, the cutoff is activated imme-
diately and the load turns off. To turn the load on again, reset the integrated data, change the cutoff activa-
tion condition, or disable the cutoff that caused the activation.
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Advanced Functions | Cutoff Function

When cutoff is activated

When any of the enabled cutoff items (elapsed time, voltage drop, integrated current, or integrated power)
reaches the specified value, cutoff is activated, and the load turns off. If a cutoff is activated, the icon cor-
responding to the item that caused it appears in the top area of the display. The activation cause icon
remains displayed until the load is turned on the next time.

1000V

Display example Elapsed time Voltage drop

-0.514

0w

0-03 0:00:05

Integrated current Integrated power o Item Value
hd ime

Levellsl 5

-Sine Level
Mode Pulse __ABC

(NOTE If a cutoff occurs due to a voltage drop, check the DUT state before measuring again.

PLZ-5WH2
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Advanced Functions

Types of Memory

The product has two types of memory, ABC preset memories and setup memory.

ABC preset memories are for storing three sets (A, B, and C) of load values. Because you can recall
saved settings just by pressing a key, this feature is useful when you want to switch between the three sets
of values in order.

Setup memory stores all basic settings.

B Differences between ABC preset memories and setup memory

Parameter ABC preset memories Setup Memory

Number of 3 20 (internal memory)

memory entries Depends on the memory size (USB mem-
ory)

Memory name A,B,C 0 to 19 (internal memory)

Any name (USB memory)

Saved setting Load values for each operation mode (cur- Load on/off state
rent, voltage, conductance, power) Operation mode

Load values (current, voltage, conduc-
tance, power)
Slew rate
Pulse amplitude
Pulse interval
Sine amplitude
Sine frequency
Alarm 2 operating conditions
ABC preset memories

When load is on  Memory entries can be saved or recalled. = Memory entries can be saved but not
recalled

When load is off Memory entries can be saved or recalled. = Memory entries can be saved or recalled.
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ABC Preset Memories

Advanced Functions

Load values can be saved in any of the three memories A, B, or C.
The load values for each operation mode saved to the memories are as follows.

Operation mode Load value

CC mode Current

CR mode Conductance

CP mode Power

CV mode Voltage

ARB mode Number of table rows, voltage, current

PLZ-5WH2
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Advanced Functions | ABC Preset Memories

Saving to ABC preset memories

You can save settings regardless of whether the load is on or off. Alarm operating conditions are not
saved.

1 Enter the load settings in the operation mode that you want to save in.

2 Press ABC to select ABC.
Each time you press the key, the selected item changes.

1000V

A oppL| 4400 W
0.0040,,. UVPL[  OFF Vv Store

-Sine

Mode More Pulse

Press Store.

Press a sub-function keys to select the memory (A, B, C) you want to save to, and
then press ENTER.

A confirmation pop-up message appears. Use the left and right arrow keys to select OK, and press
ENTER.

=

1000V

Do you want to store
= preset memory A?

| cancel | oK COA
v LI.UU.UO

Recall
A oppL| 4400 W

0.0040,,,. uveL[  OFF v SGIE

-Sine Level
Pulse :AB

More

5 Press ENTER.

The settings are saved to the selected memory.
If setting have already been saved, they are overwritten.

1000V

A
OJ.BAI— The saved load value is displayed.
-O. 5 ].6 . {3\ (except ARB mode)

owl ¢

003 0:00:00 O

A oprL| 4400 W

0.0040,,,. UVPL|  OFF v Store

“Sine
Pulse

Example: CC mode, saved to memory A

More
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Advanced Functions | ABC Preset Memories

Recalling ABC preset memory entries

You can recall settings regardless of whether the load is on or off.

If the settings that you recall cause alarm operating conditions to be exceeded, an alarm will occur.

(NOTE)

Alarm operating conditions are not saved to ABC preset memories.

=

PLZ-5WH2

Set the operation mode to the same setting as that in the memory you want to
recall.

Memories cannot be recalled if the operation mode is different.

Press ABC to select ABC.
Each time you press the key, the selected item changes.

1000V AN )

Recall

Current | A oppL| 4400 w

0.0040,,. UVPL[  OFF Vv Store

Mode Maore FSI.IIEEE

Press Recall.

Press the sub-function key (A, B, or C) for the memory to be recalled.

1000V

el
0.18A ——

-O. ) ].9 A LB —— The saved load value is displayed.

0wl ¢ (except ARB mode)
003 0:00:00 " “a

Recall

current] | A oPPL| 4400 W
0.0040,,,. UVPL|  OFF v Store

Mode More i EW‘

Pulse
Example: CC mode

The ABC preset memory is recalled.

User’s Manual

77



78

Advanced Functions

Setup Memory

The setup memory can store up to 20 sets (0 to 19) of the current conditions of the items listed below. The
current conditions can also be saved in a USB memory device.

Load on/off state

Operation mode

Load values (current, voltage, conductance, power)

Slew rate

Pulse amplitude (current/conductance or percentage)

Pulse interval (frequency/time of one cycle and duty cycle/operating time on the high side)
Sine amplitude (current)

Sine frequency

Alarm operating conditions

Content of ABC preset memories

How to view the setup memory edit screen

Press SYSTEM and then Recall Save to display the setup memory edit screen. The internal memory con-
tains an empty setup memory set. Connecting a USB memory device to the USB port on the front panel
displays an “sdxx” folder (the “xx” changes depending on the USB memory device) enabling you to save
and recall the setup memory from the USB memory device.

Select a folder and press »
to open the folder.

USB memory device

Press < to close it. B Untitled2.info
fm setups
= E::::z Internal memory
ltem \
Date Madified 6 6 ‘murerey  Details of the setup memory
B (Property)
User’s Manual PLZ-5WH2



Advanced Functions | Setup Memory

Saving to the setup memory

Saving over previous settings (internal memory and USB memory)

3
4

Set the operation mode and settings to the states you want to save them in.

Press SYSTEM > Recall Save.

Connecting a USB memory device to the USB port on the front panel displays an “sdxx” folder (the
“xx” changes depending on the USB memory device).

Use the rotary knob to select the setup memory.

Press Save.
The setting contents are saved to the setup memory.

Saving to a new file (USB memory device only)

1
2
3
4

PLZ-5WH2

Set the operation mode and settings to the states you want to save them in.
Press SYSTEM > Recall Save.

Insert a USB memory device into the USB port on the front panel.
An “sdxx” folder is displayed. The “xx” changes depending on the USB memory device.

Use the rotary knob to select the sdxx folder, and press Save As.
A new setup memory is created.

Recall

B olinfo

B 02.info

) ot
-Configure Recall .
_interiace MRV SCPI

Admin  Infomation

Use the numeric keypad or the rotary knob to enter a file name of your choice, and
then press ENTER.

Be sure to add an extension (.info) to the file name.
The setup memory is saved to a new file.
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Advanced Functions | Setup Memory

Changing the memory name (USB memory device only)

1 Press SYSTEM > Recall Save.

2 Insert a USB memory device into the USB port on the front panel.
An “sdxx” folder is displayed. The “xx” changes depending on the USB memory device.

3 Use the rotary knob to select the setup memory, and press Rename.

Recall

B olinfo

B 02.info

SCPI Admin  Infomation

4 Use the numeric keypad or the rotary knob to enter a file name of your choice, and
then press ENTER.

Be sure to add an extension (.info) to the file name.
The memory name is saved.

Checking the setup memory details

1 Press SYSTEM > Recall Save.
2 Use the rotary knob to select the setup memory.
3 Press Property.
The detailed information of the setup memory is displayed. The detailed information can be

scrolled by using the rotary knob.
Press Property again to return to the original state.

Item

Date Modified
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Advanced Functions | Setup Memory

Recalling the setup memory

You can recall memory content when load is turned off.

1 Press SYSTEM > Recall Save.

2 Use the rotary knob to select the setup memory.
Press Property to view the setting content of the setup memory.

Connecting a USB memory device to the USB port on the front panel displays an “sdxx” folder (the
“xx” changes depending on the USB memory device).

3 Press Recall.
The setting content of the selected setup memory is recalled.

Recall

[=]
D Save |

Prc»pert‘,i

Admin  Infomation

Sharing the setup memory with the PLZ-5W

B Loading a file saved on the PLZ-5W into the PLZ-5WH2 (USB memory device)

A file saved on the PLZ-5W (PLZ205W, PLZ405W, PLZ1205W) to a USB memory device can be loaded
into this product. All the above items can be loaded, but the following operations will be different.

+ If +CV mode is set on the PLZ-5W, the UVP action of this product will be Limit.
+ If +CV mode is not set on the PLZ-5W, the UVP action of this product will be Trip.

« The current ranges and voltage ranges set on the PLZ-5W are handled as PLZ-5W’s H range on this
product.

B Loading a file saved on the PLZ-5WH2 into the PLZ-5W (USB memory device)

« If the UVP action is set to Limit on this product, +CV mode will be set on the PLZ-5W (PLZ205W,
PLZ405W, PLZ1205W).
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Advanced Functions

Synchronized Operation

If you interconnect the PLZ-5WH2 series products with LAN cables, synchronized operation can be per-
formed from any of the connected products.

» Synchronizing the load on/off operation
» Synchronizing measurement recording (remote control only)
» Synchronizing the starting and resuming of sequences

Any of the models in the PLZ-5WH series or PLZ-5WH2 series can be connected together. Synchronized
operation is possible even during parallel operation.

B Simple setting using LAN cables

Common LAN cables (straight-through) up to 3m long can be used. If you need to use a LAN cable longer
than 3 m, please contact your Kikusui agent or distributor.

Connection for synchronized operation

1 Turn off all the PLZ-5WH2 series products that you will connect.

2 Remove the SYNC/PARALLEL port cover.

__M3x6

PLZ12005WH2 example
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Advanced Functions | Synchronized Operation

Connect all the PLZ-5WH2 series products with LAN cables.
Connect the OUT port of EXT SYNC of the product to the IN port of EXT SYNC of another unit with

a LAN cable.
Connection example LAN cable (straight)
To EXT SYNC IN of ( EXT SYNC OUT EXT SYNC IN EXT SYNC OUT
another device ) | 1 | |
O >, EH!@ P4 O, ﬂ'ﬁ

E ago. dEoE 3. 00
L U

—J

e

(r

ST e g
Sz i)

- -

PLZ12005WH2 example

This completes the connections.
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Advanced Functions | Synchronized Operation

Synchronizing the load on/off operation

You can synchronize the load on/off operation on multiple synchronized PLZ-5WH2 series products.

1 Press SOURCE > More.

2 Press Sync Enable.

Load on/off synchronization switches between enabled and disabled each time you press the key.
When load on/off synchronization is enabled, “Load On” and “Load Off” appear in the sub-function
area.

0.02,

0w BERE

-0.01
. Load
ten Valye L) On
- Load
Off

0:00:00

Perform Step 1 and Step 2 on all the PLZ-5WH2 series products you want to syn-
chronize.

4 Press Load On or Load Off on any of the synchronized PLZ-5WH2s.

The load on/off operation will be synchronized among all PLZ-5WH2 series products whose load
on/off synchronization was enabled.
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Advanced Functions | Synchronized Operation

Synchronizing measurement recording

PLZ-5WH2

Measurement recording (p. 55) can be synchronized among multiple synchronized PLZ-5WH2s.

1 Press MEASURE > Acquire.
2 Use the rotary knob to select Source under Trigger, and then press Edit.

3 Use the rotary knob to select MSync, and then press ENTER.

1000V

LAN T
Initiate

Edit

Item
= Trigger

Count

Data Display

4 Press Initiate.
The “MSync” is shown in the sub-function area.

Count 1
m Data Display

5 Perform Step 1 and Step 4 on all the PLZ-5WH2 series products you want to syn-
chronize.

6 Press MSync on any of the synchronized PLZ-5WH2s.
Measurement starts simultaneously on all synchronized PLZ-5WH?2 series products.

User’s Manual
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Advanced Functions | Synchronized Operation

Synchronizing the start of sequences

The start of sequences can be synchronized among multiple synchronized PLZ-5WH2 series products.

1

Press SEQUENCE > More.

2 Use the rotary knob to select Source under Trigger, and then press Edit.

3 Use the rotary knob to select MSync, and then press ENTER.

User’s Manual

1000V

-0.533

0w

0-03 0:00:00

Iltem
= Trigger

Delavls] 0
1.Program 2.5teps 3 Transient [N (¢=]

Execute the sequence (p.703).

The sequence pauses before executm he rs see aa d “Mncn apears sn te suuf utton
area.

1000V

-0.532
0 w
O -04 0:00:00

th MSync

Import
Export

1.Program 2.Steps

Perform Step 1 and Step 4 on all the PLZ-5WH2 series products you want to syn-
chronize.

Press MSync on any of the synchronized PLZ-5WH2s.
The sequence starts simultaneously on all synchronized PLZ-5WH2 series products.

PLZ-5WH2



Advanced Functions | Synchronized Operation

Synchronizing the resuming of sequences

A sequence will stop at a step with Wait (pre) set to MSync (p. 95).

The resuming of a paused sequence (trigger wait) can be synchronized on multiple synchronized PLZ-
5WH2 series products.

1 Press Sequence, Transient, and then Initiate on all the PLZ-5WH2 series products
to be synchronized.

The sequence is executed.

1000V

_0.527’“ |Abc>rt
0w Fuspend
0-02 0:00:00

Level SR[A/us] Dwell[s] Load Wait{

1
2 2.000 0.0040 E]
1.Program 2.Steps

2 Wait for the sequence on all synchronized PLZ-5WH2 series products to be paused.

The sequence pauses (waits for trigger) before executing a step with Wait (pre) set to MSync, and
“MSync” appears in the sub-function area.

1000V

Level SR[A/us] Dwell[s] Load Wait{ MSync

1
2 2.000 0.0040

Import
Export

1.Program 2.5teps ENIcuSENG  More

3 Press MSync on any of the synchronized PLZ-5WH2s.
The sequence resumes simultaneously on all synchronized PLZ-5WH2 series products.

Aborting synchronized operation

The synchronized operation setting is cleared when you remove the LAN cables.

PLZ-5WH?2 User’s Manual
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Advanced Functions

Remote Control

In addition to using the front panel, you can also control the product remotely by sending commands from
a PC.

For details on remote control, see the Communication Interface Manual on the included CD-ROM.

Releasing remote control

You can return the product’s control from remote control (the product’s panel control not accepted) to local
control (panel control accepted). While remote control is in progress, the remote icon appears on the dis-

play.

1000V Remote M LAN
Remote icon

A oppL|

0.0040 . UVPL|

Press LOCAL.
This switches the operation from remote operation to local operation.
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Sequence Function

Overview of the Sequence Function

Sequence is a function that executes a sequence of operations set in advance.
Programs and steps

A sequence consists of programs and steps. A program is a collection of steps. Steps are executed in
order one at a time, starting from step 1. The completion of the last step signifies that the program has
been executed once. When the specified number of program loops is completed, the sequence ends.

L

Input current
Load value

b Time
}  Pogamt [ Pogaml |
! Step1 | Step2 | Step 3 | Step4 { Step1 | Step2 | Step 3 | Step4 i
| ] ]
I I
Loop 1 Loop 2

Set a program for each operation mode. Up to 30 programs can be set.
Up to 10000 steps total can be used in all programs

(NOTE) Do not create more than 10000 steps. If the total number steps exceeds 10000, unex-
‘ ’ pected behavior may result.

Main functions

Setting range Setting Description
By step Load value Current, conductance, voltage, power.
The values that can be set depend on the current operation mode.
Slew rate Sets the speed of change when the current is changed.
Step execution time  0.000050 s to 3600000 s (50 us to 1000 h), resolution: 1 ps
Load on/off To turn the load on, set the load setting transition method to step or
control ramp.
Other Trigger signal setting, trigger signal output
For each program Number of loops of 1 to 100000 repetitions, or infinite repetitions.
program

Protection function Specifies the value at which a protection function (OCP, OPP, UVP)
is activated.
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Sequence Function

Program Configuration

You can set programs in CC, CR, CV, and CP modes (ARB mode is excluded). Different programs are cre-
ated for each operation mode.

How to view the program editing screen

Press SEQUENCE and then Program to display the sequence editing screen.
The program created in the present operation mode is displayed. When you change the operation mode

(p-31), programs that were created in each operation mode are displayed.

Program Name

Program2

Program3
Program4
Program5

Example: Programs 1 to 5 have been registered

Creating a program

First, create an empty program without registering any steps.

Because the location where the program is created depends on the present operation mode, even if a pro-
gram of the same name is created for example in CC mode and CP mode, the resulting programs will be
treated as different programs.

The created program is automatically saved and is not deleted even if the POWER switch is turned off.

1 Set operation mode (p.31).

2 Press SEQUENCE > Program.
The program editing screen appears.

3 Press Create.

If another program has a check mark (is selected), you cannot create a program. If a check box is
selected, use the rotary knob to select the corresponding program, and then press Select to clear
the check box.

Program Name

Create

Delete...

Import
Export

3 Transient More
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Sequence Function | Program Configuration

4 Use the numeric keypad or the rotary knob to enter the program name, and then

press ENTER.

You can enter up to 255 characters for the program name. For information about registering steps
to a program, see “Setting Steps” (p.95).

An empty program is created.

Setting the number of loops

PLZ-5WH2

Set the number of loops of a program.

1 Press SEQUENCE > Program.

2 Use the rotary knob to select a program, and then press Select.
A check mark appears to the left of the selected program name.

Program Name Select
Program1
v

Program3

3 Press Steps > Property > Loop.

JProgramz2

4400 w
OFF v

Others

1.Program [EPESCLSM 3 Transient  More IEr:pg:_'Lt

4 Use the numeric keypad or the rotary knob to enter number of loops.
This completes the setting.

User’s Manual
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Sequence Function | Program Configuration

Setting protection functions

For each program, you can set overcurrent protection (OCP), overpower protection (OPP), and undervolt-
age protection (UVP) in a program. You cannot set different protection functions for each step. The protec-
tion functions that you can set varies depending on the operation mode.

1 Press SEQUENCE > Program.

2 Use the rotary knob to select a program, and then press Select.
A check mark appears to the left of the selected program name.

Program Name

Program1
v
Program3

3 Press Steps > Property > OPP, OCP, or UVP.
The key names that appear vary depending on the operation mode.
You can select the operation (trip or limit) when an alarm occurs using the Action key.

JProgramz2

1 5e-05

Action

Limit
Import
Export

1.Program [EPESCOC 3. Transient  More

4 Use the numeric keypad or the rotary knob to enter the value.
This completes the setting.
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Sequence Function | Program Configuration

Setting the load state at the end of the sequence

PLZ-5WH2

You can set the load state (load on or off, load value, slew rate) at the end of the sequence of a program.
If this function is disabled, at the end of the sequence, the load is set to the value of the last step.

3
2

=

Press SEQUENCE > Program.

Use the rotary knob to select a program, and then press Select.
A check mark appears to the left of the selected program name.

Program Name

Select

v
Program3

Press Steps > Property > Others.

Press Enable to switch between Enabled and Disabled.
The value switches between Enabled and Disabled each time that you press the key.

/Program2

Load OFF
Dwell[s]
15e-05

Slew
Rate

Import
Export

1.Program [EPESCLSM 3 Transient  More

If you select Enabled, set the load state at the end of the sequence.

Purpose Operation

Set load on or off. Press Load to switch between Load ON and Load OFF. The value
switches each time you press the key.

Set the load value. Press level, and use the numeric keypad or the rotary knob to enter the
load value.

Set the slew rate. Press Slew Rate, and use the numeric keypad or the rotary knob to enter

the slew rate.

This completes the setting.
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Sequence Function | Program Configuration

Changing a program name

Press SEQUENCE > Program.

=N

2 Use the rotary knob to select a program, and then press Select.
A check mark appears to the left of the selected program name.

Select

Program Name
Program1

v
Program3

Press Rename.

Use the numeric keypad or the rotary knob to enter the program name, and then
press ENTER.

The program name is changed.

=

Deleting a program

Press SEQUENCE > Program.

b

2 Use the rotary knob to select a program, and then press Delete.

If the check box of any program is selected, you cannot delete programs. If a check box is
selected, use the rotary knob to select the corresponding program, and then press Select to clear
the check box.

Program Name
Program1

Program3

Create

Delete...

Import

2.Steps 3Transient More Expot.

3 Use the rotary knob to select OK, and then press ENTER.
The program is deleted.
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Sequence Function

Setting Steps

Creating steps

Press SEQUENCE > Program.

N

2 Use the rotary knob to select a program, and then press Select.
A check mark appears to the left of the selected program name.

3 Press Steps.

The step editing screen appears.
If a new step editing screen is opened, the first step with the initial value is registered.

{Programl

Property

.— Enables the editing of the settings of the selected step.
Or confirms the settings.

Edit

y— Adds a copy of the selected step below that step.

Deletes the selected step.

Saves the edited step.

1.Program (RS 3 Transient  More

Import
Export

4 Use the rotary knob and the < /— keys to select a step and item, and then press
Edit.

Set each parameter.
Parameter (p.96): Level, SR, Dwell, Load, Wait (pre), Wait (post), Generate, -
To confirm an item, press Edit again.

Repeat Step 4 and Step 5 until all the steps have been registered.

~ O

Press Save.
The steps are registered to the program.
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Step settings

m Level
Use the numeric keypad or the rotary knob to set the load value of each operation mode.
The value that you can set (unit: A, S, V, W) varies depending on the present operation mode.

1 This does not appear if the CC, CR, or CP external control is enabled in CC mode, CR mode, or CP mode
or if the CV external control is enabled in CV mode.

® SR

Use the numeric keypad or the rotary knob to set the slew rate.

B Dwell

Use the numeric keypad or the rotary knob to set the step execution time.
The values that you can set range from 0.000050 s to 3600000 s.

B Load

Set the load state and the transition of the load value.

The load turns on and load off each time you press the Load sub-function key. If set to load on, press
Immediate or Ramp to select the transition method.

Value Description
Immediate (@ J) The load value transitions in steps from the value of the previous step.

Ramp (@.F) The load value transitions with a slope from the value of the previous step. If the first step
(step 1) is set to ramp, the start point of the load value is always 0 A, 0 S, 0V, 0 W.

Example: Level: 10A, Dwell: 100 ms

Immediate Ramp
10A 10A ===
100 ms 100 ms
B Wait (pre)

Set the pre-trigger source. If you set the pre-trigger source, the program pauses before executing a step.
The pause is released when the specified trigger source condition is met.

Press MSync, Digital2, and BUS to turn each trigger source on or off. The value switches between on and
off each time you press the key.

Trigger source Description

MSync Synchronizes the releasing of the paused state on synchronized PLZ-5WH2 series products
(p.87).

Digital2’ Releases the pause state when a signal is received at pin 13 of the EXT CONT connector.

BUS?2 Releases the pause state when a *TRG command is received from a PC or the like.

1. Only when Direction of Digital 2 is set to Input (p. 131).
2. If setto BUS, other trigger sources cannot be set.
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Sequence Function | Setting Steps

B Wait (post)

Set the post-trigger source. If you set the post-trigger source, the program pauses after executing a step.
The pause is released when the specified trigger source condition is met.

Press Trig IN and Cutoff to turn each trigger source on or off. The value switches between on and off each
time you press the key.

Trigger source Description
Trig IN Releases the pause state when a trigger is received (p. 118).

Cutoff Releases the pause state when a cutoff is activated (p. 70).

B Generate

Set the trigger signal output at the start of a step.
Press TALink and Trig Out to turn each trigger output on or off. The value switches between on and off
each time you press the key.

Value Description

TALink A trigger is output at the start of a step. In the trigger setting (p. 56) of the measurement
function, setting Source to TALink causes measurements to be recorded at the start of a
step.

Trig Out A 10 ps trigger signal is output from the TRIG OUT connector.

When Generate is set to Trig Out in step 2.

Load value
Set I [ Set: Load setting based on step setting ]
0 Time
Step 1 Step 2 Step 3
TRIG OUT I]
10us
-

Set whether to set the EXT CONT connector pins (DIGITAL 0, 1, 2) to high level during a step.

Press Digital0, Digital1, and Digital2 to turn each item on or off. The value switches between on and off
each time you press the key.

Value Description
Digital0 Pin 11 (DIGITAL 0) of the EXT CONT connector is set to high level.
Digital1 Pin 12 (DIGITAL 1) of the EXT CONT connector is set to high level.

Digital2’ Pin 13 (DIGITAL 2) of the EXT CONT connector is set to high level.

1. Only when Direction of Digital 2 is set to Output (p. 731).

Example: When — is set to DigitalO in step 2

Load value
Set ———— I [ Set: Load setting based on step setting ]
0 Time
Step 1 Step 2 Step 3

DIGITALO _,_|_
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Deleting steps

Press SEQUENCE > Steps.

N

2 Use the rotary knob to select a step, and then press Delete.
The selected step is deleted.

3 Press Save.
The program is updated.
This completes the setting.
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Sequence Function

Sequence Creation Tutorial

In this example, we will actually create a sequence from the front panel.
We will enter the following program in CC mode for the PLZ12005WH2.

Program name: Program1,

number of loops: 2

Run Current Execution time Load Transition Trigger output
Step 1 8A 10 seconds On Ramp None

Step 2 6 A 12 seconds On Immediate None

Step 3 0A 7 seconds Off - None

Step 4 3A 15 seconds On Immediate Trig Out

Program1 executes steps 1 to 4 and ends the first execution. When Program1 is executed one more time,

this sequence is over.

Representing this sequence in graph form looks as follows.

Input current

8A -
Current setting
6A / /
3A /
0A ! - Time
Program1 . __Pogamt
Step 1 Step2 | Step 3 Step 4 Step 1 Step 2 Step 3 Step 4
8A 6A 0A 3A 8A 6A 0A 3A
10s 12s 7s 15s 10s 12's 7s 15s
Load On | Load On Load Load On Load On | Load On Load Load On
Ramp Immediate | Off Immediate Ramp' Immediate | Off Immediate
TRIG OUT None None None Trig Out None None None Trig Out
1 If Load of step 1 is set to Ramp and the program is repeated, the start current of step 1 will always be 0 A.

Creating Program1 as a new program

Program Name Selact

1
2
3

Delete...

2.5teps 3.Transient More

Import
Export

PLZ-5WH2

Set the operation mode to CC mode (p.32).
Press SEQUENCE > Program > Create.
Use the numeric keypad or the rotary knob to enter the pro-

gram name “Program1”, and then press ENTER.
Program1 is created.

User’s Manual
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Sequence Function | Sequence Creation Tutorial

Registering steps to Program1

When registering steps to a program, we recommend that you save the program after setting all the steps.
There is no need to save a program after setting each step.

Creating step 1

/Program1

Level SRIAfss]  Dwellls] Lo
1 8.000 0.0040 .

/Program1

SR[Afus] Dwellls]
1 0.0040 10

1.Program [PRSELCM 3.Transient  More

User’s Manual

Property

Edit

Insert

Delete

Save

Property

Edit

Insert

Delete

Save

Import
Export

Use the rotary knob to select Program1, and then press
Select.

A check mark appears to the left of Program1.

Press Steps > Edit.
The Level (current) cell of step 1 becomes editable.

Use the numeric keypad or the rotary knob to enter the cur-
rent value “8”, and then press Edit.

This sets the value to 8 A.

Use the — key to select a cell in the Dwell column, and then
press Edit.

Dwell (execution time) becomes editable.

Use the numeric keypad or the rotary knob to enter execu-
tion time “10”, and then press Edit.

This sets the value to 10 s.

Use the — key to select a cell in the Load column, and then
press Edit.

Load (load and transition) becomes editable.

Press Ramp and then Edit.

@.f (load on, ramp transition) is set.
Proceed to create step 2.
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Sequence Function | Sequence Creation Tutorial

Creating step 2

1 Press Insert.
Step 2 is inserted.

2 Use the — key to select a cell in the Level column of Step 2
(row 2), and then press Edit.

Set step 2 as follows: Level: 6, Dwell: 12, Load: On (Immedi-
ate).

The current is set to 6 A, the execution time to 12 s, and the load to on.
Immediate transition is selected.

Delete Proceed to create step 3.

Property

Dwell(s] Lo

Edit

Insert

R 3 Tranulent  More

Property

Edit

Insert

Delete

sient  More

Creating step 3

1 Press Insert.
Step 3 is inserted.

2 Use the — key to select a cell in the Dwell column of Step 3
(row 3), and then press Edit.

— ” Set step 3 as follows: Dwell: 7, Load: Off (blank).

Dwellal cos Wt The execution time is set to 7 s and the load to off.
1 : Because the load is off in this step, there is no need to set the current.

Proceed to create step 4.

1 Program [EERSICURN 3 Tranulent  Mare
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Sequence Function | Sequence Creation Tutorial

Creating step 4

fPrograml

Dwell(s] Lo

3 Tranalent  Mare

2 00040
0

4 0.0040 15

3 Tranalent  Mare

Property

Edit

Insert

Delete

Press Insert.
Step 4 is inserted.

Use the — key to select a cell in the Level column of Step 4
(row 4), and then press Edit.

Set step 4 as follows: Level: 3, Dwell: 15, Load: On (Immedi-
ate).
The current is set to 3 A, the execution time to 15 s, and the load to on.

Immediate transition is selected.
Proceed to setting the number of loops.

Setting the number of loops

fPrograml

2 00040

2 00040

4 0.0040 15

1 Program [EERSICURN 3 Tranuient  More

User’s Manual

Press Property and then Loop.

Use the numeric keypad or the rotary knob to enter number
of loops “2.”

Press Property.

The number of loops is set to 2.
Proceed to saving Program1.

Press Save.

Program1 is saved.
This completes the setting.
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Sequence Function

Executing, Pausing, and Stopping Sequences

When you finish setting the program and steps, you can run the sequence. You can pause or stop the
sequence while it is running. By setting triggers (p. 104), you can control the timing at which sequences are
to be started.

Executing a sequence

(NOTE) » During sequence execution, the pulse function and sine function are forcibly turned off.

» When the cutoff (p. 70) activation condition is met while a sequence is running, a cutoff
is activated and the load turns off, but the sequence continues running. To turn the
load on again, reset the integrated data (p. 67), change the cutoff activation condition,
or disable the cutoff that caused the activation.

The sequence can be executed regardless of whether the load is on or off.
Set the operation mode (p. 317) according to the sequence to be executed.

Press SEQUENCE > Program.

A check mark appears to the left of the program name.

3 Use the rotary knob to select a program, and then press Select.
4 Press Transient > Initiate.

The sequence is executed, and the measurements and - appear on the display.

-0.501,

0w Fuspend
003 0:00:01

Number of running loops/total number of loops.

Level SR[A/us] Dwell[s] Load Warl
YT i o i o | Ne running step is highlighted in blue.

1.Program 2.

Synchronizing the start timing of sequences

The start timing of sequences can be synchronized on synchronized PLZ-5WH2 series products. For
details, see “Synchronizing the start of sequences” (p. 86).
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Sequence Function | Executing, Pausing, and Stopping Sequences

Aborting a sequence

Pressing Abort during sequence execution stops the sequence execution in progress (if the load is on, it
remains on).

Pausing a sequence

Press Suspend while a sequence is running.
The sequence is paused (figure below). Press Resume to resume the sequence.

Controlling the start of sequences with triggers

By setting triggers, you can control the timing at which sequences are to be started.
The triggers that you can set are as follows:

Item Value Description
Trigger - Sets the trigger.
Source - Event (trigger source) that will be used as a condition for starting sequences.
Sequence starts after the Initiate key is pressed and a trigger is received.
Immediate Prggsing Initia.te withgut Initiate key press End of sequence
(factory default waiting for a trigger signal .
setting) applies a trigger immedi- AR Sequence
ately.
Delay
BUS Applies a trigger when a

*TRG command is received

from a PC or the like. Initiate key press

i . i Trigger application End of sequence
DIGITAL2' Applies a trigger when a sig- l .
nal is received at pin 13 of amm Sequence
the EXT CONT connector.
MSync The trigger application tim- Delay
ing is synced between PLZ-
5WH2 series products that
are synchronized (p. 86).
Delay 0sto100s Set the delay time from trigger application until the start of sequence.

The factory default setting is 0 s.

1. Only when Direction of Digital 2 is set to Input (p. 131).
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Sequence Function | Executing, Pausing, and Stopping Sequences

B Trigger processing procedure

1

2 Use the rotary knob to select the trigger (p. 104) you want to set, and then press

The following figure shows the trigger processing procedure.

Other

Source

Trigger application

Immediate

d
l

Delay

| Sequence start |

Press SEQUENCE > More.

Edit.

1000V,

-0.512.
0.03,

Value

0: Immediate
Delavisl 0

Use the rotary knob or numeric keys to enter a value, and then press ENTER.

Repeat steps Step 2 and Step 3 to set triggers.
This completes the setting.
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Sequence Function

Exporting and Importing Programs

Programs saved in the internal memory can be exported to a USB memory device. Programs exported to
a USB memory device can also be imported into the internal memory.

1 Insert a USB memory device into the USB port on the front panel.

Press SEQUENCE > Import/Export.

An Import/Export screen appears.
B Basic operations on the Import/Export screen
Selected program (blue)

being copied Internal Memory Copy Copies the selected program
Program Name
Data in the internal —

Pastes the copied program
memory
Overwrites the selected program

USB Memory with the copied program
Name

Data in the USB —

memory device stem Volume Infojimation Switches the selection between

[=] Internal .
Import USB memory device and

More it

internal memory
Use a rotary knob to select an Selected item (blue)

item, and then

press P to open the lower level.

press « to close the lower level.

Exporting programs to a USB memory device

1 On the Import/Export screen, press USB< Internal, and select “Internal Memory,”
which is at the top of the display area.

Each time you press USB<>Internal, the selection toggles between USB Memory and Internal Mem-
ory.

2 Use the rotary knob to select the program to export, and then press Copy.

Exporting is not possible for programs with a check mark to the left of the program name. Display-
ing the program editing screen (p. 90) and selecting a program with a check mark using the rotary
knob clears the check box.

3 Press USB<<Internal.
dUu“B emorMiwhxhsa heboton d he sypdVaeae s ¥pe ead

4 Use the rotary knob to select the export location, and press Paste.
To overwrite the selected file, press Overwrite.

A mranea granram rane ndran S saea a e gecs ea paatond

106 User’s Manual PLZ-5WH2



Sequence Function | Exporting and Importing Programs

Importing programs from a USB memory device

PLZ-5WH2

W N

On the Import/Export screen (p. 106), press USB<Internal, and select “USB Mem-
ory,” which is at the bottom of the display area.

Each time you press USB<> Internal, the selection toggles between USB Memory and Internal
Memory.

Use the rotary knob to select the program to import, and then press Copy.

Press USB<~Internal.
“Internal Memory,” which is at the top of the display area, is selected.

Use the rotary knob to select the import location, and press Paste.
To overwrite the selected memory area, press Overwrite.
The program is saved to the internal memory.
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External Control

Preparation for External Control

The product can be controlled and monitored from an external device.

The external control terminals are isolated from the DC INPUT terminals. Moreover, the BNC connectors
(V MON OUT, | MON OUT, TRIG OUT) are isolated from the chassis.

Control Functions that can be controlled/monitored Connector

Analog control Controlling the load values of CC, CP, CR, and CV modes using voltage. EXT CONT

Controlling the current to be superimposed on the load values of CC
mode using voltage.

Digital control Load on/off control EXT CONT
Sequence and measurement triggers
Releasing a paused sequence
Activation of an alarm
Clearing an alarm state

Signal output Monitoring of the load on/off state EXT CONT
Monitoring of the alarm state
Monitoring of the sequence step period

Monitoring of the current (| MON OUT) BNC/EXT CONT
Monitoring of the voltage (V MON OUT) BNC
Pulse and sequence trigger output (TRIG OUT) BNC

Precautions for use at high response speeds

When the product is used at a high response speed, do not connect the common terminal of the external
device to the terminal of the DUT (the terminal that is connected to the negative (-) DC INPUT terminal of

the product). Attach a commercially available ferrite core to the wiring between the product and the exter-
nal device.

PLZ-5WH2

External control terminal

Attach a ferrite core

DC INPUT
terminal ~~ l
External
device
- ACOM K
/
™ e @ _____________ /' Common terminal
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External Control | Preparation for External Control

EXT CONT connector pin arrangement

pin number

EXT CONT connector (ooooooooooo)
2

POOOOOOOOOOH

5 14

|ﬂe.| S =
® S S
O e P o OO0 <e===p - S S ‘
Pinno. |p/0ut! Signal name Description

1 - STATUS COM Status signal common for pins 14 to 16.

2 NC - -

3 NC - -

4 NC - -

5 IN ALARM CLEAR Alarm clearing input (p. 117).

6 IN ALARM INPUT Alarm input (p. 117).

7 NC - -

8 NC - -

9 IN TRIG INPUT Trigger input. Resumes program execution if Wait(post) was set to Trig
IN in a sequence step and the program was paused (p. 118).

10 - A COM This is connected to the chassis.

11 ouT DIGITAL 0 DIGITALO output (p. 719). Sequence control possible.

12 ouT DIGITAL 1 DIGITAL1 output (p. 119).Sequence control possible.

13 IN/OUT DIGITAL 2 DIGITAL2 I/O (p. 119).Input/output switchable (p. 131).

Sequence signal output or the trigger input of sequences and measure-
ment function.

14 ouT ALARM1 ALARM1 output (p. 777).ON when overvoltage detection, reverse-con-
nection detection, overheat detection, alarm input detection, or parallel
operation anomaly detection is activated, and also during external
alarm input.

15 ouT ALARM2 ALARM2 output (p. 777). ON during OCP, OPP, UVP, or WDP opera-
tion.

16 ouT LOAD ON STATUS  Load-on status output (p. 7716).ON during load on.

17 NC - -

18 IN LOAD ON/OFF Load on/off control input (p. 115).Logic level switchable.

CONT

19 - A COM This is connected to the chassis.

20 IN EXT CONT ADD External voltage control input (p. 774).Controls the load setting of CC
mode by adding current.

21 IN EXT CONT MODE  External voltage control input (p. 772).Controls the load values of CC,
CR, and CP modes.

22 IN EXT CONT CV External voltage control input (p. 713).Controls the voltage of CV mode.

23 - A COM This is connected to the chassis.

24 OouT IMON Current monitor output(p. 120).

25 NC - -

1.

PLZ-5WH2

1000 V reinforced insulation between each terminal and the DC INPUT terminal
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Connecting to the EXT CONT connector

External control connector kit

To connect the signal cable to the EXT CONT connector, use the external control connector kit that comes
with the product. For information about how to use this kit, see the TE Connectivity (formerly AMP) cata-

log. For information about how to obtain these tools or replacement parts, contact your Kikusui agent or
distributor.

Connector model (on the product) 5747461-3 [made by TE Connectivity]

Plug model 745211-7 [made by TE Connectivity]

Wire diameter AWG26 to AWG22

Manual pressure welding tool Handle assembly 58074-1 [made by TE Connectivity]
Head assembly 58063-2 [made by TE Connectivity]

Insertion/extraction tool 91232-1 [made by TE Connectivity] or equivalent

Storing the protection plate

By factory default, the protection plate is mounted on the EXT CONT connector. When using the EXT
CONT connector, keep the removed protection plate in a safe place. If you are not using the EXT CONT
connector, attach the protection plate for your safety and to prevent external disturbances. If it is damaged
or lost, contact your Kikusui agent or distributor.

Connecting the signal cable

(NOTE) » To prevent noise interference, use twisted wires for the signal cables.
» Use a highly stable power supply that has low noise for the external controller.

1 Turn the POWER switch off.

2 Remove the protection plate of the EXT CONT connector.

#4-40%5/32
«=/

PLZ12005WH2 example
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External Control | Preparation for External Control

3 Connect the signal cable to the EXT CONT connector.

Signal cable

PLZ12005WH2 example

4 Connect the signal cable to the external controller.
This completes the external control connection procedure.
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External Control

Load Setting Control

Constant current (CC), constant resistance (CR), and con-
stant power (CP) control

You can control the load values (current, conductance, power) of CC, CR, and CP modes using external
voltage. When you apply an external voltage between 0 V to 10 V to the EXT CONT connector, a load set-
ting proportional to the change can be obtained.

An external voltage of 0 V results in a load setting that is 0 % of the rating, and an external voltage of 10 V
in a load setting that is 100 % of the rating. The accuracy cannot be guaranteed when the external voltage
is less than 0 V or more than 10 V.

100 % Set: Load value

Ein: External voltage
Set

0%

oV

Ein

AC AUTION To avoid damaging the product, observe the following precautions. The maximum volt-
age that can be applied across pins 21 and 23 of the EXT CONT connector is +11 V. Do
not apply a voltage that exceeds this.

Turn the POWER switch off.

= N

2 Connect an external voltage across pins 21 and 23 of the EXT CONT connector.

PLZ-5WH2 External voltage
4 Twist .
EXT CONT MODE 2|15XT CONT y L
10kQ= +
Acom |22
v — -

Turn the POWER switch on and check that the load is off.
Set the operation mode to CC, CR, or CP.
Press SOURCE > More.

Use the rotary knob to select CC, CR, or CP under External Control, and then press
the Edit key.

Use the rotary knob to select Enable, and then press ENTER.

External control of each mode becomes possible. If Disable is selected, external control is dis-
abled.

This completes the setting.

~N OO RA W

User’s Manual PLZ-5WH?2



External Control | Load Setting Control

Constant voltage (CV) control

You can control the voltage in CV mode with an external voltage. When you apply an external voltage of
0V to 10 V to the EXT CONT connector, the voltage varies proportionally to that external voltage.

An external voltage of 0 V results in voltage of 0 V. An external voltage of 10 V results in voltage at 100 %
of the rating. The accuracy cannot be guaranteed when the external voltage is less than 0 V or more than

10 V.
Y1 Vo: Input voltage  / ~ VMXEin
Vm: Rated voltage 10
Vo Ein: External voltage o < Ein < 10V
ov i
ov 10V

Ein

AC AUTION To avoid damaging the product, observe the following precautions. Do not apply a volt-
age outside +11 V across pins 22 and 23 of the EXT CONT connector.

Turn the POWER switch off.

=N

2 Connect an external voltage across pins 22 and 23 of the EXT CONT connector.

PLZ-5WH2 Twist External voltage
WIS +
EXT CONT CV 22EXT CONT ; L
10kQ= o
ACOM 23
v L -

Turn the POWER switch on and check that the load is off.
Set the operation mode to CV.
Press SOURCE > More.

Use the rotary knob to select CV under External Control, and then press the Edit
key.

Use the rotary knob to select Enable, and then press ENTER.

External voltage control of CV mode is now possible. If Disable is selected, external control is dis-
abled.

This completes the setting.

~N OO0ThALE W

(NOTE) If CV is selected under External Control, the UVP action is set to UVP Limit (p. 52).You
\ ’ cannot select the UVP Trip action.
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Controlling the current to be superimposed on the constant current (CC)

You can control the current to be superimposed to the current value of CC mode with an external voltage.

When you apply an external voltage between 0 V to 10 V to the EXT CONT connector, the load current
becomes the sum of the current proportional to the external voltage change and the Present current set-
ting.

When you apply an external voltage between -10 V to 0 V to the EXT CONT connector, the load current is
equal to the current that is proportional to the external voltage change subtracted from the present current
setting.

If the current setting is Is (figure below), the current that is added to the current setting for an external volt-
age of 0 V is 0 A. The current that is added to the current setting for an external voltage of 10 V is 100 %
of the rating. However, the final load current range is 0 A to 100 % of the rating.

lo: Load current Im x Ein
oy " lox ————+1s

Im: Rated current 10

Is:  Current setting 10V <Ein<10V
Ein: External voltage 0A<lo<Im

h When the current
setting is 0 A
‘ 1 ~ Ein
-10V ov 10V

When the current
setting is Is

ACAUTlON To avoid damaging the product, observe the following precautions. Do not apply a volt-
age outside £11 V across pins 19 and 20 of the EXT CONT connector.

Turn the POWER switch off.

Connect an external voltage across pins 19 and 20 of the EXT CONT connector.

N =b

PLZ-5WH2 . External voltage
4 EXT CONT Twist 7y -
EXT CONTADD [ ) - ¥ L
10kQ=
19 T
ACOM
v — - "

Turn the POWER switch on and check that the load is off.

Set the operation mode to CC.

Press SOURCE > More.

Use the rotary knob to select CC Add under External Control, and then press the
Edit key.

~N OOhA W

Use the rotary knob to select Enable, and then press ENTER.

External control of superimposing in CC mode is now possible. If Disable is selected, external con-
trol is disabled.

This completes the setting.
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External Control

Controlling Load On/Off

You can control load on/off with an external signal. You can also monitor the load on/off state.

Priority relationship between the operation of the external contact and the
operation of the LOAD key on the front panel

Relationship between external contact and LOAD key (when Input Logic is Positive)

1
S8 HIGH=On :
S @ 1 [ 1
g E - 1 1 1 1
i 8 LOW=0ff : : : :
1 1 1 1
1 1 1 1
1 1 1 1
e On 1 L
®© 1
3 off ' U_'
1 1 1 1
1 1 1 1
A AA A
A: Timing t
!g}gg o press When the external When the external For the external contact to
contact is OFF, the contact is ON, the turn the load on again, the
LOAD key is disabled. LOAD key is enabled. load must first be turned off

once.

The OUTP command during remote control is equivalent to the LOAD key.

Load on/off control input

Turn the POWER switch off.

b

2 Connect an external contact across pins 18 and 19 of the EXT CONT connector.

y

10kQ EXT CONT
<} LOAD ON/OFF CONT 18 8
g sw
[ Acom 19
\Y

—| HIGH: 3.5V to 5V
LOW: 0V to 1.5V

Press SOURCE > More.

Use the rotary knob to select Input Logic under External Control, and then press
Edit.

= D

Use the rotary knob to select an item, and then press ENTER.

Item Description
Positive Opening and closing the external contact turns the load on and off, respectively.
Negative Opening and closing the external contact turns the load off and on, respectively.

External control of load on/load off is now possible.
This completes the setting.
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External Control | Controlling Load On/Off

Load on/off control state display

You can view the external contact state and the external contact input logic setting for the load on/off con-
trol with the icons in the top area of the display.

For example, if the external contact state is low and the external contact input logic setting is positive, you
cannot turn the load on by pressing LOAD.

Icon External contact state External contact input logic setting LOAD key
(Input Logic)

Not shown High Positive Enabled

. Low Positive Disabled

. High Negative Disabled

= Low Negative Enabled

Load-on status signal output

To externally monitor the load on/load off state, use pin 16 of the EXT CONT connector. Use pin 1 as the

common.
Maximum application voltage 30V
Maximum current 4mA “ EXT CONT Load on Load off

|16 Photocoupler ON OFF
cToRD)

Photocoupler (P.C.)
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Controlling Alarms

External Control

You can use external control signals to activate and clear alarms. You can also monitor alarm occurrences.

Alarm input

+5
10kQ

Vv
_‘ EXT CONT

<6
<10

A COM

_i HIGH: 3.5V to 5V
LOW: 0V to 1.5V

Alarm clearing input

+5V
10kQ EXT CONT

~ 5

acom| 10
_iHIGH:S.SVto 5V

LOW: 0Vto 1.5V

Alarm status output

Photocoupler (P.C.) Ai

EXT CONT

<< 14,15
< 1

Maximum application voltage 30 V

Maximum cur

PLZ-5WH2

rent 4 mA

Use pin 6 of the EXT CONT connector. Use pin 10 as the common. An
alarm is activated and the load is turned off when the input to pin 6 is a

low level signal.

Use pin 5 of the EXT CONT connector. Use pin 10 as the common.
After an alarm occurs, eliminate the root cause of the alarm, and
change the input to pin 5 of the EXT CONT connector from a low level
signal to a high level signal. The alarm will be cleared on the rising

edge of this signal.

Use pin 14 (ALARM1) and pin 15 (ALARM2) of the EXT CONT connec-

tor. Use pin 1 as the common.

Pin 14 turns on when alarm 1 (p.48) is activated.
Pin 15 turns on when alarm 2 (p.49) is activated.
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External Control

Trigger Input/Output

The rear panel has a trigger input terminal (EXT CONT pin 9) and the front panel a trigger output terminal
(TRIG OUT).

Trigger input

When Wait(post) is set to Trig IN in a sequence step setting (p. 95), the sequence is paused at the end of
the step.In this case, when the signal input to TRIG INPUT (pin 9) of the EXT CONT connector changes
from high to low level, the pause is released at the falling edge of that signal.

+5V Sequence
10kQ EXT CONT Step n Step n+1
TRIGINPUT |~ ° Run

<10 TRIG INPUT

REACOM _|HIGH: 2.31Vto 3.3V v

LOW: 0V to 0.66V

v

Trigger output

The trigger signal is output under the following conditions.

Conditions Pulse width

During pulse operation (p.42) and during sine operation (p.45) 10 ps

When a step for which Trig Output has been set is executed during
sequence operation (p.97).

The trigger signal is output from the TRIG OUT connector (BNC connector) on the front panel.For the trig-
ger signal output, the high voltage level is 4.2 V to 5 V, the low voltage level is 0 V to 0.4 V, and the output
impedance is approximately 200 Q. The isolation voltage between the BNC connectors and chassis is
+30 V. The rated voltage between BNC connectors and DC INPUT terminals is £1000 V. The TRIG OUT
connector is isolated from the chassis and DC INPUT terminal (A COM).

Front panel
2000 TRIG OUT

HIGH:42Vto 5V
LOW: 0Vto 0.4V

130V or less - |
7 10 us
(NOTE) * When the product is shipped from the factory, a plastic cover is attached to the TRIG

OUT BNC connector. Keep the connector cover that you remove in a safe place. If you
are not using the BNC connector, attach the connector cover for your safety and to pre-
vent external disturbances.

* Use an insulated cable to connect to the BNC connector.
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External Control

Digital 1/O

The rear-panel EXT CONT connectors include digital outputs DIGITALO (pin 11), DIGITAL1 (pin 12), and
DIGITAL2 (pin 13) and digital input DIGITAL2 (pin 13). The input and output of DIGITAL2 can be switched

(p- 131). Digital output is set to high level during a sequence step period. Digital input is used as a trigger
input for sequence and measurement functions.

m DIGITALO, DIGITAL1, DIGITALZ2 (output) m DIGITAL2 (input)
EXT CONT

—| EXT CONT —|

330Q 330Q
M<11 (DIGO), 12 (DIG1), 13 (DIG2) <13

DIGITAL2
A COM <10 A COM <10
%E HIGH:2.5V t0 3.3V 5 HIGH:2.31V t0 3.3V
LOW: 0Vto 0.4V LOW: 0V to 0.66V
(NOTE ) The DIGITAL2 I/O terminal is not pulled up or down. If you set DIGITAL2 to input, do not

leave the terminal open but rather set the terminal voltage to high or low within the input
voltage range shown in the figure above.
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External Control

Current/Voltage Monitor Signal Output

You can monitor the voltage and current by using the monitor signal outputs on the front panel. The current
monitor signal is output from | MON OUT and across pins 23 and 24 (pin 23 is common) of the EXT CONT
connector. The voltage monitor signal is output from V MON OUT (p. 11).

| MON OUT V MON OUT
A0V fommmm oo
5 3 10V .
g : g |
3 1 3 :
5 | 5 :
= : = i
0 Current (A) Rating O Voltage (V) Rating
H | MON OUT and V MON OUT (BNC connectors)
Front panel
| MON OUT
and
7_;730 V or less V MON OUT
I MON OUT V MON OUT
Output voltage Outputs 0 V to 10 V for 0 % to 100 % Outputs 1/100 of the measured volt-
of rated current ageinthe 0V to 10 V range
Maximum output current 5 mA 5 mA
Accuracy +(1 % of rating) +(1 % of rating)
Output impedance 50 Q 50 Q
Isolation voltage +30 V +30 V
(NOTE) * When the product is shipped from the factory, plastic covers are attached to the | MON

OUT and V MON OUT BNC connectors. Keep the connector cover that you remove in
a safe place. If you are not using the BNC connector, attach the connector cover for

your safety and to prevent external disturbances.

» Use an insulated cable to connect to the BNC connector.

B Current monitor output (across pins 23 and 24 of the EXT CONT connector)

The current monitor output is 10 V at the rated current. The common is connected to A COM. The output

impedance is 1 kQ.
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Parallel Operation

Overview of Parallel Operation

The PLZ-5WH2 series or Kikusui Electronic Load PLZ-5WH series can be connected in parallel to

increase the total current and power capacities. The included or optional (p. 187) parallel operation signal

cable kit is required for parallel connection.

You can control up to four slave units from a master unit. Parallel operation is also possible among models
with different power capacities. The master unit and the slave units are automatically configured according
to the connection status. The master unit displays the total current and total power for all the electronic

loads that are connected in parallel.

When parallel operation is performed with PLZ-5WH, update the firmware of PLZ-5WH to the latest ver-
sion. Parallel operation is possible by mixing PLZ-5WH2s and PLZ-5WHs, but when a PLZ-5WH2 is made
the master unit, PLZ-5WHSs cannot be connected as slave units.

(NOTE)

» During parallel operation, the product may not meet the specifications that it has during

independent operation. The setting accuracy and measurement accuracy can be
improved by performing calibration in a parallel state. To have your product calibrated,
contact your Kikusui agent or distributor.

» The setting resolution during parallel operation varies depending on the number of units in

parallel operation.

PLZ-5WH2

B Connection example

IN

[Z]v K="

ouT

PLZ12005WH2

‘eac. [ 0oLz

==
£

°

g

PLZ4005WH2

| ouT

BE Tk,

el ©°§'j
.

PLZ20005WH2

B Maximum current and maximum power during parallel operation (when the models

are all the same)

Number of Maximum current / Maximum power

slaves PLZ1005WH2  PLZ2005WH2  PLZ4005WH2  PLZ12005WH2 PLZ20005WH2
1 40 A/2 kW 80 A/4 kW 160 A/8 kW 480 A/24 kW 800 A/40 kW
2 60 A/3 kW 120 A/6 kW 240 A/12 kW 720 A/36 kW 1200 A/60 kW
3 80 A/4 kW 160 A/8 kW 320 A/16 kW 960 A/48 kW 1600 A/80 kW
4 100 A/5 kW 200 A/10 kW 400 A/20 kW 1200 A/60 kW 2000 A/100 kW
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Parallel Operation | Overview of Parallel Operation

Making connections for parallel operation

Connect the electronic loads to be operated in parallel to the DUT, and connect each unit using parallel
operation signal cables.

AWARNWG * Using improper cables may cause fire. Use load cables with a core diameter that
is appropriate for the amount of current being used and with sturdy, flame-resis-
tant insulation.

* Risk of electric shock. When using the PLZ-5WH2 as the master unit, do not con-
nect Kikusui Electronic Load PLZ-5WH series as slave units.

AC AUTION To avoid damaging the product, observe the following precautions.

* When you are performing parallel operation, be sure to use the DC INPUT terminals
on the rear panel.

» Do not connect the PARALLEL connector’s IN and OUT terminals incorrectly.

* Do not leave one end of the parallel operation signal cable connected to the PARAL-
LEL connector when the other end is not connected.

(NOTE) Risk of operation errors.
» Be sure to ground the product using the included power cable.
+ Check that the power plug is connected to a properly grounded outlet.

= Continued on next page
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Parallel Operation | Overview of Parallel Operation

This section explains an example of performing parallel operation using two PLZ12005WH2s.

1 Turn the load off of all the electronic loads to be connected in parallel.

2 Connect the DC INPUT terminals of each unit to the DUT.

1° s, . ©O0 o|p ® pdcr. . ©0 olp
@ ® @ @
b b
® @ ® ® w’ -+ ®
® ® ® ®
® ® ® @®
v < < <
{e ‘i" o) {e ‘i} QB
[ ] ®
@ E]
S SO

Example: Connecting one slave unit
Securely connect the DC INPUT terminals of several models to each other in parallel. After making
the connections, attach the DC INPUT terminal covers(p.21).

+ Use load cables that are as short as possible and have sufficient thickness for the current to be
used.

* Route the load cables as far as possible from the signal cables.
» Use load cables that are all of the same length (equalize the voltage drop in the load cables).

3 Remove the SYNC/PARALLEL connector cover.

___M3x6
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Parallel Operation | Overview of Parallel Operation

4 Connect all the electronic loads to be operated in parallel with parallel operation
signal cables.

Connect the PARALLEL OUT connector and IN connector with a parallel operation signal cable.

Parallel operation signal cable
PARALLEL IN PARALLEL OUT

-

' pdcr. Q. 00 "’ ® pdo». CCijemm. ©O0 9
® ] @

® >, H v ® ® >, H Y ®
® ® ® ®
® ® ® ®
- - v -
qo ° ﬂ OB ao ® OB
E]
R N NN

Example: Connecting one slave unit

This completes the connections.

Performing parallel operation

Once a parallel connection is made, the master unit and slave units are automatically identified, so parallel
operation can be used immediately.

For the operating range, see the appendix (p. 179).
You can turn the POWER switches of all the electronic loads on or off in any order.
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Slew rate and response speed settings during parallel operation

During parallel operation, the slew rate and response speed settings on the master unit are used. The
slew rate increases proportionally to the number of units operating in parallel. For details, see “Slew rate
during parallel operation” (p. 179).

In the following cases, set the response speed (p.65) to Normal to ensure stable operation.
+ If the inductance of the wiring will be increased and large voltage drops will occur owing to current changes.

« If the control of the electronic loads becomes unstable and oscillation phenomena may occur owing to
phase lag of the current.

Protection function during parallel operation (parallel oper-
ation anomaly detection)

When an anomaly occurs during parallel operation, the following alarms appear on the displays of the master
and slave units, and the loads are turned off. Eliminate the root cause of the alarm, and then clear the alarm.

Display Applicable unit Activation condition Clearing method

Parallel Communication ~ Master unit A communication anomaly was Restart!

Alarm detected during parallel operation.

Parallel Slave Over Master unit An overheating of a slave unit was Press ENTER on the master

Temperature Alarm detected. unit.

OTP/Front Alarm Slave unit An overheating of master unit was Press ENTER on the master
detected. unit.

A current of 30 A or more flowed
through the front-panel DC INPUT

terminals of the master unit.2

AC Fail Alarm Master unit A slave unit’s power supply was Restart!
interrupted.
Parallel Master Lost Alarm  Slave unit The master unit cannot be detected. Restart?
Alarm Slave unit An alarm of another unit was detected. Press ENTER on the master unit.

Incorrect Slave Alarm Master unit A Kikusui PLZ-5WH series or PLZ-5W  Restart!

series® electronic load was connected
to a slave unit.

1. You can turn the POWER switches of all the electronic loads off or on in any order.
2. PLZ1005WH2, PLZ2005WH2, PLZ4005WH2 only.
3. PLZ12005WH, PLZ20005WH, PLZ205W, PLZ405W, PLZ1205W, or PLZ2405WB.

Changing from parallel operation back to standalone operation

Turn off all the units connected for parallel operation, and then remove all connections for parallel opera-
tion. Then, connect for standalone operation.

ACAUTlON To avoid damaging the product, observe the following precautions. Do not perform stand-
alone operation with the parallel operation signal cable left connected to the PARALLEL con-
nector.
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System Settings

Displaying and Changing CONFIG Settings

You can set the following parameters using the CONFIG settings.

Parameter Value! Description

Remote Sensing Enable/Disable Remote sensing(p. 69).

Power On RST/RCLO/Resume Panel settings at startup (p. 127).

Watchdog Enable/Disable Watchdog protection setting (p. 53).
Delay 1 second to 3600 seconds (1 Time until watchdog times out.

second unit)
Factory default is 60 seconds.

Screen Saver Enable/Disable Screen saver (p. 128).

Delay 60 seconds to 59940 seconds Time until the screen saver starts.
(after setting, rounded to nearest
second unit)
Factory default is 60 seconds.

Key Enable/Disable Key lock (p. 129).
Lock Level Low/Medium/High Key lock level (p. 129).
Beeper - Beep sound setting (p. 730).
Key Enable/Disable Beep sound for invalid operation.
Protection Enable/Disable Beep sound for alarm occurrence.
SCPI Enable/Disable Beep sound for SCPI errors.
Digital2 - -
Direction Input/Output 1/0 direction of DIGITAL2 signal (p. 131).

1. Factory default settings are underlined.

Remote sensing

You can enable or disable remote sensing. For details on remote sensing, see “Remote Sensing” (p.67).
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System Settings | Displaying and Changing CONFIG Settings

Panel settings at startup

The panel setting state at power-on can be selected.

Parameter  Description

RST Start with the reset settings (p. 139).
RCLO Start in setup memory (p.78) 0 condition.
Resume Start with the same settings as when the power was

switched off the previous time (but always load off).

Press SYSTEM.
If the Configure screen does not appear, press Configure.

2 Use the rotary knob to select Power on, and then press Edit.

Use the rotary knob to select a parameter, and then press ENTER.
This completes the setting.

Watchdog protection setting (WDP)

You can enable or disable WDP and set the WDP value. For details on WDP, see “Setting watchdog pro-
tection (WDP)” (p.53).
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System Settings | Displaying and Changing CONFIG Settings

Screen saver

The screen saver starts and the display dims when there is no panel activity for a specified length of time.
Set the time until the screen saver starts.

1

(<) I~

Press SYSTEM.
If the Configure screen does not appear, press Configure.

Use the rotary knob to select Screen Saver, and then press Edit.

1: Enable
1: Enable
1: Enable =

Recall - gcpl Admin  Infomation

Use the rotary knob to select Enable, and then press ENTER.
Selecting Disable disables the function.

Use the rotary knob to select Delay, and then press Edit.

Use the numeric keypad or the rotary knob to set the time until the screen saver is
activated, and press ENTER.

This completes the setting.
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System Settings | Displaying and Changing CONFIG Settings

Key lock

The keys can be locked to prevent changing the settings or overwriting memory or sequences by mistake.

Setting the key lock level

PLZ-5WH2

You can set three different key lock levels according to the type of keys whose operation is prohibited.

While
While

key lock is enabled, an icon is shown in the top area of the display depending on the key lock level.
the keys are locked, you cannot switch to the Configure screen. To set the key lock level, release the

key lock in advance.

Level

Description Icon

1:Low Locks all operations except the following. E

* Release key lock

* Load on/off

» Used to recall setup memory.
* ABC preset memory recall

2:Medium Locks all operations except the following. E

* Release key lock
* Load on/off

3:High All key operations are locked except key lock release. @

=

Press SYSTEM.
If the Configure screen does not appear, press Configure.

Use the rotary knob to select Level under Key Lock, and then press Edit.

Value =

1: Enable

1: Enable
B 1: Enable =
Recall scpl
_lntedace __Saue - - ___

Admin  Infomation
Use the rotary knob to select the key lock level.

Press ENTER.
This completes the setting.
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System Settings | Displaying and Changing CONFIG Settings

Enabling the key lock from the SYSTEM screen

1 Press SYSTEM.
If the Configure screen does not appear, press Configure.

2 Use the rotary knob to select Key Lock, and then press Edit.

3 Use the rotary knob to select Enable, and then press ENTER.
Key lock is enabled.
To clear the key lock, hold down ENTER on the front panel.

Enabling or disabling the key lock from the front panel

Hold down KEY LOCK.
Each time KEY LOCK is held down, key lock is enabled or disabled.

Setting the beep sound

You can enable or disable beep sounds that are emitted in case of invalid operation, alarm occurrence, or
SCPI error.

1 Press SYSTEM.
If the Configure screen does not appear, press Configure.

2 Use the rotary knob to select the following items under Beeper, and then press
Edit.

SCPI Admin  Infomation

Parameter Description

Key Beep sound for invalid operation
Protection Beep sound for alarm occurrence
SCPI Beep sound for SCPI errors

3 Use the rotary knob to select Enable or Disable, and then press ENTER.
This completes the setting.
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System Settings | Displaying and Changing CONFIG Settings

Setting the DIGITAL2 signal input/output

PLZ-5WH2

Press SYSTEM.
If the Configure screen does not appear, press Configure.

Use the rotary knob to select Direction under Digital2, and then press Edit.

i 2
1: Enable
1: Enable

1 0: Input vIE|
Recall | Scpl Admin  infomation

Use the rotary knob to select Input (digital input) or Output (digital output), and then
press ENTER.

This completes the setting.
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System Settings

Displaying/Changing the Interface Settings

You can set the following parameters.

Items that have the v mark in the “Reset” column are returned to their factory default values when the

interface settings are reset.

Parameter Value! Description Reset
IP Address - IP address
Method Automatic (auto)/Static (fixed) IP address assignment method V4
IP Address - IP address -
Subnet Mask - Subnet mask -
Default Gateway - Default gateway -
DNS Server - DNS server address
DNS Server 1 - Primary DNS server address -
DNS Server 2 - Secondary DNS server address -
WINS Server - WINS server address
WINS Server 1 - Primary WINS server address -
WINS Server 2 - Secondary WINS server address -
Host name & Services - Host name and service
Desired Hostname Enter the host name (up to 15 Host name setting
characters). Factory default is -
model name and serial number.
Desired Description Enter the service name (up to mDNS service name setting
63 characters). Factory default
is KIKUSUI XXXX Electronic -
Load (XXXX = model name)
and serial number.
Dynamic DNS Enable/Disable Setting of dynamic DNS v
mDNS Enable/Disable Setting of multicast DNS v
NetBIOS Over TCP/IP  Enable/Disable NetBIOS Over TCP/IP setting v
Auto Clock Adjustment - Auto clock
NTP Server Hostname  ntp.nict.jp NTP server address -
Auto Adjustment Enable/Disable Setting of auto clock adjustment -
RS232C Settings - RS232C settings
Bitrate 9600/ 19200/ 38400/ Baud rate [bps] _
57600/ 115200
Data Bits 8 (fixed) Data length -
Stop Bits 1 (fixed) Stop bits -
Flow Control None / CTS-RTS Flow control -
1. Factory default settings are underlined.
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PLZ-5WH2

o O Ww

System Settings | Displaying/Changing the Interface Settings

Press SYSTEM > Interface.

The Interface (View Mode) screen appears.
If the Interface screen does not appear, press Interface again.

View Mode is for checking the settings. You cannot change the settings.

Interface{view Made)

Admin  in

Press Modify.
The Interface (Modify Mode) screen appears. You can change the settings in Modify Mode.

Interface

Default

Apply |

Use the rotary knob to select the parameter, and then press Edit.
Use the numeric keys or rotary knob to enter a value, and then press ENTER.

Press Apply.
A confirmation screen appears.

Press ENTER.
This completes the setting. The screen switches to View Mode.
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System Settings | Displaying/Changing the Interface Settings

Resetting the interface settings

Interface settings that have a v mark in the reset column in (p. 132) above are returned to the factory

default setting.

1 Press SYSTEM > Interface.
If the Interface screen does not appear, press Interface again.

2 Press Modify > LAN Reset.
A confirmation screen appears.

3 Press ENTER.
The interface setting is reset.

Returning the interface settings to the factory default values

1 Press SYSTEM > Interface.
If the Interface screen does not appear, press Interface again.

2 Press Modify > Default.
A confirmation screen appears.

3 Press ENTER.
The interface settings are returned to the factory default values.
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System Settings

Displaying SCPI Errors

PLZ-5WH2

You can check the content of the SCPI error when an SCPI error occurs during remote control.

Up to 16 errors are displayed. If the 17th error occurs, the 16th error changes to “-350 Queue overflow,”
and subsequent errors are not displayed.

1 Press SYSTEM > SCPI.

The SCPI error is displayed. For details on errors, see the Communication Interface Manual on the
included CD-ROM.

Pressing Clear or restarting the product will clear the error.
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System Settings

Setting the Date/Time

The date and time are used when saving setup memory.
If you change the time zone, the year, month, and day change accordingly.

If the product is connected to LAN and can access the Internet, the year, month, and day will be updated
automatically when you set the time zone.

1 Press SYSTEM > Admin > Date/Time.

2 Set the time zone and the date and time.
Each time you press Tab, the item that you can set changes.

Date & Time
ime Zone
Region name

- .
Sanitize)

City name
Firmware|
Update

Date & Time

Configure  Recall
Saue

Purpose Operation

Set the time zone (region name) Press Tab to select the item in the top row of Time Zone, and
then use the rotary knob to select the region name.

Set the time zone (city name) Press Tab to select the item in the bottom row of Time Zone,
and then use the rotary knob to select the city name.

Set the year, month, day, and time. Press Tab to select the year, month, day, or time of Date &
Time, and use the numeric keypad or rotary knob to enter the
value.

Press Apply.

This completes the setting.
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System Settings

Factory Default Settings and Reset Settings

The product provides “factory default settings” and “reset settings” as default settings.

Restoring the factory default settings

Restoring the factory default settings deletes all the user data*.
For details about the factory default setting, see “Main settings at factory default and at reset” (p. 139).

*: The user data is deleted in accordance with the NISPOM (National Industrial Security Program Operat-
ing Manual) standard.

You can also return only the interface settings to their factory default values (p. 134).

1 Press SYSTEM > Admin > Sanitize.

Sanitize

itized and the unit  EETTlarae]

Execute..

-Configure Recall SCPI
Gfaeaia G C

Infomation

2 Press Execute.
A confirmation screen appears.

3 Use the rotary knob to select OK, and then press ENTER.
The product restarts, and the factory default settings are restored.

(NOTE) The error “-314 Save/recall memory lost” always occurs after the product restarts, but
; ’ this is actually not an error.
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System Settings | Factory Default Settings and Reset Settings

Restoring the reset settings

You can reset some of the settings to their factory defaults.
For the items that are reset, see “Main settings at factory default and at reset” (p. 139).

You can also reset only the interface settings (p. 134).

Resetting at power-on

1 Press SYSTEM.
If the Configure screen does not appear, press Configure.

2 Use the rotary knob to select Power on, and then press Edit.

Configure
Item Value

1: Enable
1: Enable
1: Enable =
Recall | Scpl Admin  infomation

Use the rotary knob to select RST, and then press ENTER.

4 Turn the POWER switch off and then back on.
The product restarts with some of the settings reset to their factory defaults.

Resetting immediately

1 Press SYSTEM > SCPI.

2 Press *RST.

SCPI error queue
Code Message

*RST

onnioyre m’f?" Admin  Infomation

A confirmation screen appears.

3 Press ENTER.
Some of the settings are reset.
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System Settings | Factory Default Settings and Reset Settings

Main settings at factory default and at reset

The main settings at factory default and at reset, for each of the settings that can be done with the

SOURCE key, MEASURE key, SEQUENCE key, and SYSTEM key, are listed below. All items that have

the v mark in the “Reset” column are returned to their factory default values upon reset.

SOURCE function settings

PLZ-5WH2

Parameter Factory default Reset
Operation mode CcC V4
CC range (CR range) H range v
Current 0A Vs
Conductance 0S v
Voltage ov v
Power ow v
ABC preset value CC mode 0A v
CR mode 0S s
CV mode oV v
CP mode ow v/
Response speed for CR mode Normal V4
Response speed for CV mode Normal v
Response speed for ARB mode 500 ps v
Soft start time 500 ps v
Cutoff Elapsed time Disable V4
Voltage drop Disable v
Integrated current Disable V4
Integrated power Disable v
External control CC/CR/CP mode Disable v
CV mode Disable v
CC Add Disable v/
Input Logic Positive v
Pulse Function Disable v
Current (Depth) 0A V4
Conductance (Depth) 0S V4
Duty cycle 50 % v
Frequency 1 Hz v
Sine Function Disable v
Amplitude 0A v
Frequency 1 Hz v
Number of data points of |-V characteristics 3(all0A) V4
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System Settings | Factory Default Settings and Reset Settings

SOURCE function settings (continued)

Parameter Factory default Reset
PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2

Slew rate 0.001 A/us 0.002 A/us 0.004 A/us 0.01 Alus 0.02 Alus v/

Overcurrent protection 22 A 44 A 88 A 264 A 440 A

setting

Operation at overcurrent Limit

protection activation v

Overpower protection 1100 W 2200 W 4400 W 13200 W 22000 W

setting v

Operat?on at overpower Limit v

protection activation

Undgrvoltage protecton OFF v

setting

Operation at undervolt-  Limit

age protection activation 4

MEASURE function settings

Parameter Factory default  Reset

Measurement function Number of measurement values to be recorded 1 V4
Delay Os V4
Measurement interval function (Interval) Disable v
Measurement interval time (Interval Time) 01s V4
Trigger source Immediate V4
Measurement time (Sense Aperture) 01s V4

Integrated data record-  Integrated data recording period (Integral Gate) Load On V4

ing function Resetting of integrated data before start of recording Auto
(Reset) 4

Integrated data display = Elapsed time Enable V4
Integrated current Disable v/
Integrated power Disable V4

SEQUENCE function settings

Parameter Factory default Reset

Program No program -

Trigger source Immediate -

Trigger delay Os -
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System Settings | Factory Default Settings and Reset Settings

SYSTEM function settings

Parameter Factory default Reset
Remote sensing Disable -
Panel settings at startup (Power On) Resume -
Watchdog protection function Disable -
Set time for watchdog protection function (Delay) 60s -
Screen saver Disable -
Screen saver startup time (Delay) 60s -
key lock Disable -
Key lock level High -
Beep sound In case of invalid operation (Key) Enable -
In case of alarm activation Enable -
In case of SCPI error Enable -
I/O direction of DIGITALZ2 signal Input -
Time zone uTc! -

1. If reset to the factory default value, set the date and time (p. 136).

For details on the factory default settings and reset settings for the interface, see “Displaying/Changing the
Interface Settings” (p. 132).
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System Settings

Updating

You can update the product’s firmware by using a USB memory device.
If there is an update, you can obtain it from the download service on the Kikusui website (http://www.kiku-

sui.co.jp/en/download/).

(NOTE) Save the update files (Update.img, CHECKSUM.md5) in the root directory of the USB
\ ’ memory device. Do not change the names of the update files.

1 Press SYSTEM > Admin > Firmware Update.

Firmware Update = E,ate
ime

Prerequisite Sanitizel
- Prepare the firmware update

fil Firmware

Execute..
Procedure
g el Admin [

2 Insert the USB memory device on which the update files have been saved into the
USB port on the front panel, and then press Execute.

An update screen appears.

Firmware Update

- Press [ENTER] key to start.
- Press [ESCAPE] key to reboot.

Once update has started, don't turn off the
unit and don't remave the USB until
everything finishes.

0%

3 Press ENTER.
The update process begins. Do not turn off the POWER switch while updating is in progress. Do

not remove the USB memory device.

4 After the update complete screen appears, turn the POWER switch off and then
back on.
Firmware Update

The system is going down for reboot
now!

- Remove the USB media.

Cycle the unit power...
| 100% |

Updating is complete.

142 User’s Manual PLZ-5WH2



System Settings

Displaying the Device Information

You can display the model name, serial number, firmware version, IP address, and other device informa-
tion.

1 Press SYSTEM > Information.
The device information is displayed. You can scroll the screen by turning the rotary knob.

If a connection is established when IP Address > Method is set to Automatic in the interface set-
tings (p. 132) (the LAN connection status icon in the upper right of the display is green), the auto-
matically assigned |IP address is displayed next to IP Address.

S KIKUSUI

Basic Instrument Info
PLZ4005WH2

n 2.00
IFC0.02.0015
FPGA1.00.0005

10C1.03.0006
|

SCPI Admin  |GIGGIERGT
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Maintenance

Inspection

To purchase accessories or options, contact your Kikusui agent or distributor.

Overhaul

The electrolytic capacitors and fan motor inside the product are consumable parts.

We recommend that you have the product overhauled every 10000 operating hours or so (the frequency
depends on the usage conditions), along with internal inspection and cleaning. To have your unit over-
hauled, contact your Kikusui agent or distributor.

Backup battery replacement

The product has a battery inside. The battery’s service life differs depending on the environment that the
product is used in, but three years after it is purchased is a rough estimate for the battery’s service life.
When the battery is exhausted, the time becomes inaccurate. For information about replacing the battery,
contact your Kikusui agent or distributor.

Calibration

The product is calibrated before shipment. To maintain long-term performance, we recommend periodic
calibration. To have your product calibrated, contact your Kikusui agent or distributor.
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Specifications

Unless specified otherwise, the specifications are for the following settings and conditions.

» The product is warmed up for at least 30 minutes.

* Rear-panel DC INPUT terminals are used.

The used terminology is as follows:

* TYP: These are typical values that are representative of situations where the product operates in an
environment with an ambient temperature of 23 °C (73.4 °F). These values do not guarantee the
performance of this product.

« setting: Indicates a setting.

» reading: Indicates a readout value.

« rating: Indicates a rated value.

» Open: Indicates equivalence to the state in which the DC INPUT terminals are opened.

Rating
Parameter PLZ1005WH2 | PLZ2005WH2 | PLZ4005WH2 | PLZ12005WH2 | PLZ20005WH2
Operating voltage (DC) 10V ~1000V
Power 1000 W 2000 W 4000 W 12000 W 20000 W
Current 20 A 40 A 80 A 240 A 400 A
DC INPUT terminal’s isolation Positive pin: £1 000 V, Negative pin: 900 V
voltage
Minimum At the rated 10V
operating voltage | current
When the 1.5V orless
current begins
to flow
Constant current (CC) mode
Parameter PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
Operating 0Ato20A 0Ato40A 0Ato80A 0Ato240 A 0 Ato400 A
range
Setting range | 0.0000 A to 20.2000 A | 0.000 A to 40.400 A | 0.000 A to 80.800 A | 0.00 A to 242.40 A | 0.00 A to 404.00 A
Resolution 0.0005 A 0.001 A 0.002 A 0.005 A 0.01 A
Setting +(0.2 % of setting + 0.1 % of rating)
accuracy
Parallel +(0.4 % of setting + 0.2 % of rating)
operation

PLZ-5WH2

User’s Manual

145



Specifications

Constant resistance (CR) mode

Parameter PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 | PLZ20005WH2
Operating range! |Hrange 500 mSto0S 18Sto0S 2Sto0S 6Sto0S 10Sto0S
Lrange |5mSto0S 10mSto0S 20mSto0S 60mSto0S 100mSto0S
Setting range Hrange |505.00 mS to 1.01000 S to 2.02000 S to 6.0600 S to 10.1000 S to
0.00 S 0.00000 S 0.00000 S 0.00000 S 0.0000 S
Lrange | 5.05000 mS to 10.1000 mS to 20.2000 mS to 60.600 mS to 101.000 mS to
0.00000 S 0.0000 S 0.0000 S 0.000 S 0.000S
Resolution Hrange |0.01 mS 0.00002 S 0.00005 S 0.0002 S 0.0002 S
L range |0.0001 mS 0.0002 mS 0.0005 mS 0.002 mS 0.002 mS
Setting accuracy? |Hrange | +(0.5 % of setting + 0.5 % of rating®)
Lrange | +(0.5 % of setting + 0.2 % of rating®)
Parallel Hrange | +(1.0 % of setting + 1.0 % of rating®)
operation
Lrange | +(1.0 % of setting + 0.4 % of rating®)
Response speed NORM/FAST
1. Conductance [S] = input current [A}/input voltage [V] = 1/resistance [Q]
2. Converted value at the input current. At the sensing point during remote sensing.
3. Rated current
Constant voltage (CV) mode
Parameter All models
Operating range 10 Vto 1000 V
Setting range 0.00 Vto 1010.00 V
Resolution 0.02Vv
Setting accuracy’ +(0.05 % of setting + 0.05 % of rating)
Parallel operation +(0.1 % of setting + 0.1 % of rating)
Response speed NORM/FAST
1. With the input voltage within the operating range, and at the sensing point during remote sensing.
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Specifications

Constant power (CP) mode

Parameter PLZ1005WH2 PLZ2005WH2 PLZ4005WH2

Operating 0 W to 1000 W 0 W to 2000 W 0 W to 4000 W

range

Setting range | 0.00 W to 1010.00 W 0.00 W to 2020.00 W 0.0 W to 4040.0 W

Resolution 0.02 W 0.05W 01W

Setting 0 . 2 0 . -2 o . 2

accuracy +(0.5 % of rating’ + 0.02 A x Vin“) | (0.5 % of rating’ + 0.04 A x Vin“) | £(0.5 % of rating'+ 0.08 A x Vin<)
Parallel +(1 % of power rating + 0.1 % current rating x Vin2)
operation

1. Rated power
2. DC INPUT terminal voltage or SENSING terminal voltage.

Parameter PLZ12005WH2 PLZ20005WH2
Operating 0 W to 12000 W 0 Wto 20000 W
range
Setting range | 0.0000 kW to 12.1200 kW 0.0000 kW to 20.2000 kW
Resolution 0.0005 kW
Setting +(0.5 % of rating” + 0.2 A x Vin2 ) +(0.5 % of rating + 0.4 A x Vin?)
accuracy B 9 +u e 9 *v
Parallel +(1 % of power rating + 0.1 % current rating x Vin?)
operation

1. Rated power
2. DC INPUT terminal voltage or SENSING terminal voltage.

Arbitrary I-V characteristics (ARB) mode

Parameter All models

Operating range Three to 100 points of current values can be specified for the input voltage.
Linear interpolation is applied between specified points.

Response speed 500 us, 1 ms, 2 ms, 5 ms, 10 ms, 20 ms, 50 ms, 100 ms, or off
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Specifications

Measurement function

Voltmeter
Parameter All models
Display 0.00 V to 1000.00 V
Resolution 10 mV
Accuracy +(0.05 % of reading + 0.05 % of rating)
‘ Parallel operation +(0.1 % of reading + 0.1 % of rating) (TYP)

Ammeter
Parameter PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
Display 0.000 A to 20.000 A | 0.000 A to 40.000 A | 0.000 A to 80.000 A | 0.00 A to 240.00 A | 0.00 A to 400.00 A
Resolution 0.001 A 0.001 A 0.001 A 0.01 A 0.01A
Accuracy +(0.2 % of reading + 0.1 % of rating)
Parallel +(0.4 % of reading + 0.2 % of rating) (TYP)
operation

Power display

Parameter

All models

Display

Displays the product of the voltmeter reading and ammeter reading

Measurement trigger

Parameter All models

Trigger Source Immediate, BUS, DIGITAL2, MSync, TALink, LoadOff
Trigger Count 1to 65536

Trigger Delay 0.00000 s to 100.00000 s

Interval Disable/Enable

Interval Time 0.00001 s to 3600 s

Sense Aperture 0.00001 s to 1.00000 s
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Pulse function

Specifications

Parameter All models
Operation mode CC and CR
Frequency setting range 1.0 Hz to 10.0 kHz
Frequency setting 1Hzto 10 Hz 0.1 Hz
resolution’ 11 Hz to 100 Hz 1 Hz

110 Hz to 1000 Hz 10 Hz

1.1 kHz to 10.0 kHz 0.1 kHz

Frequency setting 1 Hzto 5.0 kHz +(0.5 % of setting)
accuracy 5.1 Hz to 10.0 kHz +(1.0 % of setting)
Duty cycle setting range, |1 Hzto 10 Hz 5.0 % to 95.0 %, 0.1 % steps

step 11 Hz to 100 Hz
110 Hz to 1000 Hz
1.1 kHz to 10.0 kHz 5% 1095 %2,1 % steps
1. (Reference) The resolution actually set in the device is period resolution 4 T =1 pus, as shown in the equation below. For

example, if you specify 9300 Hz, the period set in the device willbe n x 4 T =108 x 1 ys = 108 pys (where n is a number set
in the device). Converted to frequency, this becomes 1/108 ps = 9259 Hz.

2. The minimum time span is 20 ps. The minimum duty cycle is limited by the minimum time span.

Switch value (Depth)

Parameter! | PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
CC mode |0.0000 Ato20.2000 A |0.000 Ato40.400 A | 0.000 A to 80.800 A | 0.000 A to 242.40 A | 0.00 A to 404.00 A
CRmode | 505.00mSt00.00S 1010.00 mS to 2020.00 mS to 6.06000 S to 10.1000 S to

H range 0.00 S 0.00S 0.00000 S 0.0000 S
CRmode | 5.0500 mSto 0.0000S | 10.1000 mS to 20.2000 mS to 60.600 mS to 101.000 mS to

L range 0.0000 S 0.0000 S 0.000 S 0.000 S

1. The switch value is limited to the set current or set conductance or less.

Slew rate

Parameter | PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
Operation CcC

mode

Operating 0.001 A/us to 1 A/us | 0.002 A/us to 2 A/us | 0.004 A/usto 4 A/lus | 0.01 A/us to 12 A/us | 0.02 A/us to 20 Alus
range

Resolution | 0.00002 A/us 0.00005 Alus 0.0001 A/us 0.0002 Alus 0.0005 A/us
Setting +(10 % of setting +20 us)

accuracy1

1. Time to change from 10 % to 90 % when the current is changed from 0 % to 100 % of the rated current

PLZ-5WH2
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Specifications

Sine function

Parameter All models
Operation mode CcC
Frequency setting range 1 Hz to 1000 Hz, 2000 Hz, 5000 Hz, 10000 Hz
Frequency setting 1Hzto 10 Hz 1Hz
resolution’ 20 Hz to 100 Hz 10 Hz
200 Hz to 1000 Hz 100 Hz

Frequency setting 300 Hz to 900 Hz +(1.0 % of setting)
accuracy Other than the frequencies above +(0.5 % of setting)

1. (Reference) The resolution actually set in the device is period resolution 4 T= 20 ps, as shown in the equation below. For

example, if you specify 900 Hz, the period set in the device willbe n x 4 T =56 x 20 us = 1120 ps (where n is a number set
in the device). Converted to frequency, this becomes 1/1120 ys = 893 Hz.

Soft start

Parameter

All models

Operation mode

CcC

Time setting range

500 ys, 1 ms, 2 ms, 5 ms, 10 ms, 20 ms, 50 ms, 100 ms, or off
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Alarm function

Alarm 1

Specifications

Parameter

All models

Overvoltage detection

Turns off the load when a voltage that is 110 % of the rating or higher is applied.

Reverse-connection detection

Turns off the load when approximately -1 % of the rated current flows through the
DC INPUT terminals.

Overheat detection, overcurrent detection
of the front-panel DC INPUT terminals

Turns off the load when the heatsink temperature reaches 100 °C.

Or, turns off the load when a current of 30 A or higher is flowing through the front-
panel DC INPUT terminals.

Alarm input detection

Turns off the load when a voltage between 0 V and 1.5 V is applied to ALARM
INPUT (pin 6) of the EXT CONT connector.

Parallel operation anomaly detection

Turns off the load when any of the following errors occurs.

* An error occurred in the communication between the master unit and slave unit
during parallel operation.

» A slave unit's power supply was interrupted.
» An overheating was detected on the master or slave unit.

» An overcurrent flowed through the front-panel DC INPUT terminals.

Alarm 2
Parameter PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
Overcurrent | Setting range | 0.000 Ato 22.000 A | 0.00 Ato 44.00 A  0.00 Ato 88.00 A |0.00 Ato 264.00 A 0.0Ato440.0A
protection | Resolution 0.001 A 0.01A 0.01A 0.01A 0.1A
OCP
( ) Protection Select load off or limit.
operation
Overpower Settingrange | 0.0 Wto 1100.0 W | 0.0 W to 0Wto4400 W |0.000 W to 0.000 W to
protection 2200.0 W 13.200 kW 22.000 kW
(OPP) Resolution 0.1W 0.1W 1W 0.001 kW 0.001 kW
Protection Select load off or limit.
operation
Undervoltage | Setting range | 0.00 V to 1000.00 V, or off.
protection  Resolution 0.02V
(UVP) _ —
Protection Select load off or limit.
operation
Watchdog Setting range | 1 s to 3600 s or off
protection Protection Load off
(WDP operation
Sequence function
Parameter All models
Operation mode CC,CR,CV, CP
Maximum number of programs 30
Maximum number of steps 10000
Step execution time 0.000050 s to 3600000 s (50 us to 1000 h)
Time resolution 1 us

PLZ-5WH2
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Integration display

Parameter

PLZ1005WH2 ‘ PLZ2005WH2 ‘ PLZ4005WH2 PLZ12005WH2 PLZ20005WH2

Elapsed time display

Displays the time from load on to load off.

‘ Range

0 s to 3600000 s (1000 h 0 min 0 s)

Ampere-hour meter
display

Displays integrated current

‘ Range

0 Ah to 70000 Ah ‘ 0 Ah to 140000 Ah ‘ 0 Ah to 280000 Ah | 0 Ah to 800000 Ah | 0 Ah to 1400000 Ah

Watt-hour meter
display

Displays integrated power

Range 0 Wh to 0 Wh to 0 Wh to 0 Wh to 0 Wh to
40000000 Wh 80000000 Wh 160000000 Wh 500000000 Wh 800000000 Wh
Cutoff function
Parameter PLZ1005WH2 ‘ PLZ2005WH2 ‘ PLZ4005WH2 PLZ12005WH2 PLZ20005WH2
Elapsed time The load turns off when the elapsed time value reaches the specified value.
Range 0sto 3600000s (1000 h0min0's)
Resolution 1s

Integrated current | The load turns off when the ampere-hour meter value reaches the specified value.

Range

0 Ah to 70000 Ah ‘ 0 Ah to 140000 Ah ‘ 0 Ah to 280000 Ah | 0 Ah to 800000 Ah | 0 Ah to 1400000 Ah

Resolution

0.001 mAh (0.000 mAh to 1000.000 mAh)
0.001 Ah (1.001 Ah to 1000.000 Ah)
0.001 kAh (1.001 kAh to 1000.000 kAh)
0.001 MAh (1.001 MAh to 1.400 MAh)

Integrated power

The load turns off when the watt-hour meter value reaches the specified value.

Range 0 Wh to 0 Wh to 0 Wh to 0 Wh to 0 Wh to
40000000 Wh 80000000 Wh 160000000 Wh 500000000 Wh 800000000 Wh
Resolution 0.001 Wh (0.000 Wh to 1000.000 Wh)
0.001 kWh (1.001 kWh to 1000.000 kWh)
0.001 MWh (1.001 MWh to 800.000 MWh)
Voltage drop The load turns off when the voltmeter value becomes less than or equal to the specified value.
Range 0.00 V to 1000.00 V
Resolution 0.02V

Other functions

Parameter All models

Remote sensing Input voltage rating’ 1000 V2
Isolation voltage +1000 V

Number of units in parallel operation 5 units

Mutual synchronized operation®

Synchronizes load on/off.
Synchronization of sequence execution, and sequence resumption.
Synchronizing the recording timing of measured values.

1. There are limitations depending on the actual power that the load consumes.
2. Total potential difference between the DC INPUT terminals and SENSING terminals
3. The terminals for mutual synchronized operation are isolated from the DC INPUT terminals and operate at the chassis potential.
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Specifications

Common specifications

EXT CONT connector

Parameter’

Specifications

Load on/off control input

Logic level switchable. Pulled up to 5 V by a 10 kQ resistor.
The thresholds are HIGH: 3.5V to 5V, LOW: 0 Vto 1.5 V.

Alarm input

An alarm is activated with a voltage between 0 V and 1.5 V. Pulled up to 5V by a 10 kQ
resistor.
The thresholds are HIGH: 3.5 Vto 5V,LOW:0Vto1.5V.

Alarm clearing input

After an alarm occurs, eliminate the root cause of the alarm, and change the input to pin 5 of
the EXT CONT connector from a low level signal to a high level signal. The alarm will be
cleared on the rising edge of this signal.

Pulled up to 5 V by a 10 kQ resistor. The thresholds are HIGH: 3.5V to 5.0 V, LOW: 0 V to
1.5V.

Trigger input

Paused sequence operation resumes when a voltage between 0 V and 0.66 V is received.

Pulled up to 5 V by a 10 kQ resistor. The thresholds are HIGH: 2.31 V to 3.3 V, LOW: 0 V to
0.66 V.

External voltage control input
(CC, CR, CP mode)

Controls the load settings of CC, CR, CP mode through external voltage input.

Input impedance: Approx. 10 kQ.

CC: The setting can be controlled in the range of 0 % to 100 % of the rated current through
external voltage input of 0 V to 10 V.

CR: The setting can be controlled in the range of 0 % to 100 % of the conductance setting
through external voltage input of 0 V to 10 V.

CP: The setting can be controlled in the range of 0 % to 100 % of the rated power through
external voltage input of 0 V to 10 V.

‘ Setting accuracy

+(1 % of rating) (TYP value in CC mode)

External voltage control input
(CV mode)

The load setting of CV mode can be controlled through external voltage input.

The rated voltage can be controlled in the range of 0 % to 100 % with 0 V to 10 V. Input
impedance: Approx. 10 kQ.

‘ Setting accuracy

+(1 % of rating) (TYP)

External voltage control input
(superimposing in CC mode)

Controls the load setting of CC mode by adding current through external voltage input.
Adds current in the range of -100 % to 100 % of the rated current for -10 V to 10 V.
Input impedance: Approx. 10 kQ.

‘ Setting accuracy

+(1 % of rating) (TYP)

Load-on status output

On when load is on. Open-collector output from a photocoupler.2

ALARM 1 output

ON when overvoltage detection, reverse-connection detection, overheat detection, front-
panel DC INPUT overcurrent detection, alarm input detection, or parallel operation anomaly

detection is activated. Open-collector output from a photocoupler.2

ALARM 2 output

Turns on when OCP, OPP, UVP, or WDP is activated. Open-collector output from a
photocoupler.2

DIGITAL 0 output

DIGITAL 1 output

Can be controlled through sequences. Output impedance: Approx. 330 Q.
The thresholds are HIGH: 2.5V to 3.3V, LOW: 0V to 0.4 V.

DIGITAL 2 input/output

Input/output switchable.

Output: Sequence trigger output. The output impedance is 330 Q. The thresholds are HIGH:
25V1t03.3V,LOW:0Vto04 V.

Input: Trigger input signal for the sequence and the measurement functions. The thresholds are
HIGH: 2.31 V10 3.3V, LOW: 0V to 0.66 V.

Current monitor output

Outputs 0 V to 10 V for 0 % to 100 % of the rated current Output impedance: 1 kQ (TYP).

Accuracy

+(1 % of rating) (TYP)

1. 1000 V reinforced insulation

between each terminal and the DC INPUT terminal

2. The maximum voltage that can be applied to the photocoupler is 30 V. The maximum current is 4 mA.

PLZ-5WH2
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BNC connector

Parameter

Specifications

Trigger output

Transmits 10 ys pulses during step execution when trigger output is set in a sequence.
Transmits 10 ps pulses during pulse operation and sine operation.
Output impedance: 200 Q, output voltage HIGH: 4.2V t0 5.0 V, LOW: 0V to 0.4 V.

Current monitor

Output voltage Outputs 0 V to 10 V for 0 % to 100 % of the rated current

output

Outputimpedance |50 Q (TYP)

Accuracy +(1 % of rating)

Voltage monitor

Output voltage Outputs the measured voltage with 1/100 magnification from 0 V to 10 V.

output

Outputimpedance |50 Q (TYP)

Accuracy +(1 % of rating)

Isolation voltage

+30V

Communication function

Parameter Specifications
RS232C Hardware D-SUB 9-pin connector.
Baud rate: 9600, 19200, 38400, 115200 bps.
Data length: 8 bits, Stop bits: 1 bit, Parity bit: None
Flow control: No, CTS/RTS
Message terminator LF during reception, LF during transmission.
USB (device) Hardware Standard type B socket.
Complies with the USB 2.0 specification. Data rate: 480 Mbps (High Speed).
Message terminator LF or EOM during reception, LF + EOM during transmission.
Device class Complies with the USBTMC-USB488 device class specifications.
USB (host) Hardware Standard type A socket
Complies with the USB 2.0 specification. Data rate: 480 Mbps (High Speed).
LAN Hardware IEEE 802,3 100Base-TX/10Base-T Ethernet
IPv4, RJ-45 connector.
Compliant standards LXI 1.4 Core Specification 2011
Communication protocol | VXI-11, HiSLIP, SCPI-RAW, SCPI-Telnet
Message terminator VXI-11, HiSLIP: LF or END during reception, LF + END during transmission.
SCPI-RAW: LF during reception, LF during transmission.
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General specifications

Specifications

Parameter PLZ1005WH2 | PLZ2005WH2 | PLZ4005WH2 | PLZ12005WH2 | PLZ20005WH2
Input voltage range 100 Vac to 240 Vac (90 Vac to 250 Vac) single phase

Input frequency range 47 Hzto 63 Hz

Power consumption 70 VAmax 90 VAmax 150 VAmax 360 VAmax 590 VAmax
Inrush current | 100 Vac 30 Amax 30 Amax 30 Amax 40 Amax 40 Amax
(peak value) 230 vac 80 Amax 80 Amax 80 Amax 160 Amax 160 Amax
Leakage current’ 0.5mAorless 06mAorless 08mAorless |1.6mAorless |2.4mAorless

Environmental

Operating temperature range

0 °C to 40 °C (32 °F to 104 °F)

conditions Operating humidity range 20 %rh to 85 %rh (no condensation)

Storage temperature range: -25°C to 60 °C (-13 °F to 140 °F)

Storage humidity range: 90 %rh or less (no condensation)

Installation location Indoor use, altitude of up to 2000 m, overvoltage category I
Insulation Between primary and chassis, | 1000 Vdc, 30 MQ or more (70 %rh or less)
resistance input, monitor terminals

Between input terminals and
chassis, monitor terminal

1000 Vdc, 3 MQ or more (70 %rh or less)

Withstanding
voltage

Between primary and chassis,
input, monitor terminals

No abnormalities at 1500 Vac for 2 s

Between input terminals and
chassis, monitor terminal

No abnormalities at 1500 Vac for 2 s

External dimensions See p. 156 . See p. 156 . See p.157 . See p.158. See p.159.
Weight Approx. 13 kg | Approx. 16 kg | Approx. 20 kg | Approx. 64 kg | Approx. 93 kg

(28.7 Ibs) (35.3 Ibs) (44.1 Ibs) (141.1 Ibs) (205 Ibs)
Accessories Seep.3.

Electromagnetic compatibility23

Complies with the requirements of the following directive and standards.
EMC Directive 2014/30/EU

EN 61326-1 (Class A%)

EN 55011 (Class A*, Group 1°)

EN 61000-3-2

EN 61000-3-3

Applicable under the following conditions
The maximum length of all cabling and wiring connected to the product must be
less than 3 m.

Safety2

Complies with the requirements of the following directive and standards.
EMC Directive 2014/35/EU3
EN 61010-1 (Class 18, Pollution Degree 27)

Eal

Leakage current between the positive and negative terminals of the rear-panel DC INPUT. At 1000 Vdc.

Does not apply to specially ordered or modified products.

Only on models that have CE/UKCA marking on the panel.

This is a Class A instrument. This product is intended for use in an industrial environment. This product may cause interference

if used in residential areas. Such use must be avoided unless the user takes special measures to reduce electromagnetic
emissions to prevent interference to the reception of radio and television broadcasts.

5. This is a Group 1 instrument. This product does not generate and/or use intentionally radio-frequency energy, in the form of
electromagnetic radiation, inductive and/or capacitive coupling, for the treatment of material or inspection/analysis purpose.

6. This is a Class | instrument. Be sure to ground this product's protective conductor terminal. The safety of this product is
guaranteed only when the product is properly grounded.

7. Pollution is addition of foreign matter (solid, liquid or gaseous) that may produce a reduction of dielectric strength or surface
resistivity. Pollution Degree 2 assumes that only non-conductive pollution will occur except for an occasional temporary
conductivity caused by condensation.
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External dimensions

PLZ1005WH2, PLZ2005WH2
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Appendix

Selecting the Load Cables

&WARMNG * Risk of fire. Use load cables whose capacity is adequate for the product’s rated
input current.

* Risk of electric shock. Use load cables with a voltage rating that meets or
exceeds the isolation voltage (1000 V) of the product’s DC INPUT terminals.

ACAU“ON Use load cables with a core diameter that is appropriate for the amount of current being
used and with sturdy, flame-resistant insulation.

B Current capacity of load cables

If the resistance of the cables used as the load cables is large, a large voltage drop may occur when cur-
rent flows through the cables. This may result in the DC INPUT terminals voltage being lower than the min-
imum operating voltage of this product. Using the following table as a reference, select wiring whose
nominal cross-sectional area is as thick as possible.

A wire’s temperature is determined by the resistive loss based on the current, the ambient temperature,
and the wire’s external thermal resistance. The following table shows the current capacity of heat-resistant
vinyl wires that have a maximum allowable temperature of 60 °C when one of the wires is separated and
stretched out horizontally in air in an ambient temperature of 30 °C. The current must be reduced under
certain conditions, such as when vinyl wires that have a low heat resistance are used, when the ambient
temperature is 30 °C or greater, or when wires are bundled together and little heat is radiated.

Nominal cross-sectional AWG (reference cross-sectional  Ajlowable Current! Kikusui- Recommended

area (mm?) area mm?) [A](Ta = 30 °C) Current [A]
14 6  (13.3) 88 50
22 4 (21.15) 115 80
30 2 (33.62) 139 -
38 1 (42.41) 162 100
50 10 (53.49) 190 -

60 200 (67.43) 217 ;

80 3/0  (85.01) 257 200
100 4/0  (107.2) 298 -
125 - - 344 -
150 - - 395 300
200 - - 469 -
250 - - 556 -
325 - - 650 -

1. Excerpt from Japanese laws related to electrical equipment.
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Appendix | Selecting the Load Cables

B Taking measures against noise

When connecting cables that have the same heat resistance, separating the cables as much as possible
to increase heat radiation enables a greater amount of current to flow. However, wiring the positive (+) and
negative (-) output wires of the load cable side by side or bundling them together is more effective against
unwanted noise. The Kikusui-recommended currents shown in the above table are allowable currents that
have been reduced in consideration of the potential bundling of load cables. Use these values as a guide-
line when connecting load cables.

B Limitations of the remote sensing

All wires have resistance. As the cable becomes longer or the current becomes larger, the voltage drop in
the cable becomes greater. This results in a smaller voltage being applied at the DC INPUT terminal. Use
cables with a large cross-sectional area to keep the DC INPUT terminal voltage from falling below the
operating voltage.
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Appendix

Methods to Stabilize Operation

Using the product at a fast response speed may cause instable oscillation or other operation instability. To
achieve stabilization, the load cable inductance must be reduced and an appropriate response speed must
be set.

Reducing the load cable inductance

Relationship between voltage induction when current is changed and induc-
tance

Load cables have inductance L. If current | changes quickly, a large voltage is induced on both ends of the
installed cables. If the impedance of the DUT is small, this voltage is entirely applied to the DC INPUT ter-
minals of the electronic load. The load cable’s inductance L and voltage E that is induced according to the
changes in current | (hereafter referred to as the induced voltage) are expressed by the following expres-

sion:
m PLZ-5WH2
L
+ E=Lx(Al/AT)

E:Induced voltage

i

puT il_ __E AUAT L: Wiring inductance
/ Al: Change in current
-3 AT: Duration of time over which the current changes
DC INPUT terminali—o— - ____ 3

Generally, a cable's inductance is 1 yH per meter of cable. If 1 meter of cable (cumulative length of posi-
tive (+) polarity cable and negative (-) polarity cable) is used as the load cable between the DUT and elec-
tronic load, and the current change is 50 A/us, the induced voltage is 50 V.

In constant voltage mode, constant resistance mode, and constant power mode, the load current is varied
by the voltage at the DC INPUT terminals. This causes the operation to be easily affected by induced volt-
age.

Preventing large voltage variation when load current changes suddenly

Use the shortest cables possible to connect the product and DUT, and twist the cables. If the cables are
too thick to be twisted, bring the DC INPUT terminal’s positive and negative terminal cables close together
and make them parallel. If the load cable is long or has a large loop, the inductance of the wiring will be
increased and large voltage variation will occur owing to current changes when the load current changes
suddenly. Keep the voltage resulting from inductance equal to or higher than the minimum operating volt-
age and within the maximum input voltage range of the product.

/\

Current Al /

DC INPUT terminal
voltage

AT

N\

/ Minimum operating voltage
When the value of drops below the
minimum operating voltage, the set
slew rate is not realized.
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Appendix | Methods to Stabilize Operation

When the value of instantaneous voltage of the DC INPUT terminals drops below the minimum operating
voltage, the set slew rate is not realized. You must be careful especially when the slew rate setting is high
or when changing the load rapidly using large current.

In such a case, reduce the slew rate. If it is not necessary to operate at a high response speed, reduce the
slew rate or reduce the response speed in CC mode or CR mode.

Reducing oscillation caused by phase lag of the current

In CR mode, CV mode, and CP mode, phase lag of the current may cause control of the product to
become unstable and oscillation phenomena to occur, even during DC operation. Therefore, use the short-
est cables possible and twist them. If the cables are too thick to be twisted, bring the DC INPUT terminal’s
positive and negative terminal cables close together and make them parallel.

If only DC operation is required, a capacitor and a resistor may be connected to the DC INPUT terminal to
reduce oscillation. Use the capacitor within its allowable ripple current.

|_Keep the wire short 100 cm or less

PLZ-5WH2

Example: R=10 Q, C=1

Optimizing the response speed

The current phase is delayed with respect to the voltage due to the inductance of the wiring. Control of the
product may become unstable and oscillation phenomena may occur.

If, in CV mode or CR mode, the response speed is set to Fast, stable operation can be secured by setting
the response speed to Normal (p. 65).

Using remote sensing

PLZ-5WH2

Remote sensing (p. 67) can be used to stabilize load current. In CP mode the response speed cannot be
specified, but the operation can be stabilized by using remote sensing.
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Appendix

Frequency Derating of Input Voltage

Keep the frequency and amplitude of the voltage applied to the DC Input terminals below the derating
curve shown below.

NOTE Otherwise, the internal circuit may break.

Frequency derating curve of the DC INPUT terminal voltage

1000

100 \

10 \

Amplitude of the DC INPUT voltage (Vrms)

100 1000 10000 100000 1000000
Frequency of the DC INPUT voltage (Hz)
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Appendix

Slew Rate for Small Currents

If the load current is made small in current (CC) mode, the specified slew rate may not be achieved. The
following graph shows the relationship between the set current and the rise/fall time of the actual current
when the slew rate is set to 20 A/us or 2 A/us.

1000
Slew rate
—0— 2 Alus
—m— 20 Alus
100
)
=
(0]
S
: '\'1-.\-_.1_”._./././'
8
o
.2
o
1
0.1 1 10 100
. . 1 ,
Current setting ratio [%] 1: Current setting x100

Rated current

The relationship between the set current and changes in current is shown below.

2 Current setting PLZ20005WH2

S 400 A Slew rate: 20 A/us
Fai

5 L 300 A

= r 200 A

5 e 100 A

3 /

Time (20 ps/DIV)

Current setting  p|_720005WH?2

< 100 A
% / Slew rate: 20 A/us
X / 80 A
@ /r 60 A
‘5 40A
S 20A
Time (20 ps/DIV)
. Current setting
S o n PLZ20005WH2
g / Slew rate: 20 A/ps
o / 15 A
£ e w10 A
/ o n
>
@)

Time (20 ps/DIV)
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Appendix

Operating Area

As shown in the following figure (PLZ12005WH2 example), the product can be used within the area
enclosed by the constant voltage line according to the rated voltage (L1), the constant power line accord-
ing to the rated power (L2), the constant current line according to the rated current (L3), and the constant
voltage line according to the minimum operating voltage (L4) (operating area where the specifications are
guaranteed). The specifications are guaranteed at input voltages of 10 V and greater, but by reducing the
current, operation is possible even with input voltages of less than 10 V (actual operating area).However,
the specifications are not guaranteed in that case.

The voltage at which current starts flowing to the product is approximately 1.5 V. If the input voltage is
gradually increased from 0V, no current will flow until the voltage exceeds approximately 1.5 V. If the input
voltage exceeds approximately 1.5 V and once a current greater than or equal to 1 % of the current rating
starts flowing, the current can be kept flowing even when the input voltage is reduced.

For the operating range of each model, refer to “Operating area of each model” (p.173).

L1 Operating area where L3—
L2 specifications are guaranteed
1000 10 X
— 7 —
=, 9000 >, L
o} Operating area where w [}
2 100 PR =
8 specifications are 8
o o) .
> uaranteed
Z g L4 —13 ; Actual operating area
£ 10 g
n
»
Approx. 1.5---
Approx. 1.5 --
1 10 100 240 1000 0o 240
Low voltage area
X

Input current (A) Input current (A)

Basic operation modes

The following five operation modes are available on the product.
» Constant current mode (CC mode)
» Constant resistance mode (CR mode)
» Constant power mode (CP mode)
» Constant voltage mode (CV mode)
* Arbitrary |-V characteristics mode (ARB mode)
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Appendix | Operating Area

Operation of the constant current (CC) mode

Operation of the constant current mode

When the product is used in CC mode, it operates as a constant current load as shown in the following fig-
ure. The product sinks specified current | even when output voltage V1 of the constant-voltage power sup-

ply changes.
—»I o -E Voltage V
, : The current is kept constant even
V1 ! I

I ' when the voltage changes
Constant voltage 7‘5 i !
source v |

] E 0 Current | .

PLZ-5WH2 CC setting

Transition of the operating point: Overpower protection (OPP) operation

Example: Examining the load characteristics of the constant-voltage power supply in CC mode.

Operating area Constant power line

OPP setting) _ OPP trip point

=

® A =
8V1

Ke)

>

2

c C —
- V2

Logarithmic scale
9 Input current (A)

B Operation on segment AB

If the voltage of the constant-voltage power supply is set to V1 and the input current (load current) of the
product is increased, the operating point moves along segment AB. When point B is reached, overpower
protection (OPP) is activated. At this point, two types of operation are available on the product depending
on which action is set to be executed at OPP detection.

Setup Behavior

Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant power load at point B. Even if you attempt to increase the
input current, the current is limited at point B. If you decrease the input current, the OPP is cleared.
The product returns to CC mode and the operating point moves along segment AB.

B Operation on segment CD

If the voltage of the constant-voltage power supply is set to V2 and the input current (load current) of the
product is increased, the operating point moves along segment CD. Point D is maximum current.
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Operation in constant resistance (CR) mode

Operation in constant resistance mode

When the product is used in CR mode, it operates as a constant resistance load as shown in the following
figure. When voltage V1 of the constant-voltage power supply varies, the product sinks current to maintain
I = VIR, with the specified resistance R fixed. The product operates by sinking current. This mode cannot
be used with an AC circuit.

Voltage V|
V1 A2 /
Constant voltage 7‘ !
source vib----- /: R=VY1_ V2 The rresistance (R) is kept
! ; I1 12 constant even when the
E ! voltage and current change
PLZ-5WH2 0 : .
I I2 Current |

Transition of the operating point: Overpower protection (OPP) operation

Example: Examining the load characteristics of the constant-voltage power supply in CR mode.

Operating area

Constant power line

(OPP setting)
E | OPP trip point
)
g . la
35 W
> %
= R1,¢
Q .
£

s I~ Constant resistance line
(Constant resistance settings: R1, R2, RB)

Logarithmic scale IB locpP

Input current (A)

If the overcurrent protection (OCP) setting IOCP is greater than the current value IB at point B, when the
product resistance is decreased (R1 — R2 — RB) and the input current (load current) is increased with the
voltage of the constant-voltage power supply at V1, the operating point moves along segment AB (A1 —
A2 — B). When point B is reached, OPP is activated. At this point, two types of operation are available on
the product depending on which action is set to be executed at OPP detection.

Setup Behavior

Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant power load at point B. Even if you attempt to increase the
input current by decreasing the resistance, the current is limited at point B. If you decrease the input
current by increasing the resistance, the OPP is cleared. The product returns to CR mode, and the
operating point moves along segment AB.
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Transition of the operating point: Overcurrent protection (OCP) operation

Operating area Constant current line
< (OCP setting)

| OCP trip point

i
S 1
‘6’ 1
(e} 1
S A Als A2 i
8
5V Fm——p
> & o <
-*g_ Rj N &8

R 0 #

< y & Rg, \ . 4 1

— Constant resistance line
(Constant resistance settings: R1, R2, RF)

H
Logarithmic scale locp 1B
Input current (A)

If the OCP setting IOCP is smaller than the current value IB at point B, when the product resistance is
decreased (R1 = R2 — RF) and the input current (load current) is increased with the voltage of the con-
stant-voltage power supply at V1, the operating point moves along segment AF (A1 = A2 — F). When

point F is reached, OCP is activated. At this point, two types of operation are available on the product
depending on which action is set to be executed at OCP detection.

Setup Behavior

Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant current load at point F. Even if you attempt to increase the
input current by decreasing the resistance, the current is limited at point F. If you decrease the input
current by increasing the resistance, the OCP is cleared. The product returns to CR mode, and the
operating point moves along segment AF.
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Constant power (CP) mode operation

Constant power mode operation

When the product is used in CP mode, the product operates as a constant power load as shown in the fol-
lowing figure. When voltage V1 of the constant-voltage power supply increases, input current | decreases
so that the power consumed by the product, P=Vxl, is kept constant. In the following figure, P = V1xI1 =

Vax|2.
Voltage V
vipeoee \E’ =Vix11=V2xIl2 The power (P)is kept
Vi constant even when
Constant voltage IVZY S the current and
source voltage change
0 I 12 E Current |
PLZ-5WH2 Maximum rated current

Transition of the operating point: Overcurrent protection (OCP) operation

Example: Examining the load characteristics of the constant-voltage power supply in CP mode.

Operating area ¢ Constant power line
(Constant power settings: P1, P2, PB)

E V3 e
)
8 L OCP trip point
©
Z
2 Constant current line
= r” (OCP setting)
Logarithmic scale Input current (A)

B Operation on segment AB

If the voltage of the constant-voltage power supply is set to V1 and the power of the product is increased
(P1 — P2 — PB) and the input current (load current) is increased, the operating point moves along seg-
ment AB (A1 — A2 — B). When point B is reached, OCP is activated. At this point, two types of operation
are available on the product depending on which action is set to be executed at OCP detection.

Setup Behavior
Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant current load at point B. Even if you attempt to increase the
input current, the current is limited at point B. If you decrease the input current, the OCP is cleared.
The product returns to CP mode and the operating point moves along segment AB.

B Operation on segment GH
If the voltage of the constant-voltage power supply is set to V3 and the power of the product is increased

(P1 — P2 — PB) and the input current (load current) is increased, the operating point moves along seg-
ment GH. Point G is maximum power.
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Constant voltage (CV) mode operation

In CV mode, the product sinks current so that the voltage at the load input end of the product is constant.

Constant voltage mode operation

When the product is used in CV mode, the product operates as a constant voltage load (shunt regulator)
as shown in the following figure. When V1 is greater than V, input voltage V is kept constant even when
input current | varies. Current does not flow when V1 is less than or equal to V. The product may operate
unstably if R1 is low.

The voltage is kept constant even

when the current changes
B

Voltage
\%

V1
Constant voltage s
ource

PLZ-SWH2 0 Current |

Transition of the operating point: Overpower protection (OPP) operation

PLZ-5WH2

Example: Examining in CV mode the load characteristics of the power supply with a large internal resis-
tance

Operating area Constant power [line
— (OPP setting)
= .
Q VMO beeeeeeeeeeons S . OPP trip point
o M
S VMo M
S VM1 [rmt szt
> VM2
5 VN
2 X
= Constant voltage line

(constant voltage setting)

1

Logarithmic scale IN locp

Input current (A)

We assume that the overcurrent protection setting IOCP is greater than current IN at point N and denote
the voltage of the constant voltage power supply as VM. When voltage VMO of the product is greater than
VM, no current flows. When the voltage of the product is decreased to a point where VMO0 is smaller than
VM, the current starts flowing. If the voltage is decreased further (VM1 — VM2 — VN) to increase the input
current (load current), the operating point moves along segment MN (M1 — M2 — N). When point N is
reached, OPP is activated. At this point, two types of operation are available on the product depending on
which action is set to be executed at OPP detection.

Setup Behavior

Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant power load at point N. Even if you attempt to decrease the
voltage, the current is limited at point N. If you increase the voltage, the OPP is cleared. The product
returns to CV mode and the operating point moves along segment MN.
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Transition of the operating point: Overcurrent protection (OCP) operation

Operating area Constant current line
(OCP setting)
E - OCP trip point
)
o
8
©
>
5
<%
£ i
Constant voltage line ;
constant voltage setting)i
1
L
Logarithmic scale locP IN

Input current (A)
We assume that OCP setting IOCP is smaller than current IN at point N and denote the voltage of the con-
stant voltage power supply as VM. When voltage VMO of the product is greater than VM, no current flows.
When the voltage of the product is decreased to a point where VMO0 is smaller than VM, the current starts
flowing. If the voltage is decreased further (VM1 — VM2 — VL) to increase the input current (load current),
the operating point moves along segment ML (M1 — M2 — L). When point L is reached, OCP is activated.
At this point, two types of operation are available on the product depending on which action is set to be
executed at OCP detection.

Setup Behavior

Trip Turns off the load (stops the current flow).

Limit The product sinks current as a constant current load at point L. Even if you attempt to decrease the
voltage current, the current is limited at point L. If you increase the voltage, the OCP is cleared. The
product returns to CV mode and the operating point moves along segment ML.
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Operating area of each model
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Operating area of the PLZ12005WH2
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Appendix

OPP Operation

This section explains the current limit and response time until OPP is activated in the voltage and current
waveforms when OPP is activated.

Current limit in relation to the voltage

PLZ-5WH2

This product can capture the power instantaneously even when the load power is exceeding the rated
power until OPP is activated. However, the current is limited in relation to the voltage across the DC Input
terminals. The following graph shows the relationship between the current and power in relation to the
voltage across the DC INPUT terminals.

For example, if the DC INPUT terminal voltage is 100 V, the power can be captured instantaneously up to
200 % of the rated power. In this situation, the current flow can be increased up to the rated current.

If the DC INPUT terminal voltage is 500 V, the power can be captured instantaneously up to 600 % of the
rated power. In this situation, the current is limited to 60 % of the rated current.

140 700
2w, 120 600 o o
££ ER
€ 100 500 = .
§ § 5 g —— Current limit
33 ¢80 400 3§  —®— Power limit
o T [OaNe}
£28 60 300 £ 2
w— @© - @©
o - o -
22 4o 200 o 2
4] ©
e} o
== 2 100 * =
0 0 1- C;r:e;\t setting 100
0 100 200 300 400 500 600 700 800 900 1000 ated current
DC INPUT terminal voltage [V] 2 Power setting 100

Rated current
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Response time

The OPP response time varies depending on the amplitude of the load power and the amplitude of the
load current exceeding the OPP setting.

The following graph shows the relationship between the duration of time until OPP (Limit) is activated and
the DC INPUT terminal voltage in CC mode.

100 .
DC INPUT terminal voltage
—&— 1000 V
- —A— 800V
s 10
2 —»— 600V
3 —m— 400V
c
o
[oN
é 1 —¥— 200V
—0— 100V
0.1
0 20 40 60 80 100
Ratio of the load current to the rated current [%)]' _ Load current

— x100
Rated current
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Waveform

The following figures show the waveforms when the action to be taken when OPP is activated is set to
Limit (OPPL). (for PLZ2005WHZ2)

B Load power 11300 W

m Measurement conditions

Operation mode: CC
Load current: 0 A28 A
DC INPUT terminal voltage: 400 V

Load current

Current (5 A/DIV)

Time (2 ms/DIV)

B Load power 9700 W

m Measurement conditions
Operation mode: CC

Load current: 0 A—>12 A

DC INPUT terminal voltage: 800 V

Current (5 A/DIV)

Load current

Time (2 ms/DIV)

B Load power 4000 W

m Measurement conditions
Operation mode: CC

Load current: 0 A—~4 A

DC INPUT terminal voltage: 1000 V

Current (5 A/DIV)

Load current

Time (2 ms/DIV)
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Propagation Delay for External Control

The following figure shows the propagation delays of the changes in the load current with respect to exter-
nal control and the changes in the current monitor voltage with respect to changes in the load current.

B External input voltage (EXT CONT) vs. load current

m Measurement conditions

,\S EXT CONT Operation mode: CC

% <Q( Load current: 0 A—400 A

S = DC INPUT terminal voltage: 50 V

N = Load current Slew rate: 20 A/us

%‘g EXT CONT signal (external input voltage): 0 V — 10 V
23

Time (20 ps/DIV)

B Load current vs. current monitor voltage (I MON OUT)

| |
H1O 998 us m Measurement conditions
o

= 1 | MON OUT Operation mode: CC

% % i Load current: 0 A—400 A

S =) i DC INPUT terminal voltage: 50 V
S Load current Slew rate: 20 A/us

=

S 3 |1

Time (20 ps/DIV)
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Operating Range during Parallel Operation

The operating range during parallel operation using the same model is shown for each operation mode.

CC mode

B Operating range

Number of PLZ1005WH2 |PLZ2005WH2 | PLZ4005WH2 | PLZ12005WH2 PLZ20005WH2
slaves
1 0Ato40A 0Ato80A 0Ato 160 A 0Ato480 A 0 Ato 800 A
2 0Ato60A 0Ato 120 A 0Ato240 A 0Ato720 A 0Ato 1200 A
3 0Ato80A 0Ato 160 A 0Ato320 A 0Ato960 A 0Ato 1600 A
4 0Ato 100 A 0Ato200A 0 Ato400A 0Ato 1200 A 0 Ato 2000 A
B Slew rate
Number of PLZ1005WH2 PLZ2005WH2 PLZ4005WH2
slaves
1 0.002 A/ps to 2 Alus 0.004 Alus to 4 Alus 0.008 A/us to 8 Alus
2 0.003 A/us to 3 Alus 0.006 A/us to 6 Alus 0.012 A/us to 12 Alus
3 0.004 A/us to 4 Alus 0.008 A/us to 8 Alus 0.016 A/us to 16 Alus
4 0.005 A/us to 5 Alus 0.010 A/ps to 10 Alus 0.020 A/ps to 20 Alus
Number of PLZ12005WH2 PLZ20005WH2
slaves
1 0.02 Alus to 24 Alus 0.04 Alus to 40 Alus
2 0.03 A/us to 36 Alus 0.06 A/us to 60 A/us
3 0.04 Alus to 48 Alus 0.08 A/us to 80 Alus
4 0.05 A/us to 60 Alus 0.1 A/us to 100 Alus
CR mode

B Operating range

Number of PLZ1005WH2 PLZ2005WH2 PLZ4005WH2

slaves H range L range H range L range H range L range

1 10Sto0S 10mSto0S 2Sto0S 20mSto0S 4Sto0S 200mSto0S
2 1.58t00S |15mSto0S [3Sto0S 30mSto0S 6Sto0S 300mSto0S
3 20Sto0S '20mSto0S |[4Sto0S 40mSto0S 8Sto0S 400mSto0S
4 258to0S 25mSto0S |[5Sto0S 50mSto0S [10Sto0S 500mSto0S
Number of PLZ12005WH2 PLZ20005WH2

slaves H range L range H range L range

1 12Sto0S 120mSto0S [20Sto0S 200mSto0S

2 18Sto0S 180 mSto0S [30Sto0S 300mSto0S

3 24Sto0S |240mSto0S 40Sto0S |400mSto0S

4 30Sto0S |300mSto0S |50Sto0S 500mSto0S
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CV mode

B Operating range

Number of slaves

All models

1t04 10 Vto 1000V

CP mode

B Operating range
Number of PLZ1005WH2 PLZ2005WH2 PLZ4005WH2 PLZ12005WH2 | PLZ20005WH2
slaves
1 0 Wto 2 kW 0 W to 4 kW 0 W to 8 kW 0 W to 24 kW 0 W to 40 kW
2 0 W to 3 kW 0 W to 6 kW 0Wto 12 kW 0 W to 36 kW 0 W to 60 kW
3 0 W to 4 kW 0 W to 8 kW 0 Wto 16 kW 0 W to 48 kW 0 W to 80 kW
4 0 W to 5 kW 0 W to 10 kW 0 W to 20 kW 0 W to 60 kW 0 W to 100 kW
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Appendix

Options

This product has the following options.
For information about options, contact your Kikusui agent or distributor.

Parallel operation signal cable kit

0000000000000 000000000000 00000000 0CCOCOCPOCOCOCOOCOPOCOOOPOCOPCOPOPOPOPOCOOPOPCOPOPOTPOPOPOQOPTOPTOPQOPTOQTPTQOPTOTTYYTYS

This kit contains a signal cable for performing parallel operation on the PLZ-5WH2 series.

I

Model Cable length
PCO01-PLZ-5W Approx. 30 cm
PC02-PLZ-5W Approx. 1 m

Low inductance cable

This is a load cable with suppressed inductance. It suppresses voltage drops that occur when current fluc-
tuations are fast.

High-voltage load cable

This load cable supports high voltage. Up to 80 A (Kikusui-recommended current) is supported.

181
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GPIB converter (PIA5100)

This converter converts RS232C or USB of the product to GPIB, enabling connection of a remote control-
ler using GPIB. Perform the connection as shown below.

RS232C or USB Remote control device

/ PIA5100
PLZ-5WH2

DC OUT (5V) GPIB S

The GPIB communication specifications are as follows.

ltem Specifications
Hardware Complies with IEEE Std 488.1-1987

SH1, AH1, T6, L4, SR1, PPO, DC1, DT1, CO, E1
Message terminator LF or EOI during reception, LF + EOI during transmission
Primary address 0to 30

When you connect a PIA5100, you cannot use the product’s RS232C or USB port.

Some restrictions apply to the GPIB functions that can be used with the PIA5100. When connected
through RS232C, the product supports the KISTD SAFU protocol.

For details, see the GPIB converter (PIA5100) operation manual.
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Rack mount bracket
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These are rack mounting options.

Appropriate Model Model Description
PLZ1005WH2 KRB3-TOS For EIA inch racks
Iﬁtéﬁgggwgg KRB150-TOS For JIS millimeter racks
PLZ12005WH2 KRB9 For EIA inch racks
KRB400-PCR-LE For JIS millimeter racks
PLZ20005WH2 KRB13 For EIA inch racks
KRB600 For JIS millimeter racks

To rack mount the product, remove the casters and the stopper.

Outline drawing

H PLZ1005WH2, PLZ2005WH2, PLZ4005WH2

(460 15,

149 (5.87)

B PLZ12005WH2

KRB9 -
——
|
g9 25
ke : 2|2 :
\'— é): . d S ’ d
- Iss| @ E\ o @
g 6 & 1 2
g o °© A, e
96° sl p
~17 9941545 ==
\> 4794 7887 ~—
T e Unit: mm (inches)
[ ]
[ ]
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B PLZ20005WH2

KRB13 ) KRB600
S ‘\'
= 5|
o o
= o
© 2
~ -
— —
4
2s 2|3
2 EE
Sl Slg
‘\B 4| o
2 0 9 2 0
S e < e
2 o © Bl 9
4 0l6l® 45 i€
40184, 1 <(8g; B
g < 2|2 Unit: mm (inches)

Preparation for rack mount bracket attachment

To attach the product’s rack mount bracket, remove components such as the handle, legs, and casters.
For information on rack mounting, see the operation manual of the rack mount bracket.

(NOTE) We recommend that you keep all pieces that you remove from the product. You will need
‘ ’ these pieces if you remove the product from the rack.

B PLZ1005WH2, PLZ2005WH2, PLZ4005WH2
Side panel legs and handle are attached only to the PLZ1005WH2 and PLZ2005WH2.

Foot on the side panel

—-——
—_
—_

—-_——
——

S=o-G— = L Bracket

e 2ese |1 - Handle Cover
\\\\\\\\ S R /
= 106 T 5\‘\]% E]

S 0000 ° = *\@Q
DD F o E Screw (M4x8)
L |
|__Rubber foot Ef i H
< Pry the pins off Rivet :
with a flat-blade

)_-Screw pin ~
screwdriver.

1 Remove the two handle covers.
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Unfasten the two screws, and remove the entire handle.

While pulling down the rubber feet (four locations) of the bottom panel, loosen their
screw pin with a screwdriver and remove the feet.

Unfasten the internal pins from the rubber feet (four locations) of the side panel
using a flat-blade screwdriver, and then remove the feet.

This completes the removal.

(NOTE)

To reinstall the handle that has been removed, use screw locking agent (e.g., 1401B by
ThreeBond International, Inc.) to prevent screws from loosening.

B PLZ12005WH2, PLZ20005WH2

PLZ-5WH2

iwo

- & ' -
c?:gu?? o [ [ T Screws (4-M4)
. @0000

@@® ko .
~ Handle

e’

L

j iy ﬁD
Ay

4 Screws (16-M6)

:g@

Stopper —_. &
While pulling down the stopper (one location) of the bottom panel, loosen the
screws with a screwdriver and remove it.

While pulling down the casters (four location) of the bottom panel, loosen the
screws with a screwdriver and remove it.

While pulling the handles (two location) of the side panel toward you, loosen the
screws with a screwdriver and remove it.

User’s Manual

185



Appendix

Troubleshooting

This section introduces troubleshooting measures. Typical symptoms are listed. Check whether any of the
items listed below apply to your case. In some cases, the problem can be solved quite easily.

If none of the items apply to your case, we recommend that you initialize the product to its factory default set-
tings (p. 137). If following the remedy does not solve your problem, contact your Kikusui agent or distributor.

B Nothing appears on the display when the POWER switch is turned on.

Check Possible cause Remedy

Is the rated voltage being  Broken power cord. Check that the power cord is not broken and
applied to the input power Bad connection at the rear- that the connection at the AC INPUT connector
supply (AC)? panel AC INPUT connector. is secure.

B Keys do not work.

Check Possible cause Remedy

Are the keys locked? ([B)/[B)) The key lock is enabled (p. 129). Hold down KEY LOCK to release
A is shown on the display) the key lock.

The remote icon (EMaEal) Panel control is not possible because Press ESCAPE to enable panel
is shown on the display. remote control is in progress. control.

B Input current is unstable or oscillates.

Check Possible cause Remedy

Is the rated voltage being  Low supply voltage. Use the product in the input supply voltage

applied to the input power range.

supply (AC)?

Is an alarm occurring? There is an internal or exter- Check the type of alarm, and eliminate the root
nal error. cause of the alarm. (p.48).

Is there a large loop in the The wire inductance has Twist the wires.

load cable? increased. See “Preventing large voltage variation when

load current changes suddenly” (p. 162).

Does the behavior change A proper response speed is Change the response speed (p. 65).
depending on the length of not being used.
the wiring?

B An alarm is occurring.

Check Possible cause Remedy
Has overheat detection The fan has stopped. Immediately stop using the product, and have it
(OTP) been activated? repaired.
Vent or inlet holes are Move the product so that there is at least
blocked. 75 cm of space between the vents and the sur-

rounding walls.Do not place objects within
75 cm of the vents.

Has overcurrent protection The OCP setting is small. Set an appropriate OCP value on the setup
(OCP) been activated? screen (p.50).
Has overpower protection  The OPP setting is small. Set an appropriate OPP value on the setup
(OPP) been activated? screen (p.51).
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Check

B The load cannot be turned on.

Possible cause

Appendix | Troubleshooting

Remedy

A sequence is in opera-
tion.

The load cannot be turned
on manually when a
sequence is in operation.

Wait for the sequence operation to finish.
Abort the sequence by pressing the Abort key

(p. 104).

Is the load on/off logic
(Input Logic) set to Nega-
tive?

The logic is incorrect.

Set Input Logic to Positive (p. 115).

Are you using an external
signal to turn the load off?

When the load is turned off
through external control, the
LOAD key is invalid.

The load key will be valid after you use an
external signal to turn the load on (p. 115).

The cutoff cause icon

(I, |, [, (B is

shown on the display.

The cutoff function is satisfy-
ing the condition for turning
the load off.

Set the cutoff to Disable (p. 70).

Check

B The load suddenly turns off.

Possible cause

Remedy

The cutoff cause icon

(I, |, [, (B is

shown on the display.

The cutoff function is satisfy-
ing the condition for turning
the load off.

Set the cutoff to Disable (p. 70).

Check

B External control (CC/CR/CP) cannot be set.

Possible cause

Remedy

The pulse function is on.

Cannot be used simultane-
ously with the pulse func-
tion.

Turn off the pulse function (p.44).

The sine function is on.

Cannot be used simultane-
ously with the sine function.

Turn off the sine function (p. 47).

Check

B Pulse function of sine function cannot be set.

Possible cause

Remedy

External control (CC/CR/
CP)is on.

Cannot be used simultane-
ously with the external con-
trol (CC/CR/CP).

Turn off the external control (CC/CR/CP)
(p.112).

A sequence is running.

Cannot be used simultane-
ously with a running
sequence.

Abort the sequence (p. 104).

User’s Manual

187



188

Index

A
ABC preset memories.........ceviviiieiiniiee e 75
ACCESSOMIES ..o ietiiiieeeeetiiieee e e ettt e e e et aee e e e sae e ae e e naeeeeas 3
alarm

OCCUITEINCE ...eeieieeee ettt e et e e e e e e e e e e e e e eneaes 54

137/ 01 TSRS 48
alarms

CleariNG . .o 54
ARB MOAE ....oeiiiiiie e 37
arbitrary |-V characteristics mode...............ccoccceeens 37
B
battery replacement..........cccocooiiii i 144
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CPMOde....oiiiiee e 36, 170
CR MOAE.....coiiiiiiieiieiie e 33, 168
current/voltage monitor signal..........ccccceeiiircciennnnen. 120
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CV MOAE ..ot 35, 171
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DC INPUT terminal COVEr ........ccovvvieeeiiieeeeeeeeee e 21
DC INPUT terminals ........ccccceeeeeeiciieeeece e 15, 20, 22
DC OUT BVt 182
default settings........ooooiiriie e 132, 139
device information............cccoeeve e 143
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DIGITALD ..ottt 119
DIGITALT .t 119
DIGITALZ....oo e 119, 131
AISPIAY ..t e 13
151 O PP 19
E
elapsed time display ........cccoovviiiiiiiiee e 63
ESCAPE KEY.....ooiiieeieecieiee e 28
EXT CONT CONNECLOr.......evvvvviieeeeeieeeeeeeeeeeeeenn, 109, 110
EXT SYNC POFt...coiiieiiiiiie et 83
external control ..........ccoovriiiicinii e 108
external dimensions...........cccooevvii e 156
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factory default settings .........cccccooeveiiiiieninn. 132, 139
factory default settings, restoring ..........ccccccuee. 134, 137
firmware Version..........cccooeiiiiii i, 143
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G

GPIB CONVEE......eiiiiiiiieie et 182
H
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|

IIMON OUT oot 11, 120
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integrated current display ...........cccccoiiiiiiiin i, 63
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interface settings ..., 132
IP address ......cocvueieeieiiiie e 132, 143
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K
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KEY LOCK KEY....uveiieeeiee et 130
KEYDOAId .....ccooiiiiie e 28
L

LOAD KEY ...ttt et 30
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10ad VaIUE.......coiiiiie i 13
LOCAL KEY ....eeeeiieie ettt 88
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10GGING . 55
M

malfunctions and CaUSES.........ccccceeeveiieeeieicieee e 186
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MEASUIEMENT .....uviiiiiiiiiei e 55
MEMOTY ... s 74
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N

Numeric Keypad ............oeiiiiiiiiiie e 28
o

OCP e e s 50
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O P T e s 50
operating a@r€a ........ccccuvueieeiiiiririeeee e ee e 166
operation MOAE ........cccieiuiiiiie e 31
OPP e 51, 175
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overcurrent protection ...........oooccoeeiiiiie e 50
OVErhaUl ... 144
overpower protection...........ccoceieiiiieiee e, 51, 175
P

panel Operation ..........ccceeveeeiiiiieiee e 25
panel settings at startup ..........ccoeceeveiiiiin 127
PARALLEL CONNECIOT .....cocuuiieiiie e 123
parallel operation...........ccoeevveiiiiiies i 121
POWET CONSUMPLION ..ot 165
POWET ON/OFf ... 17
POWER SWItCh........ccooviiiiciiiiieeeece e 17
PresSet MEMOTY .....ooiiiiiiie e 75
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Protection .......cccvvieeiiiiieie e 48, 92, 125
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R
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FESEL .. 138
reset SettingsS......c.oovvie i 139
FESPONSE SPEEU.....cuiviiiiiiieiiiie et 65
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B TSRS 67
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SANIIZE eeeeee e 137
100 o T o P 135
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SENSING Cable ... 68
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SEQUENCE KEY ..ccueiieieiii e 12, 25
sequence tutorial..........ceeeeverieeiii 99
serial NUMDET ... 15
SEtUP MEMOTY ... e 78
SiNE FUNCHON ..o 45
slew rate.......ooooeeio i 41, 165
SOft Start ..o 66
SOURCE KEY .....veieeiieeeie st 12, 25
SPECIfiCatioNS.........veeeiiiiiie e 145
SE O ot —— 89, 95
stopper, I0CKING .......coiiiii e 5
synchronized operation .............cccceeiiieeii e 82
SYSTEMKEY ..o 12, 25
system settings ..o 126
T

temperature range.......cccccceveeeiei e 155
time Setting......cccovvieie e 136
tiME ZONE...i e 136
TRIG OUT .o 118
Ly T [o = PSPPSR 56, 96, 104
trigger iNpUt/oUtpUL ........ocoiiiiiii 118
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V)

undervoltage protection ..........ccceeeee e 52
(U] oo F= 110 To [P 142
USB ..o 11, 28, 79, 106, 142
UVP et e e 52
UVPL ot e e 52
UV P et e 52
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VMON OUT ..o 11, 120
VEISION L.ttt ettt enn e 143
W

watchdog protection ... 53
WWDP e 53
WEIGNT ..o 1565
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If you find any misplaced or missing pages in the manuals, they will be replaced. If the
manual gets lost or soiled, a new copy can be provided for a fee. In either case, please
contact your Kikusui agent or distributor. At that time, inform your agent or distributor of
the “Part No.” written on the front cover of this manual.

Every effort has been made to ensure the accuracy of this manual. However, if you have
any questions or find any errors or omissions, please contact your Kikusui agent or
distributor.

After you have finished reading this manual, store it so that you can use it for reference
at any time.

KIKUSUI ELECTRONICS CORP.

1-1-3 Higashiyamata, Tsuzuki-ku, Yokohama,
224-0023, Japan

Phone:  +81-45-482-6353
Facsimile: +81-45-482-6261

www.kikusui.co.jp/en/
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